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Preface

This Preface provides supporting information for the Oracle Financial Services 
Insurance Performance Pack (OFS CA) Installation Guide and includes the following 
topics:

•      Summary

•      Audience

•      Documentation Accessibility

•      Related Documents

•      Conventions

•      Abbreviations

Summary
You can find the latest copy of this document in Oracle Technology Network (OTN) 
Library which includes all the recent additions/revisions (if any) done till date.

Before you begin the installation, ensure that you have an access to the Oracle Support 
Portal with the required login credentials to quickly notify us of any issues at any 
stage. You can obtain the login credentials by contacting Oracle Support.

Audience
Oracle Financial Services Customer Analytics Pack Installation Guide is intended for 
administrators, and implementation consultants who are responsible for installing and 
maintaining the application pack components.

Prerequisites for the Audience
Following are the expected preparations from the administrator before starting the 
actual installation:

The document assumes that you have experience in installing Enterprise components 
and basic knowledge about the following are recommended:

•      Oracle Oracle Financial Services Customer Analytics pack components

•      OFSAA Architecture

•      UNIX Commands

•      Database Concepts

http://docs.oracle.com/cd/E60202_01/homepage.htm
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•      Web Server/Web Application Server

Note:

The Customer Analytics Pack installer download contains a primary ERwin 
XML file that is required for uploading the model. This file is sufficient to 
install the v8.0.0.0.0 product. However, this XML file cannot be opened in 
ERwin Data modeler tool and hence cannot be used for any data model 
customization. This ERwin file is delivered as a patch and need to be 
downloaded separately. This ERwin file should be used for any customization 
of the data model. 

Reference bug/patch where the primary ERwin file can be downloaded is Bug 
20469016 - OFS Customer Analytics 8.0.0.0.0 Data Model

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle 
Accessibility Program website at 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc

Access to Oracle Support
Oracle customers have access to electronic support through My Oracle Support. For 
information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or 
visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing 
impaired.

Related Documents
This section identifies additional documents related to OFS CA. You can access Oracle 
documentation online from Documentation Library for Oracle Financial Services 
Customer Analytics (OTN).

OFSAAI Related Documents

•      Oracle Financial Services Advanced Analytical Applications Infrastructure Application 
Pack Installation and Configuration Guide

•      Oracle Financial Services Analytical Applications Infrastructure Environment Check 
Utility Guide

•      Oracle Financial Services Analytical Applications Infrastructure Administration Guide

•      Oracle Financial Services Analytical Applications Infrastructure User Guide

•      Oracle Financial Services Analytical Applications Infrastructure Language Pack Guide

OFS CA Application Related Documents

•      Oracle Financial Services Customer Analytics User Guide 

•      Oracle Financial Services Customer Analytics Release Notes

The following document is available in My Oracle Support (MOS) and you should 
have SSO credentials to access MOS.

•      Oracle Financial Services Analytical Applications Infrastructure Security Guide

Conventions
The following text conventions are used in this document:

http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60202_01/homepage.htm


Table 0–1 Convention and their meaning

Convention Meaning

boldface Boldface type indicates graphical user interface elements 
associated with an action, or terms defined in text or the 
glossary.

italic Italic type indicates book titles, emphasis, or placeholder 
variables for which you supply particular values.

monospace Monospace type indicates commands within a paragraph, 
URLs, code in examples, text that appears on the screen, or 
text that you enter.

                                                                         xv 

Abbreviations
The following table lists the abbreviations used in this document:

Table 0–2 Abbreviations and their meaning

Abbreviation Meaning

CA Customer Analytics

GUI Graphical User Interface

HTTPS Hypertext Transfer Protocol Secure

J2C J2EE Connector

J2EE Java 2 Enterprise Edition

JDBC Java Database Connectivity

LDAP Lightweight Directory Access Protocol

LHS Left Hand Side

MOS My Oracle Support

OFSAA Oracle Financial Services Analytical Application 

OFSAAI Oracle Financial Services Analytical Application Infrastructure

OLAP On-Line Analytical Processing

OTN Oracle Technology Network

OS Operating System

SFTP Secure File Transfer Protocol

URL Uniform Resource Locator

Web Archive WAR

XML Extensible Markup Language
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1About OFS CA Application Pack

This chapter provides complete details about Customer Analytics (CA) Application 
pack.

This chapter includes the following topics:

•      About Oracle Financial Services Analytical Applications (OFSAA)

•      About Oracle Financial Services Analytical Applications (OFSAA) Application 
Packs

•      Introduction to Oracle Financial Services Customer Analytics (OFS CA) 
Application

•      About Oracle Financial Services Analytical Applications Infrastructure (OFSAAI)

About Oracle Financial Services Analytical Applications (OFSAA)
In today's turbulent markets, financial institutions require a better understanding of 
their risk-return, while strengthening competitive advantage and enhancing long-term 
customer value. Oracle Financial Services Analytical Applications (OFSAA) enable 
financial institutions to measure and meet risk adjusted performance objectives, 
cultivate a risk management culture through transparency, lower the costs of 
compliance and regulation, and improve insight into customer behavior.

OFSAA uses industry-leading analytical methods, shared data model and applications 
architecture to enable integrated risk management, performance management, 
customer insight, and compliance management. OFSAA actively incorporates risk into 
decision making, enables to achieve a consistent view of performance, promote a 
transparent risk management culture, and provide pervasive intelligence.

With the help of OFSAA, the financial services organizations can achieve, management 
excellence with a lower total cost of ownership, due to our integrated, architecture, 
combining performance and risk applications into a single, seamlessly integrated 
framework.

OFSAA delivers a comprehensive and integrated suite of financial services analytical 
applications for both banking and insurance domain. 

About Oracle Financial Services Analytical Applications (OFSAA) 
Application Packs 

The following figure depicts the various application packs that are available across the 
OFSAA Banking and Insurance domains:  



Introduction to Oracle Financial Services Customer Analytics (OFS CA) Application

1-2 Oracle Financial Services Customer Analytics Application Pack                     

Figure 1–1 OFSAA Applications Packs

Introduction to Oracle Financial Services Customer Analytics (OFS CA) 
Application

OFS CA Application is a complete end-to-end web-based Business Intelligence 
solution for Customer Analytics. It provides tools for data integration and includes 
customizable, pre-built dashboards and reports, a reporting data model, and user 
friendly functional subject areas for ad-hoc reporting. It enables you to actively plan, 
manage, and track marketing investments with pre-built reports, dashboards, and 
underlying data structures.

About Oracle Financial Services Analytical Applications Infrastructure 
(OFSAAI)

Oracle Financial Services Analytical Applications Infrastructure (OFSAAI) powers the 
Oracle Financial Services Analytical Applications family of products to perform the 
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processing, categorizing, selection and manipulation of data and information needed 
to analyze, understand and report on specific performance, risk, compliance and 
customer insight issues by providing a strong foundation for the entire family of 
Oracle Financial Services Analytical Applications across the domains of Risk, 
Performance, Compliance, and Customer Insight.

Components of OFSAAI
The OFSAA Infrastructure is comprised of a set of frameworks that operates on and 
with the Oracle Financial Services Analytical Applications Data Model and form the 
array of components within the Infrastructure. 

The OFSAA Infrastructure components/frameworks are installed in two layers: 
primarily the metadata server and Infrastructure services run on one layer, and the UI 
and presentation logic runs on the other. The UI and presentation layer is deployed on 
any of the supported J2EE Servers.

The following figure depicts the various frameworks and capabilities that make up the 
OFSAA Infrastructure:

Figure 1–2 Components of OFSAAI

OFSAA Infrastructure High Availability
The current release of the OFSAA Infrastructure supports only "Single Instance" 
installation for the Infrastructure components. However, the High Availability (HA) 
for the Database Server and the Web Application Server clustering and deployment 
are supported in this release.
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This release supports Active-Passive model of implementation for OFSAAI 
components. For more information, refer Configuration for High Availability - Best 
Practices Guide.

http://docs.oracle.com/cd/E61555_01/books/Configuration%20for%20High%20Availability%20%28HA%29%20Best%20Practices%20Guide.pdf
http://docs.oracle.com/cd/E61555_01/books/Configuration%20for%20High%20Availability%20%28HA%29%20Best%20Practices%20Guide.pdf


2

                                                           Understanding OFS CA Pack Installation 2-5

2Understanding OFS CA Pack Installation

This chapter includes the following topics:

•      Installation Overview

•      Logical Deployment Architecture

•      Hardware and Software Requirements

•      Verifying the System Environment

•      Understanding the Installation Mode

Installation Overview 
This section gives an overview of the OFS CA Pack Installation. Figure 2–1 shows the 
order of procedures you will need to follow: 
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Figure 2–1 Installation Overview

 The following lists provide additional information and links to specific 
documentation for each task in the flowchart.

•      Verify System Environment: This section provides details to verify that your 
system meets the minimum necessary requirements for installing and hosting the 
OFS CA  Application Pack. For more information, see Hardware and Software 
Requirements" and "Verifying the System Environment.

•      Obtain the Software: This section provides details about obtaining the software. 
For more information, see Obtaining the software.

•      Configure and Execute the Schema Creator Utility: This section provides details 
about configuring and executing the schema creator utility. For more information, see 
Configuring and Executing the Schema Creator Utility.

•      Install OFS CA Pack: This section provides details about installing the OFS CA 
Pack Installer. For more information, see Running the OFS CA Installer.



Hardware and Software Requirements

                                Understanding OFS CA Pack Installation 2-7

•      Configure OFS CA Pack: This section provides details about post installation 
configuration. For more information, see Post Installation Configuration.

•      Verify Installation: This section provides details about verifying the installation. 
For more information, see Verifying the Installation.

Logical Deployment Architecture
The deployment architecture depicts the mapping of a logical architecture to a physical 
environment. 

The physical environment includes the computing nodes in an intranet or Internet 
environment, CPUs, memory, storage devices, and other hardware and network 
devices.

Figure 2–2 Logical Deployment Architecture

Hardware and Software Requirements
This section describes the various Operating Systems, Database, Web Server, and Web 
Application Server versions, and other variant details on which this release of the OFS 
CA Application Pack has been qualified. 



Note:

OFS CA Application Pack installation can be performed on both Virtual and 
Physical servers.
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Configurations supported for Java 8
The following table shows the minimum hardware and software requirements for 
installing OFS CA Application Pack (Java 8):

Table 2–1  Configurations Supported for Java 8

Operating System

Oracle Linux / Red Hat 
Enterprise Linux (x86-64)

•       Oracle Linux Server release 5.3 up to 5.10 - 64 bit

•       Oracle Linux Server release 6.0 and above - 64 bit

Note: Same versions of RHEL is supported

Oracle Solaris(SPARC)/ 
Solaris x86

•       Oracle Solaris v5.10 Update 11 and above - 64 bit

•       Oracle Solaris v5.11 update 1 and above - 64 bit

IBM AIX (POWERPC) •       AIX 6.1 (TL 09 and above) - 64 bit

Shell •       KORN Shell (KSH)

Note : 

•       If the OS is IBM AIX 6.1, configure the size parameter setting for "Large File Support". 
Refer link http://www-01.ibm.com/support/docview.wss?uid=isg3T1000290 for more 
details.

•       If the operating system is RHEL, install the package lsb_release using one of the 
following commands by logging in as root user:

•      yum install redhat-lsb-core

•      yum install redhat-lsb

Java Runtime Environment

Oracle Linux / Red Hat 
Enterprise Linux

Oracle Solaris

•       Oracle Java Runtime Environment (JRE) 1.8.x - 64 bit

IBM AIX •       IBM AIX Runtime, Java Technology JRE 1.8.x - 64 bit

Oracle Database Server and Client

•       Oracle Database Server Enterprise Edition 11g Release 2 (11.2.0.3.0 +) - 64 bit RAC/ 
Non-RAC with/ without partitioning option

•       Oracle Database Server Enterprise Edition 12c Release 1 (12.1.0.1.0 +)- 64 bit RAC/ 
Non-RAC with/ without partitioning option

•       Oracle Client 11g Release 2 (11.2.0.3.0+) - 64 bit

•       Oracle Client 12c Release 1 (12.1.0.1.0+) - 64 bit

•       Oracle 11g Release 2 (11.2.0.3+) JDBC driver (Oracle thin driver)

•       Oracle 12C Release 1 (12.1.0.1+) JDBC driver (Oracle thin driver)

•        Oracle Distribution of R version 2.15.1, 2.15.2 or 2.15.3.(Optional)

•       Oracle R Enterprise (Server) version 1.4. (Optional)

•       Oracle R Enterprise 1.4 requires Oracle Database Enterprise Edition 11.2.0.3/ 11.2.0.4/ 
12.1.0.1

http://www-01.ibm.com/support/docview.wss?uid=isg3T1000290
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Note:

Ensure that the following patches are applied:

•       Oracle Server 12c,  v12.1.0.1 – 17082699

•       Oracle Server 12c,  v12.1.0.2 - 19392604, 19649591

•       Also for latest information, refer http://support.oracle.com/ ,  12.1.0.2 Bundle Patches 
for Engineered Systems and DB In-Memory - List of Fixes in each Bundle (Doc ID 
1937782.1)

•       Oracle R Enterprise 1.4 requires Oracle Database Enterprise Edition 11.2.0.3/ 11.2.0.4/ 
12.1.0.1

OLAP

Oracle Hyperion Essbase •       V 11.1.2.1+ (Server and Client) with Oracle 11g Database

•       V 11.1.2.3+ (Server and Client) with Oracle 12c Database

Oracle OLAP •       V 11.2.0.3+ with Oracle 11g Database

•       V 12.1.0.1+ with Oracle 12c Database

Note:

•       Oracle Hyperion Essbase & Oracle OLAP is required only if you are using the OLAP 
feature of OFSAAI. For Oracle OLAP, ensure that you have configured the Oracle 
Database server with OLAP option.

Web Server/ Web Application Server

Oracle Linux / Red Hat 
Enterprise Linux / IBM 
AIX

Oracle Solaris

Oracle HTTP Server 11.1.1.1/ Apache HTTP Server 2.2.x/ IBM 
HTTP Server

•       Oracle WebLogic Server 12.1.3+ (64 bit)

•       Apache Tomcat 8.0.x (64 bit)

Note: 

IBM WebSphere 8.5.x (Full Profile) on Java 8 is not available.

Note:

•       OFSAA Infrastructure web component deployment on Oracle WebLogic Server with 
Oracle JRockit is not supported.

•       For deployment on Oracle WebLogic Server 12.1.3+ (64 bit) with Java 8, download and 
install patch 18729264 from http://support.oracle.com/. 

Desktop Requirements

Operating System MS Windows 7/ Windows 8/ Windows 8.1

Browser •       MS Internet Explorer  9 , 10(Compatibility Mode) and 11 
(Compatibility Mode)

•       Oracle Java plug-in 1.7.0+* (64-bit)

Turn off Pop-up blocker settings. For more information, see 
Internet Explorer Settings.

Office Tools •       MS Office 2007/2010/2013 

•       Adobe Acrobat Reader 8 or above

Screen Resolution 1024*768 or 1280*1024

Other Software

Directory Services OFSAAI is qualified on both OPEN LDAP 2.2.29+ and Oracle 
Internet Directory v 11.1.1.3.0. However, it can be integrated 
with other directory services software like MS Active Directory.

Table 2–1 (Cont.) Configurations Supported for Java 8

http://support.oracle.com/
http://support.oracle.com/
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OFS CA Application Pack recommends the following software combinations for 
deployment:

Table 2–2 Recommended Software Combinations

Operating System Database
Web Application 
Server Web Server

Oracle Linux 5.3 up 
to 5.10/ 6.0 and 
above 

Oracle Database Oracle WebLogic Server 
/Apache Tomcat Server

Oracle HTTP Server/ 
Apache HTTP Server

Oracle Solaris 5.10/ 
5.11

Oracle Database Oracle WebLogic Server 
/Apache Tomcat Server

Oracle HTTP Server/ 
Apache HTTP Server

IBM AIX 6.1 Oracle Database IBM WebSphere 
Application Server 
/Apache Tomcat Server

IBM HTTP Server/ 
Apache HTTP Server

Verifying the System Environment
To verify that your system environment meets the minimum requirements for the 
installation, a Pre-Install Check utility is available within the Install Kit archive file. 
This utility can also be obtained separately by contacting Oracle Support.

Though the system environment verification is an integral and automated part of the 
installation of this software product, Oracle strongly recommends running this utility 
prior to beginning the installation as part of your organization's "Installation 
Readiness Verification Process".

Note:

For more details on download and usage of this utility, see Oracle Financial 
Services Analytical Applications Infrastructure Environment Check Utility 
Guide given in the Related Documents section.

Understanding the Installation Mode
The following modes of installation are available for the OFS CA Application Pack.

•      GUI Mode

•      Silent Mode

GUI Mode
This mode launches the product installation in a Graphical User Interface (GUI )mode. 
Users need to enter the required information on various panels within the UI in a user 
interaction format at various stages.

Note:

•       Configuration of Directory services software  for OFSAAI installation is optional. For 
more information on configuration, see Appendix E. 

•       Open LDAP needs to be installed on MS Windows Server machine only.

Table 2–1 (Cont.) Configurations Supported for Java 8
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Silent Mode
This mode mandates updating the installation files with required details and performs 
installation in a "Silent" non user interactive format.
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3Preparing for Installation

This chapter provides necessary information to review before installing the Oracle 
Financial Services Customer Analytics (OFS CA) Pack v8.0.0.0.0.

This chapter includes the following topics:

•      Installer and Installation Prerequisites

•      Obtaining the software

•      Common Installation Tasks

Installer and Installation Prerequisites
Table 3–1 mentions the list of prerequisites required before beginning the installation 
for OFS CA application. The Pre-Install Check utility notifies you if any requirements 
are not met.
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Table 3–1  Prerequisite Information

Category Sub-Category Expected Value

Environment 
Settings

Java Settings •      PATH in .profile to be set to include the Java 
Runtime Environment absolute path. The path 
should include java version (java 6,  or java 8) 
based on the configuration.

Note:

•       Ensure the absolute path to JRE/bin is set at 
the beginning of PATH variable.

•      For example, 
PATH=/usr/java/jre1.6/bin:$ORACLE_
HOME/bin:$PATH 

Ensure no SYMBOLIC links to JAVA installation is 
being set in the PATH variable.

Oracle Database 
Settings

•      TNS_ADMIN to be set in .profile pointing to 
appropriate tnsnames.ora file

•      ORACLE_HOME to be set in .profile 
pointing to appropriate Oracle Client 
installation

•      PATH in .profile to be set to include 
appropriate $ORACLE_HOME/bin path 

•      Ensure to add an entry (with SID/ SERVICE 
NAME) in the tnsnames.ora file on the OFSAA 
server. 

Oracle Essbase 
Settings

•      ARBORPATH, ESSBASEPATH, HYPERION_
HOME to be set in the .profile pointing to an 
appropriate Oracle Essbase Client installation.

Note: 

These settings are required only if you want to use 
Oracle Hyperion Essbase OLAP features.
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OS/File System 
Settings

File Descriptor 
Settings

Greater than 15000

Total Number of 
Process Settings

Greater than 4096

Port Settings Default port numbers to be enabled on the system 
are 6500, 6501, 6505, 6507, 6509, 6510, 6666, 9999, 
and 10101.

.profile 
permissions

User to have 755 permission on the .profile file. 

Staging Area/ 
Metadata 
Repository

•      A directory to hold the application metadata 
artifacts and additionally act as staging area for 
flat files. 

•      The directory should exist on the same system 
as the OFSAA Installation. This directory can 
be configured on different mount or under a 
different user profile.

•      Set 777 permission on this directory.

Installation 
Directory 

•      A directory where the installation files will be 
installed.

•      Set 755 permission on this directory. 

•      This directory needs to be set as FIC_HOME.

Download 
Directory

•      A directory where the product installer files 
will be downloaded/ copied.

•      Set 755 permission on this directory.

Database Settings Database Instance 
Settings

•      NLS_CHARACTERSET to be AL32UTF8

•      NLS_LENGTH_SEMANTICS to be BYTE

•      Available OPEN CURSORS limit to be greater 
than 1000

Web Application 
Server

WebSphere/ 
WebLogic/ 
Tomcat

Web Application Server should be installed and 
profile/domain created.

You will be prompted to enter the WebSphere 
Profile path or WebLogic Domain path or Tomcat 
Deployment path during OFSAAI installation.

Note: Refer Appendix A for WebSphere Profile 
Creation and WebLogic Domain Creation.

Web Server Apache HTTP 
Server/ Oracle 
HTTP Server/

IBM HTTP Server

.

This is an optional requirement. HTTP Server 
Installation to be present. You will be required to 
enter the Web Server IP/Hostname and Port details 
during installation.

Note: Refer Appendix A for Web Server installation.

Table 3–1 (Cont.) Prerequisite Information

Category Sub-Category Expected Value
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Obtaining the software
This release of OFS CA Application Pack v8.0.0.0.0 can be downloaded from the 
Oracle Software Delivery Cloud (https://edelivery.oracle.com). You need to have a 
valid Oracle account in order to download the software.

Common Installation Tasks
The following are the common pre-installation activities that you need to carry out 
before installing the OFS CA application pack.

This section includes the following topics:

•      Identifying the Installation Directory

•      Configuration for GUI Mode Installation

•      Copying and Extracting the Software

•      Setting Up the Web Application Server

Identifying the Installation Directory
This would typically be the User home directory and requires you to copy the 
following files:

•      OFSAA Download Directory - Create a download directory and copy the 
OFSAA Application Pack Installer File (Archive). This is the directory where the 
downloaded file is available.

•      OFSAA Installation Directory  - Create an installation directory. This is the 
directory where the installer would install the product files. $FIC_HOME to be set in 
the .profile pointing to the OFSAA Installation Directory.

Others Oracle R/ Oracle 
R Enterprise

•      This is an optional requirement.

Refer section Installation of Oracle R distribution 
and Oracle R Enterprise (ORE) for more details.

OFSAA •      For installation on Java 8, login to  
https://support.oracle.com/ and search for 
21160684 under the Patches & Updates tab. 
This is applicable only when you have installed 
8.0.0.0.0 OFSAAI pack and not required for 
8.0.0.1.0.

•      For installation of this release on an existing 
OFSAA instance version 8.0.1.0.0, login to 
https://support.oracle.com/ and search for 
21133780 under the Patches and Updates tab

•      For installation of this release on an existing 
OFSAA instance version 8.0.2.0.0, login to 
https://support.oracle.com/ and search for 
21657319 under the Patches and Updates tab.

Note: Ensure that the tablespace(s) used for the database user(s) is 
set to AUTOEXTEND ON.

Table 3–1 (Cont.) Prerequisite Information

Category Sub-Category Expected Value

https://support.oracle.com/ 
https://edelivery.oracle.com
https://support.oracle.com/
https://support.oracle.com/
https://support.oracle.com/
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•      OFSAA Staging/Metadata Directory - Create a Staging/Metadata Directory. This 
is also referred as "FTPSHARE".

Note:

Ensure the user permission set to 755 on the installation directory.

Configuration for GUI Mode Installation
To install OFS CA Application Pack in GUI mode, you need to ensure the below 
software and configurations are available:

•      Install and configure any PC X Server software such as Open Text Exceed 
(formerly Hummingbird Exceed) on the user desktop system from which the 
installation is triggered.

•      Configure the DISPLAY variable.

Ensure to set the DISPLAY variable on the system on which the OFSAA will be 
installed, to point to the user desktop system where the PC X Server software has 
been installed.

Syntax:

export DISPLAY=hostname:n.n1 
where hostname is the IP Address/Host Name of the user desktop system and n is 
the sequence number (usually 0).

For example, 10.11.12.13:0.0 or myhostname:0.0

Copying and Extracting the Software
Once you obtain the installer, copy the installer (in BINARY mode) to the system on 
which the OFSAA Infrastructure components will be installed.

Note: 

You must be logged in to the UNIX operating system as a non-root 
user.

1. Download the unzip utility (OS specific) unzip_<os>.Z from the location 
https://updates.oracle.com/unzips/unzips.html, and copy it in Binary mode 
to the directory that is included in your PATH variable. If you already have the 
unzip utility to extract the contents of the downloaded archive, skip to the next 
step.

2. Uncompress the unzip installer file using the command:

uncompress unzip_<os>.Z

Note

In case you notice an error message "uncompress: not found [No such 
file or directory]" when the package is not installed, contact your 
UNIX administrator.

3. Give EXECUTE permission to the file using the command:

chmod 751 unzip_<OS>

https://updates.oracle.com/unzips/unzips.html
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For example, chmod 751 unzip_sparc

4. Extract the contents of the Oracle Financial Services Customer Analytics 
Application Pack 8.0.0.0 in Download Directory installer archive file using the 
following command:

unzip OFS CA_80000.zip

5. Give EXECUTE permission to the installer script. Navigate to the path and execute 
the command

chmod 755 setup.sh

Setting Up the Web Application Server
For setting up the environment based on your selected Web Application Server, refer 
to Configuring Web Application Servers.

Installation of Oracle R distribution and Oracle R Enterprise (ORE)
This is an optional step and required only if you intend to use Oracle R scripting in the 
Oracle Financial Services Enterprise Modeling Application. Ensure the below sequence 
of prerequisites are followed:

1. Install Oracle R Distribution and Oracle R Enterprise (Server Components) on the 
Oracle Database server. See Oracle® R Enterprise Installation and Administration 
Guide for Windows, Linux, Solaris, and AIX, Release 1.3.1.

2. Oracle R Distribution versions supported- Oracle Distribution of R version 2.15.1, 
2.15.2 or 2.15.3.

3. ORE version supported- Oracle R Enterprise (Server) version 1.4.
 Skip this step if it is already installed.

Note: Oracle R Enterprise 1.4 requires Oracle Database Enterprise 
Edition 11.2.0.3+/ 12.1.0.1+.

Oracle® R Enterprise Installation and Administration Guide for Windows, Linux, Solaris, and AIX, Release 1.3.1
Oracle® R Enterprise Installation and Administration Guide for Windows, Linux, Solaris, and AIX, Release 1.3.1
http://docs.oracle.com/cd/E11882_01/doc.112/e36763.pdf
http://docs.oracle.com/cd/E11882_01/doc.112/e36763.pdf
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4Installing OFS CA Pack

Follow the instructions in this chapter to install the OFS CApack depending on the 
offline and online modes of installation.

This chapter includes the following sections:

•      Schema creator utility

•      Configuring and Executing the Schema Creator Utility

•      Running the OFS CA Installer

Schema creator utility
Creating database users/schemas is one of the primary steps in the complete OFSAA 
installation. This release of OFSAA provides a utility to quickly get started with the 
OFSAA 8.0 installation by allowing easier and faster creation of database User(s)/ 
Schema(s), assign the necessary GRANT(s), and so on. Additionally, it also creates the 
required entities in these schemas. 

The different types of schemas available for configuration in the OFSAA instance and 
their use is mentioned as follows:

•      CONFIG - This schema denotes the unique OFSAA setup configuration schema 
and holds entities and other objects required to hold the unique OFSAA setup 
information. 

Note: There can be only one CONFIG schema per OFSAA instance.

•      ATOMIC - This schema denotes the schema that holds the data model entities. 
One ATOMIC schema is attached to one Information Domain.

Note: There can be multiple ATOMIC schemas per OFSAA Instance 
and an Information Domain can have only one ATOMIC schema.

•      SANDBOX - This schema denotes the schema that holds the data for all Sandbox 
executions. One SANDBOX schema is attached to one Sandbox Information 
Domain. 



Note: There can be multiple SANDBOX schemas per OFSAA Instance and a 
Sandbox Information Domain can have only one SANDBOX schema.

Schema creator utility
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•      ADDON - This schema denotes any additional schema used by the OFSAA 
Applications.

Execution Modes in Schema Creator Utility
The Schema Configuration Utility supports the following modes of execution:

•      Online Mode: In the Online mode, the utility connects to the database and 
executes the DDLs for Users, Objects and Grants. If you have the SYSDBA 
privileges you can execute the Schema Creator Utility in Online mode and thereby 
create the Users, Objects, and Grants during the execution process.

Note:  To execute the utility in Online mode, you need to connect as "SYS 
AS SYSDBA" user.

•      Offline Mode:  In the Offline mode, the utility generates SQL script with all the 
required DDLs for User, Objects and Grants. This script needs to be executed by 
the DBA on the appropriate database identified for OFSAA usage. If you do not 
have the SYSDBA privileges, you can execute the Schema Creator Utility in Offline 
mode and generate the script file that contains the Schemas, Objects, and Grants 
information. Subsequently, a SYSDBA user can execute the script file manually. 

Note: To execute the utility in Offline mode, you need to connect as 
any user with the following grants:

•      SELECT ON DBA_ROLES

•      SELECT ON DBA_USERS

•      SELECT ON DBA_USERS

•      SELECT ON DBA_DIRECTORIES

•      SELECT ON DBA_TABLESPACES

•      CREATE SESSION

For more details refer, Executing the Schema Creator Utility in Offline 
Mode.

Note: 

1. Do not modify the <PACK>_SCHEMA_OUT.XML file generated after the 
execution of this utility.

2. If there are any errors during the script execution, reconfigure the 
<PACK>_SCHEMA_IN.XML file and execute the utility. This regenerates 
the scripts with corrected information.

Execution Options in Schema Creator Utility
Depending on the option selected to run the OFSAA Application Pack Installer, you 
need to select the schema creator utility execution option. If you try to run the OFSAA 
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Application Pack installer in SILENT mode, it is mandatory to execute the schema 
creator utility with -s option.

Note: If the schema creator utility is executed without the option -s, 
it is mandatory to run the OFSAA Application Pack Installer in GUI 
mode.

Configuring and Executing the Schema Creator Utility
This section includes the following topics:

•      Prerequisites

•      Configuring the Schema Creator Utility

•      Executing the Schema Creator Utility

•      Verifying the Log File

Prerequisites
The following prerequisites must be satisfied before configuring the Schema Creator 
Utility:

•      You must have the Oracle User ID/Password with SYSDBA privileges.

•      You must have the JDBC Connection URL for RAC/Non RAC database.

•      You must have the HOSTNAME/IP of the server on which OFSAA is getting 
installed.

•      For Java 8, navigate to OFS_AAI_PACK/bin/ and modify the value for property 
JAVA_VERSION to 1.8 in the VerInfo.txt file and save the changes.

Note: •      If this release of the OFS AAAI Application Pack version 8.0.0.0.0 
is being installed on an OFSAA setup where the underlying OFSAA 
Infrastructure (OFS AAI) version is upgraded to version 8.0.1.x.x, 
download and install the patch for schema creator utility (Bug 21133780 ) 
by following the instructions in the Readme.txt packaged in it prior to 
executing the utility.

•      If this release of the OFS AAAI Application Pack version 8.0.0.0.0 is being 
installed on an OFSAA setup where the underlying OFSAA 
Infrastructure (OFS AAI) version is upgraded to version 8.0.2x.x, 
download and install the patch for schema creator utility (Bug 21657319) 
by following the instructions in the Readme.txt packaged in it prior to 
executing the utility.

Configuring the Schema Creator Utility
This section explains the steps to configure the Schema Creator Utility.

To configure the Schema Creator Utility, follow these steps:

1. Navigate to the following path: OFS_CA_PACK/schema_creator/conf folder.

2. Edit the OFS_CA_SCHEMA_IN.xml file in a text editor.

3. Configure the following elements as described in the table:
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Table 4–1  Prerequisite Information

Element Name Description Permissible Value
Mandatory/Optional 
change

APP_PACK_ID Application Pack 
ID as per Product 
Management

- Mandatory

This value should not 
be edited.

 <JDBC_URL> Enter the JDBC 
URL.

Note: You can 
enter RAC and 
NON-RAC 
enabled database 
connectivity URL.

Example, 

jdbc:oracle:thin:@<HO
ST/IP>:<PORT>:<SID
>

Mandatory

<JDBC_DRIVER> By default this 
driver is seeded. 

Note: Do not 
edit this 
attribute value.

Example, 

oracle.jdbc.driver.Orac
leDriver

Mandatory

<HOST> Enter the 
Hostname or the 
IP Address of the 
system on which 
you are installing 
the OFSAA 
components.

Host Name/IP 
Address

Mandatory

<SETUPINFO>/ 
NAME

Enter the acronym 
for the type of 
implementation. 
This information 
will be displayed 
in the OFSAA 
Home Page.

Note: On 
executing the 
schema creator 
utility, this value 
will be prefixed 
with each schema 
name. For 
example: dev_
ofsaaconf, uat_
ofsaaatm.

Accepts strings with a 
minimum length of 
two and maximum of 
four.

Example, 

DEV, SIT, PROD

Mandatory
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<PASSWORD>/A
PPLYSAMEFORA
LL

Enter as Y if you 
want to apply the 
password 
specified in 
DEFAULT 
attribute for all the 
schemas. 

If you enter as N, 
then you need to 
provide individual 
passwords for all 
schemas.

Note: In case you 
have entered Y in 
APPLYSAMEFOR
ALL attribute and 
also have specified 
individual 
passwords for all 
the schemas, then 
the specified 
individual 
passwords will 
take precedence.

 

Y/N Mandatory 

Note: Setting this 
attribute value is 
mandatory, If 
DEFAULT attribute is 
set.

<PASSWORD>/ 
DEFAULT*

Enter the 
password if you 
want to set a 
default for all 
schemas.

Note: You also 
need to set 
APPLYSAMEFO
RALL attribute 
as Y to apply the 
default 
password for all 
the schemas.

The maximum length 
allowed is 30 
characters. Special 
characters are not 
allowed.

Optional

<SCHEMA>TYPE The different types 
of schemas that are 
supported in this 
release are  
ATOMIC, 
CONFIG, and 
SANDBOX.

By default, the 
schemas types are 
seeded based on 
the Application 
Pack. 

Note: Do not edit 
this attribute 
value.

ATOMIC/CONFIG/S
ANDBOX/ADDON 

Mandatory

Table 4–1 (Cont.) Prerequisite Information

Element Name Description Permissible Value
Mandatory/Optional 
change
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<SCHEMA> 
NAME

By default, the 
schemas names 
are seeded based 
on the Application 
Pack.

You can edit the 
schema names if 
required. 

Note:

•      The Schema 
Name will 
have a prefix 
of the 
SETUPINFO/
NAME 
attribute.

•      SCHEMA 
NAME must 
be same for all 
the ATOMIC 
Schemas of 
applications 
within an 
Application 
Pack. 

•      The 
permissible 
length for 
schema name 
is 15 
characters.

- To identify which 
schema is associated 
to this Application.

Cannot be blank

Table 4–1 (Cont.) Prerequisite Information

Element Name Description Permissible Value
Mandatory/Optional 
change
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<SCHEMA>/ 
PASSWORD*

Enter the 
password of the 
schema to be 
created.

Note:

•      If this 
attribute is left 
blank, then 
the password 
specified in 
the 
<PASSWORD
>/DEFAULT 
attribute is 
applied as the 
Schema 
Password.

•      The 
permissible 
length and 
allowed 
characters for 
schema 
password as 
defined by 
Oracle 
Database User 
naming 
convention

The maximum length 
allowed is 30 
characters. Special 
characters are not 
allowed.

Optional

Note: You need to 
mandatorily enter the 
password if you have 
set the 
<PASSWORD>/ 
APPLYSAMEFORALL 
attribute as N.

<SCHEMA>/ 
APP_ID

By default, the 
Application ID is 
seeded based on 
the Application 
Pack. 

Note: Do not edit 
this attribute 
value.

- Mandatory

<SCHEMA>/ 
DEFAULTTABLES
PACE

Enter the available 
default tablespace 
for DB User.

Note: If this 
attribute is left 
blank, then USERS 
is set as the default 
tablespace. 

- Optional

<SCHEMA>/ 
TEMPTABLESPAC
E

Enter the available 
temporary 
tablespace for the 
DB User.

Note: If this 
attribute is left 
blank, then TEMP 
is set as the default 
tablespace.

- Optional

Table 4–1 (Cont.) Prerequisite Information

Element Name Description Permissible Value
Mandatory/Optional 
change
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4. Save the OFS_CA_PACK_SCHEMA_IN.xml file.

5. Navigate to BIN folder and run the schema creator utility.

Executing the Schema Creator Utility 
You can execute the schema creator utility either in Online Mode or Offline Mode. This 
section includes the following topics:

•      Executing the Schema Creator Utility in Online Mode

•      Executing the Schema Creator Utility in Offline Mode

•      Executing the Schema Creator Utility in Silent Mode

•      Executing the Schema Creator Utility while Installing Subsequent Application 
Pack

Executing the Schema Creator Utility in Online Mode
In Online Mode, the Schema Creator Utility will create all the Schemas, Schema 
Objects, Grants, and Roles in the database during the execution process.

To execute the schema creator utility while creating the schemas for the first 
application pack, follow these steps:

1. Navigate to the following folder path: OFS_CA_Pack/schema_creator/bin/

2. Execute the osc.sh file using the following command:

./osc.sh
3. The following message is displayed: You have chosen ONLINE mode.

4. Enter the DB Username with SYSDBA Previleges. For example: SYS as SYSDBA.

5. Enter the User Password.

<SCHEMA>/QU
OTA

Enter the quota to 
be set on 
DEFAULTTABLES
PACE attribute for 
the schema/user. 
By default, the 
quota size is set to 
500M.

Minimum: 500M or 
Unlimited on default 
Tablespace.

For example,

•      600M/m

•      20G/g

•      UNLIMITED/unl
imited

Optional

Table 4–1 (Cont.) Prerequisite Information

Element Name Description Permissible Value
Mandatory/Optional 
change
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Figure 4–1 Schema Creation

6. The console runs the initial validation checks and then displays the following 
message: You have chosen to install this Application Pack on <Name of the Atomic 
Schema>ATOMIC schema. Do you want to proceed? (Y/N)

7. Enter Y to start the schema creation.

Or

Enter N if you want to quit executing the schema creation.

Figure 4–2 Schema Creation

Note: On successful execution of schema creator utility, the console displays 
the following status message:

Success. Please proceed with the installation. 

Refer log file in OFS_CA_PACK/schema_creator/logs folder for 
execution status. In case of any errors, contact Oracle Support.
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Executing the Schema Creator Utility in Offline Mode
In Offline Mode, the Schema Creator Utility creates an output in SQL file format. This 
script has to be executed manually by logging as database user with SYSDBA 
privileges. The SQL file will contain the creation of Schemas, Schema Objects, and 
Roles.

Prerequisites:

•      DBA_ROLES

•      DBA_USERS

•      DBA_DIRECTORIES

•      DBA_TABLESPACES

•      CREATE_SESSION

Note: Explicit Grants to the user are required. Grants assigned 
through Roles are not supported.

To execute the schema creator utility in the offline mode, follow these steps:

1. Navigate to the following folder path: OFS_CA_Pack/schema_creator/bin

2. Execute the osc.sh file using the following command:

./osc.sh -o

3. The following message is displayed: You have chosen OFFLINE mode.

4. Enter the DB Username with SELECT privileges.

5. Enter the User Password.

6. The console runs the initial validation checks and displays the following message: 
You have chosen to install this Application Pack on <Name of the Atomic 
Schema>ATOMIC schema. Do you want to proceed? (Y/N)
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7. Enter Y to start the script generation. 

Or

Enter N if you want to quit the script generation. 

Note: On successful execution of schema creator utility, the console displays 
the following status message: 

Success. Please execute OFS_CA_Pack/schema_creator/sysdba_output_
scripts.sql before proceeding with the installation.

8. Navigate to the directory: OFS_CA_Pack/schema_creator.

9. Login to SQLPLUS with a user having SYSDBA Privileges.

10. Execute the sysdba_output_scripts.sql file using the following command:

SQL>@sysdba_output_scripts.sql
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Alternatively, you can copy the sysdba_output_scripts.sql file and 
SQLScripts folder to a remote server and execute sysdba_output_scripts.sql 
file.

Note: Refer log sysdba_output_scripts.log file for execution status. In 
case of any errors, contact Oracle Support.

Executing the Schema Creator Utility in Silent Mode
If you try to run the OFSAA Application Pack Installer in SILENT mode, it is 
mandatory to execute the schema creator utility with -s option.

Follow these steps to execute the utility with -s option:

1. Edit the file OFS_CA_PACK/schema_creator/conf/OFS_CA_SCHEMA_IN.xml in text 
editor.

Note: TThe maximum acceptable length of the infodom name is 16 
characters.

2. Set the value for attribute "INFODOM" of <SCHEMA> tag(s) to specify a specific 
Information Domain name. By default, the value is empty and the utility will 
derive the Information Domain name. If the attribute value is set, the utility/ 
installer will configure the Information Domain against this <SCHEMA>.

3. Execute the utility with -s option. For example, ./osc.sh -s.

Note: If the utility is executed without the -s option, it is mandatory to 
launch the OFSAA Application Pack Installer in GUI mode.

Note: To execute the utility in OFFLINE mode with SILENT option, 
type. /osc.sh -o -s.

Executing the Schema Creator Utility while Installing Subsequent Application Pack
While executing the schema creator utility for subsequent Application Pack, you can 
choose to install the pack either on the same Information Domain/Atomic Schema or 
on a new Information Domain/Atomic Schema. You can execute the Schema Creator 
Utility either in Online or Offline Mode.

To execute the schema creator utility while installing OFS CA Pack over an existing 
Application pack, follow these steps:

1. Perform the steps 1 to 5 from the  Executing the Schema Creator Utility section.

2. The console identifies the Application Packs that are already installed on the 
current OFSAA setup and displays the following:

•      Atomic schema of the Existing Application Pack

•      Information Domain Name of the Existing Pack

•      List of Installed Application Packs.
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3. Enter Y to start the schema creation.

Or

Enter N if you want to quit executing the schema creation. 

Note: On successful execution of schema creator utility, the console displays 
the following status message:

Success. Please proceed with the installation. 

Refer log file in OFS_CA_PACK/schema_creator/logs folder for execution 
status, if scripts are executed in online mode. 

Refer log sysdba_output_scripts.log file for execution status, if 
executed in offline mode.

In case of any errors, contact Oracle Support.
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Verifying the Log File

Figure 4–3 Log file

If schema creation is successful, the console would display an appropriate message. If 
the schema creation runs into errors, refer the following log file:

•      << OFSCA Installer folder>>/<<OFS_ CA _PACK>>/schema_creator/logs/

•      <<OFS_CA>>_osc_<timestamp>.log for further details

You may contact Oracle support anytime for assistance.

Grants
The following grants need to be added:

•      grant rqadmin to dev_rcaconf1;

•      grant rqrole to dev_rcaconf1;

Running the OFS CA Installer
Follow the instructions in this section to install the OFS CA Application Pack 
depending on the mode of installation. 

This section covers the following topics:

•      Silent Mode Installation

•      GUI Mode Installation

Silent Mode Installation
In the Silent Mode Installation you must configure the product xml files and follow the 
instructions in command prompt.
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Configuring OFSAAI_InstallConfig.xml
Follow these instructions to configure OFSAA_InstallConfig.xml file:

1. Log in to the system as non-root user.

2. Identify a directory for installation and set the same in the user .profile file as the 
following:

FIC_HOME=< OFSAA Installation Directory >

export FIC_HOME

3. Execute the user .profile.

4. Navigate to the file: OFS_CA_PACK/OFS_AAI/conf/OFSAAI_InstallConfig.xml

5. Configure the OFSAAI_InstallConfig.xml as mentioned in the following table:

Table 4–2  Prerequisite Information

InteractionVariableNa
me Significance and Expected Value Mandatory

<Layer name="GENERAL">

WEBAPPSERVERTYPE Identifies the web application 
server on which the OFSAA 
Infrastructure web components 
would be deployed.

The below numeric value should be 
set depending on the type:

Apache Tomcat = 1

IBM WebSphere Application Server 
= 2

Oracle WebLogic Server = 3

For example,  <InteractionVariable 
name="WEBAPPSERVERTYPE">3<
/InteractionVari able>

Yes

DBSERVER_IP Identifies the hostname or IP 
address of the system on which the 
Database Engine is hosted.

Note: For RAC Database , the value 
should be NA.

For example, <InteractionVariable 
name="DBSERVER_ 
IP">14.15.16.17</InteractionVariabl
e> or

<InteractionVariable 
name="DBSERVER_ 
IP">dbhost.server.com</Interactio
nVariable

>

Yes
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ORACLE_
SID/SERVICE_ NAME

Identifies the Oracle DB Instance 
SID or SERVICE_NAME

Note: The Oracle_SID value should 
be exactly the same as it is 
mentioned in JDBC_URL.

For example, <InteractionVariable 
name="ORACLE_SID/SERVICE_

NAME">ofsaser</InteractionVaria
ble>

Yes

ABS_DRIVER_PATH Identifies the directory where the 
JDBC driver (ojdbc6.jar) exists. This 
would typically be the

$ORACLE_HOME/jdbc/lib

For example, <InteractionVariable 
name="ABS_DRIVER_ 
PATH">">/oradata6/revwb7/oracl
e

</InteractionVariable>

Yes

OLAP_SERVER_ 
IMPLEMENTATION

Identifies if the OFSAA 
Infrastructure OLAP component 
needs to be configured depending 
on whether you intend to use the 
OLAP feature. The following 
numeric value should be set 
depending on the choice:

•      YES - 1

•      NO - 0

No

Note: If value for OLAP_SERVER_IMPLEMENTATION is set to 1, it checks for following 
environment variables are set in .profile:

SFTP_ENABLE Identifies if the SFTP (Secure File 
Transfer Protocol) feature is to be 
enabled. The below numeric value 
should be set depending on the 
choice:

•      SFTP - 1

•      FTP - 0

Yes

Note:

The default value for SFTP_ENABLE is 1, which signifies that SFTP will be used. Oracle recom-
mends using SFTP instead of FTP because SFTP is considered more secure. However, a client 
may choose to ignore this recommendation and to use FTP by setting SFTP_ENABLE to 0. This 
selection may be changed later by using the OFSAAI administration interface.

FILE_TRANSFER_
PORT

Identifies the port used for the file 
transfer service. The default value 
specified is 22 (SFTP). Specify value 
as 21 or any other PORT value if 
value for SFTP_ENABLE is 0.

For example, <InteractionVariable 
name="FILE_TRANSFER_ 
PORT">21</InteractionVariable>

Yes

Table 4–2 (Cont.) Prerequisite Information

InteractionVariableNa
me Significance and Expected Value Mandatory
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LOCALE Identifies the locale information to 
be used during the installation. This 
release of the OFSAA Infrastructure 
supports only US English.

For example, <InteractionVariable 
name="LOCALE">en_
US</InteractionVariable>

Yes

Note: The following ports are used internally by the various OFSAA Infrastructure services. 
The default values mentioned below are set in the installation. If you intend to specify a 
different value, update the parameter value accordingly and ensure this port value is in the 
range of 1025 to 65535 and the respective port is enabled.

JAVAPORT 9999 Yes

NATIVEPORT 6666 Yes

AGENTPORT 6510 Yes

ICCPORT 6507 Yes

ICCNATIVEPORT 6509 Yes

OLAPPORT 10101 Yes

MSGPORT 6501 Yes

ROUTERPORT 6500 Yes

AMPORT 6505 Yes

<Layer name="OFSAAI_WEB_LAYER">

HTTPS_ENABLE Identifies if the UI should be 
accessed using HTTP or HTTPS 
scheme. The default value set is 0. 
The following numeric value 
should be set depending on the 
choice:

•      Yes - 1

•      No - 0

Yes

WEB_SERVER_IP Identifies the HTTP Server IP/ 
Hostname or Web Application 
Server IP/ Hostname, to be used 
for accessing the UI. This IP would 
typically be the HTTP Server IP.

If no separate HTTP Server is 
available, the value should be Web 
Application Server IP/Hostname.

For example, <InteractionVariable 
name="WEB_SERVER_ 
IP">10.11.12.13</InteractionVariabl
e>

or

<InteractionVariable name="WEB_
SERVER_ 
IP">myweb.server.com</Interactio
nVariable>

No

Table 4–2 (Cont.) Prerequisite Information

InteractionVariableNa
me Significance and Expected Value Mandatory
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WEB_SERVER_PORT Identifies the Web Server Port. This 
would typically be 80 for non SSL 
and 443 for SSL. If no separate 
HTTP Server exists, the value 
should be the port configured for 
Web Server.

Note: The port value will not be 
accepted as 80 if HTTPS_ENABLE 
is 1 and as 443, if HTTPS_ENABLE 
is 0.

For example, <InteractionVariable 
name="WEB_ SERVER_
PORT">80</InteractionVariable>

No

CONTEXT_NAME Identifies the web application 
context name which will be used to 
built the URL to access the OFSAA 
applications. The context name can 
be identified from a URL as below:

<scheme>://<host>:<port>/<cont
ext-name>/lo gin.jsp

Sample URL:

https://myweb:443/ofsaadev/
login.jsp

For example, <InteractionVariable 
name="CONTEXT_ 
NAME">ofsaadev</InteractionVari
able>

Yes

Table 4–2 (Cont.) Prerequisite Information

InteractionVariableNa
me Significance and Expected Value Mandatory



Running the OFS CA Installer

                                Installing OFS CA Pack 4-37 

WEBAPP_CONTEXT_
PATH

Identifies the absolute path of the 
exploded .ear file on the web 
application server.

For Tomcat, specify the Tomcat 
directory path till

/webapps, such as

/oradata6/revwb7/tomcat/webap
ps/.

For WebSphere, enter the 
WebSphere path as

<WebSphere profile 
directory>/installedApps/

<NodeCellName>. For example,

/data2/test//WebSphere/AppServ
er/profiles/

<Profile_

Name>/installedApps/aix-imfNod
e01Cell. Where aix-imf is Host 
name.

For WebLogic, provide the 
WebLogic home directory path as 
/<WebLogic home directory 
path>/bea/wlserver_10.3

Note: For WebLogic, value 
specified for this attrbute is ignored 
and value provided against 
attribute WEBLOGIC_DOMAIN_
HOME is considered.

Yes

WEB_LOCAL_PATH Identifies the absolute path to any 
directory on the web application 
server that can hold temporary files 
being uploaded as part of the 
applications usage.

Note: In case of a clustered 
deployment, ensure this path and 
directory is same on all the nodes.

Yes

WEBLOGIC_
DOMAIN_HOME

Identifies the WebLogic Domain 
Home. Specify the value only if 
WEBSERVERTYPE is set as 3 
(WebLogic).

For example, <InteractionVariable 
name="WEBLOGIC_DOMAIN_

HOME">/home/weblogic/bea/us
er_ projects/domains/mydomain

</InteractionVariable>

No

Table 4–2 (Cont.) Prerequisite Information

InteractionVariableNa
me Significance and Expected Value Mandatory



Running the OFS CA Installer

4-38   Oracle Financial Services Customer Analytics Application Pack                     

6. Navigate to the file: OFS_CA_PACK/conf/OFS_CA_Pack.xml and select the 
applications to be enabled.

For Java 8: Edit the VerInfo.txt file to modify the value for property JAVA_
VERSION to 1.8. Save the changes and proceed with step 6.

Note: Enter Yes in ENABLE tag to enable application.

Configure Silent.props
To configure Silent.props, follow these steps:

1. The installer folder contains a template file “Silent.template”

2. Create a copy of this file and rename the copy as “Silent.props”

3. Edit the file “Silent.props” and specify the parameters as per the requirements. For 
details, see Silent.props

Silent.props
Silent installation is achieved via a properties file [Silent.props] that must be updated 
with proper values, before attempting to install using the silent mode. The following 
table lists all the properties that need to be specified:

OFSAAI_FTPSHARE_
PATH

Identifies the absolute path to the 
directory identified as file system 
stage area.

Note: 

1.The directory should exist on the 
same system on which the OFSAA 
Infrastructure is being installed (can 
be on a separate mount).

2.The user mentioned in APP_
SFTP_USER_ID parameter below 
should have RWX permission on 
the directory.

For example, <InteractionVariable 
name="APP_FTPSHARE_
PATH">">/oradata6/revwb7/ftpsh
are</InteractionVariable>

Yes

OFSAAI_SFTP_USER_
ID

Identifies the user who has RWX 
permissions on the directory 
identified under parameter APP_
FTPSHARE_PATH above.

Yes

Table 4–2 (Cont.) Prerequisite Information

InteractionVariableNa
me Significance and Expected Value Mandatory
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Table 4–3 Silent.Props Properties

Property Name
Description of 
Property Permissible values Comments

LOG_MODE Specify Log Mode 1 = Debug Mode

0= General Mode

Password will be 
printed in the log file 

Password will not be 
printed in the log file. 

Default is GENERAL

SEGMENT_1_CODE Specify the Data 
Management Segment 
Code

User Input

APPFTP_LOG_PATH Specify the Infodom 
Maintenance log 
path(to be created) for 
the new Infodom 
Please ignore if you 
are doing installation 
on an existing 
information domain

User Input

DBFTP_LOG_PATH Specify the Infodom 
Maintenance log 
path(to be created) for 
the new Infodom 
Please ignore if you 
are doing installation 
on an existing 
information domain

User Input

UPLOAD_MODEL Specify whether you 
want to perform 
Model Upload

0 = If you have 
already performed 
Model Upload and 
want to skip model 
upload process

1 = If you want to 
perform Model 
Upload

MODEL_TYPE Specify whether you 
want to use the 
released datamodel or 
customized 
datamodel for model 
upload process

0 = If you want to 
upload the released 
datamodel

1 = If you want to 
upload the 
customized 
datamodel

DATAMODEL CA_
DIRECTORY

Specify the path (CA_
DIRECTORY) and file 
(DATAMODEL) name 
for the cutomized 
datamodel Mandatory 
only if you want to 
upload the 
customized 
datamodel i.e you 
have specified 
MODEL_TYPE=1

User Input
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ETL_APPSRC_TYPE Please specify if you 
want create new ETL 
App/Src pair or use 
an existing one.

0 = If you want to 
create a new ETL 
app/src pair

1 = If you want to 
use an existing pair

ETL_APP_1_DESC ETL Data 
Management 
Application 
description

User Input Please give description 
for the ETL App/Src 
pair Mandatory if you 
want to create new 
ETL app/src pair, that 
is, you have specified 
ETL_APPSRC_TYPE = 
0

ETL_SRC_1_1_DESC ETL Data 
Management source 
description

User Input Please give description 
for the ETL App/Src 
pair Mandatory if you 
want to create new 
ETL app/src pair, that 
is, you have specified 
ETL_APPSRC_TYPE = 
0

ETL_APP_1_NAME ETL Data 
Management 
Application name

User Input Specify the ETL 
Application and 
Source Name into ETL 
Area Definitions will 
be deployed

ETL_SRC_1_1_NAME ETL Data 
Management source 
name

User Input Specify the ETL 
Application and 
Source Name into ETL 
Area Definitions will 
be deployed

CIRCA_APPSERVER_
FTP_LOGPATH

Specify the Sandbox User Input Infodom Maintenance 
log path (to be created) 
for the Sandbox 
Infodom name 
specified during 
schema creation. If left 
blank during schema 
creation, the default 
sandbox infodom 
name would be 
"OFSSBXCIRCA"

CIRCA_DBSERVER_
FTP_LOGPATH

Specify the Sandbox User Input Infodom Maintenance 
log path (to be created) 
for the Sandbox 
Infodom name 
specified during 
schema creation. If left 
blank during schema 
creation, the default 
sandbox infodom 
name would be 
"OFSSBXCIRCA"

Table 4–3 Silent.Props Properties

Property Name
Description of 
Property Permissible values Comments
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Running the installer in Silent Mode
To install the OFSAA Infrastructure in Silent mode, execute the following command:

./setup.sh SILENT in the console.

Note:

For Java 8: Edit the VerInfo.txt file to modify the value for property JAVA_
VERSION to 1.8.

Completing the installation in Silent Mode
On launching the installer in silent mode, the environment check utility is executed. 
Enter the required information to execute the utility as explained:

Table 4–4  Webserver start up options

Console Prompts User Inputs

Enter OFSAAI CONFIG 
Schema user name

Enter the user name for OFSAAI configuration schema.

Enter password Enter the configuration schema password.

Enter Oracle SID/ SERVICE 
name

Enter the SID or service name of the Oracle database instance.

The status of each checks performed by the utility is displayed as shown in the figure If the 
status of the utility is Success, it proceeds with the installation.

Note: The above table item is asked if environment check utility  is 
executed in the standalone mode.

Table 4–5  Webserver start up options

Console Prompts User Inputs

Enter Infrastructure 
FTP/SFTP password

Enter the password to access Product Staging/Metadata repository 
directory in the application server.

Note: During installation stage, you need to enter the config schema 
password again.



Running the OFS CA Installer

4-42   Oracle Financial Services Customer Analytics Application Pack                     

1. The OFSAAI License Agreement is displayed as shown in the figure:

2. Accept the License Agreement

Table 4–6  Webserver start up options

Console Prompts User Inputs

 Are you accepting the 
terms and conditions 
mentioned above? [Y/N]

Enter Y if you accept the license agreement and want to proceed with 
installation.
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GUI Mode Installation

Note: Ensure you have followed the steps as mentioned in the 
Configuration for GUI Mode Installation section prior to proceeding with the 
next steps

1. Log in to the system as non-root user.

2. Identify a directory for installation and set the same in the user .profile file as the 
following:

FIC_HOME=<ofsaa_install_dir>
export FIC_HOME 

3. Execute the user .profile.

4. Navigate to the path: OFS_CA_PACK/bin

5. To install OFS CA Application Pack on Java 8, edit the VerInfo.txt file to modify 
the value for property JAVA_VERSION to 1.8. Save the changes and proceed with 
step 6.

6. Execute ./setup.sh GUI in the console.

Note: Refer the console for any errors during Pre-install checks.

Enter password for default 
Infrastructure administrator 
user SYSADMN

Enter the password for the System Administrator.

Re-enter password for 
default Infrastructure 
administrator user 
SYSADMN

Enter the same password again to confirm its validity.

Enter password for default 
Infrastructure authorizer 
user SYSAUTH

Enter the password for the System Authorizer.

Enter password for default 
Infrastructure authorizer 
user SYSAUTH

Enter the same password again to confirm its validity.

Note: SYSADMN and SYSAUTH are the two default OFSAAI 
administrative users created.

Note: The installation process continues on the console. Do not close 
the console until the installation process is complete.

Table 4–6 (Cont.) Webserver start up options

Console Prompts User Inputs
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Figure 4–4 Initialization Window

Figure 4–5 License Agreement

7. Select I accept the terms if the License Agreement option.

8. Click Next.

The Financial Services Customer Analytics Application Pack details are displayed.
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Figure 4–6 Application Pack Details 

9. Select the product to enable for which you have already obtained license. 

10. Click Next. The License Agreement page is displayed.

Figure 4–7 License Agreement page 

11. Select I accept the terms of the License Agreement option.

12. Click Next.

The Manage Information Domain page is displayed.
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Figure 4–8 Manage Information Domain page 

13. Edit the Information Domain Name if it is a new Information domain or if you 
want to change the name of the information domain name.

Note: In case of subsequent Application Pack installation on the same 
Information Domain, you cannot edit the name.

14. Click Next. The License Agreement window is displayed.
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Figure 4–9 License Agreement Window

15. Select I accept the terms of the License Agreement option.

16. Click Next. The License Details page is displayed.

Figure 4–10 License Details Page

17. Click Next. The User Installation Directory window is displayed.
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Figure 4–11 User Installation Directory

Note: The User Installation Directory path is auto-populated from the 
path you have set in the user .profile file in step 2.

18. Click Next. The OFSAA Infrastructure Server Details window is displayed.

Figure 4–12 OFSAA Infrastructure Server Details

19. Enter the IP address or hostname of the OFSAAI server and Database server.

20. Click Next. The Web Application Server window is displayed.
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Figure 4–13 Web Application Server

21. Select the appropriate Web Application server type. The options are Tomcat, 
WebSphere, and WebLogic.

22. Click Next. Based on the selection, corresponding screens are displayed.

For Tomcat: The Absolute Tomcat Path window is displayed.

Figure 4–14 Absolute Tomcat Path

23. Enter the Tomcat installation path (till/webapps) where OFSAAI will be deployed.

For WebSphere: The WebSphere Setup Details window is displayed.
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Figure 4–15 WebSphere Setup Details

24. Enter the installation path (up to the host name directory) of the WebSphere. The 
format is WebSphere path <WebSphere profile 
directory>/installedApps/<NodeCellName>.

For WebLogic: The Weblogic Home window is displayed.

Figure 4–16 Weblogic Home

25. Enter the WebLogic home directory path.



Running the OFS CA Installer

                                Installing OFS CA Pack 4-51 

26. Enter the path of the Weblogic domain home directory and click Next. The OLAP 
Details window is displayed.

Figure 4–17 OLAP Details

27. Enter 1 if you want to configure OFSAAI OLAP feature. By default, 0 is displayed.

28. Click Next. The Web Server Details window is displayed.
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Figure 4–18 Web Server Details

29. Select Enable HTTPS checkbox to configure HTTPS.

30. Enter Web Server (HTTP Server) Port, Web App Server (HTTP Server) IP address, 
context name for deployment and the local path to any folder on the Web 
Application Server (Tomcat/ Websphere/ Weblogic).

31. Click Next. The Database Details window is displayed.

Figure 4–19 Database Details

32. Enter Oracle SID/Service Name, JDBC URL, Configuration Schema User ID and 
Password, and Absolute Driver Path.



Note:

Absolute Driver Path can be the path where Oracle DB client is 
installed or JDBC driver is installed. For example, 
/scratch/oracle/app/oracle/product/11.2.0/client_1/jdbc/lib
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33. Click Next. The Ports Configuration window is displayed.

Figure 4–20 Ports Configuration

34. Enter the Java Port, Native Port, Agent Port, ICC Server Port, and ICC Native 
Ports. You can proceed with the default port values configured.

35. Click Next. The Ports Configuration window is displayed.
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Figure 4–21 Ports Configuration

36. Enter OLAP Port, Message Server Port, Router Port, and AM Port.

37. Click Next. The Default Infrastructure Administrator and Authorizer User 
Password window is displayed.

Figure 4–22 Default Infrastructure Administrator and Authorizer User Password

38. Enter the passwords for default System Administrator and System Authorizer 
users.

39. Click Next. The SFTP Details window is displayed.
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Figure 4–23 SFTP Details

40. Enter 1 to enable SFTP or 0 to enable FTP.

Note: Ensure the system on which the OFSAA Infrastructure is being 
installed, has either FTP/SFTP enabled.

41. Enter the port to be used for file transfer.

42. Click Next. The OFSAAI Post Install Details window is displayed.

Figure 4–24 OFSAAI Post Install Details
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43. Enter the FTPSHARE Path, FTP/SFTP User ID and Password for OFSAAI Server.

Note: The transfer of data (files) between the OFSAAI Server and the 
Web Application Server happens over FTP/SFTP. Ensure the 
necessary host configurations are made for a successful handshake.

44. Click Next. The Sample Application Installation window is displayed.

Figure 4–25 Sample Application Installation

45. Select Yes if you want to install Sample Application.

Note: Ensure the appropriate DB schemas are created for holding the 
Sample Application data. See Database User/ SchemaDatabase User/ 
Schema Database User/ Schema section.

46. Click Next. The Pre Installation Summary window is displayed.
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Figure 4–26 Pre Installation Summary 

47. Click Install. The Installing OFSAA Infrastructure window is displayed.

Figure 4–27 Installing OFSAA Infrastructure

Anytime during the installation you can click Cancel to stop the installation. Once 
completed, the Installation Summary window is displayed.
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Figure 4–28 Installation Summary

The Summary window displays the number of Fatal Errors, Errors, Debug 
Statements, Informations, and Warnings along with the location of log files.

48. Click Next. The Installation Complete window is displayed.

Figure 4–29 Installation Complete

Note: If the installation is successful with some warnings, you can 
navigate to the installation log for more details and address them.
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49. Click Done. The following message is displayed: Please wait, pack_install is being 
configured for your system. This may take a moment.

Figure 4–30 Checking OFSAAI Services

50. The Installer will prepare to install Oracle Financial Services Customer Analytics 
Application Pack.

51. The Solution Setup - Introduction window is displayed.

Figure 4–31 Solution Setup Introduction Window

52. Click Next. The Log mode window is displayed. Select the Log Mode.
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Figure 4–32 Log Mode Window

53. Click Next. The Segment creation window is displayed. Enter the log paths.

Figure 4–33 Segment Creation Window

54. Click Next. The Pre-Infodom Creation Summary window is displayed. 
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Figure 4–34 Pre-Infodom Creation Summary window

55. Click Next. The Infodom creation window is displayed.

Figure 4–35 Infodom creation Window
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56. After creation of infodom, the Tablespace specificiation window is displayed.

Figure 4–36 Tablespace Specificiation Window

57. Click Next. The Model Upload Window is displayed
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Figure 4–37 Model Upload Window

 

58. Select Yes and click Next. The Model Type window is displayed.

Figure 4–38 Model Type Window

59. Select Released Data Model and click Next. The Model is  copied into ftpshare.
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Figure 4–39 Model Copy Window

60. The Model Review Window is displayed.

Figure 4–40 Model Review Window

61. Click Next. It will check for the Heap Memory Warning. The Model Heap Memory 
Warning Window is displayed.
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Figure 4–41 Model Heap Memory Warning Window

62. Click Back. Update your .profile entry with required heap memory size.

•      Open a new session in Putty

•      Shutdown Reveleus server using $FIC_HOME/ficapp/common/FICServer/bin/ 
stopofsaai.sh

•      Update the X_ARGS_APP entry in .profile. Following is an example:

X_ARGS_APP="-Xms2g -Xmx18g -XX:+UseAdaptiveSizePolicy 
-XX:MaxPermSize=1024M -XX:+UseParallelOldGC  
-XX:+DisableExplicitGC"

•      Run .profile

•      Start Reveleus using $FIC_HOME/ficapp/common/FICServer/bin/ 
startofsaai.sh

•      Proceed for model Upload by clicking Next

63. Click Next again. The Upload starts. This takes an approximate time of 3 Hours.
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Figure 4–42 Model Upload Window

64. After Model Upload completion, the Source Pair window is displayed.

Figure 4–43 Source Pair Window

65. Select New Application source and click Next. The Staging details Window is 
displayed.
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Figure 4–44 Staging Details Window

66. Click Next. This creates the staging source folder.

Figure 4–45 Staging Creation Window

67. After creation, click Next. The Installation Details Review window opens.
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Figure 4–46 Installation Details Review Window

68. Click Install. The Confirmation window is displayed.

Figure 4–47 Confirmation Window

69. Click Yes. The Installation starts and the Installation Progress is displayed in the 
Installation Progress window.
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Figure 4–48 Installation Progress Window

70. After Installation completion, the Installation Completion window is displayed.
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Figure 4–49 Installation Completion Window

71. Click Done. The Panel navigates back to Main Application Pack Installation 
Window.

Figure 4–50 Application Pack Installation Window

72. The Installation Summary window is displayed.



Running the OFS CA Installer

                                Installing OFS CA Pack 4-71 

Figure 4–51 Installation Summary Window

73. Click Done. The Installation Complete Window is displayed.

Figure 4–52 Installation Complete Window

74. Click Done. 

Note: The installation process continues on the console. Do not close 
the console until the installation process is complete.
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Figure 4–53 Installation Complete Window

75. Select the log mode and click Next.

Figure 4–54 Log Mode

76. Enter the details to create a information domain, and click Next.
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Figure 4–55 Information domain

77. Verify the details and click Next.

Figure 4–56 Pre-Infodom Creation Summary

78. Enter the tablespace name (Infodom database) and click Next.
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Figure 4–57 Tablespace Name

79. Select Yes if you want to perform model upload and click Next.

Figure 4–58 Model Upload Window

80. Select the type of data model, and click Next.
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Figure 4–59 Model Type Window

81. The following panel is displayed. Wait for some time to configure the solution 
setup and click Next.

Figure 4–60 Solution - Setup Window

82. Verify the summary details, and click Next.
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Figure 4–61 Pre-Upload Model Summary Window

83. Select the ETL application/source, and click Next.

Figure 4–62 Application Source details

84. Enter the ETL application details, and click Next.
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Figure 4–63 ETL Application Details

85. Click Install. The Installing OFSAA Infrastructure window is displayed.

Figure 4–64 Installing OFSAA Infrastructure

Anytime during the installation you can click Cancel to stop the installation. Once 
completed, the Installation Summary window is displayed.

86. Click Done.
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Figure 4–65 Installation Complete Window

The following message is displayed: Please wait, pack_install is being configured for 
your system. This may take a moment.

87. Click Next. The installation summary page is displayed.
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Figure 4–66 Installation Summary Window

88. Click Done to finish the installation.

Figure 4–67 Installation Complete Window

Post Install Health checks are displayed:
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Figure 4–68 Installation Complete

Verifying the Log File
The log files OFS_CA_installation.log and OFSAAInfrastructure_Install.log can be 
found in the installation path $FIC_HOMElocation of the installer, in this case OFS_
CA_PACK. The log files contain detailed summary of installation processes. It also 
shows the number of Fatal Errors, Errors, Debug Statements, Information, and 
Warnings. 

There are three log files:

•      Application Pack specific log file (overall status of the app pack installation): OFS_
CA_PACK/logs/ Pack_Install.log

•      AAI Installation log file: /scratch/ofsaaweb/MP1/OFS_CA_PACK/OFS_
AAI/logs/OFSAAI8<timestamp>.log

•      Application installation log file: OFS_CA_PACK/OFS_CA/logs 

•      OFS_CA_Installation_debug.log

•      OFS_CA_installation.log

Note: The warnings "IMP-00041: object created with compilation 
warnings" present in sampleapp.log can be ignored. 
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Verifying the Installation
This section explains the steps to verify your installation of application.

To verify that you have successfully installed the Customer Analytics pack, follow 
these steps:

1. Login in to the atomic/*schema.

2. Verify the application log (it must not have any error).

3. Verify all the database objects like view, procedure, and functions must have been 
complied without any compilation error.

4. Deploy the war file and check whether the application screen is coming or not.
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5Post Installation Configuration

On successful installation of the Oracle Financial Service Customer Analytics 
Application Pack, refer the following post installation sections:

This chapter includes the following sections:

•      Configuring Resource Reference

•      Configuring Web Application Server

•      Creating and Deploying the Application Pack Web Archive 

•      Changing Batch ownership

•      Updating OBIEE URL

•      Configurations for Java 8

Note: Ensure to clear the application cache prior to the deployment of 
Application Pack Web Archive. This is applicable to all Web Servers 
(WebSphere, WebLogic, and Tomcat). For more information, refer 
Clearing Application Cache section.

Configuring Resource Reference
This section describes the details for configuring the resource reference in WebSphere, 
Weblogic, and Tomcat Application Servers. For detailed information, refer to 
Configuring Resource Reference.

Configuring Web Application Server
This section describes the details to configure the different web application servers for 
OFSAA Infrastructure deployment namely, IBM Websphere, Oracle Weblogic, and 
Apache Tomcat Servers. For detailed information, refer to Configuring Web Application 
Servers.

Creating and Deploying the Application Pack Web Archive
To create and deploy the application pack web archive, follow these steps:

1. Navigate to the $FIC_WEB_HOME directory.

2. Execute the command:

./ant.sh



Changing Batch ownership

5-84 Oracle Financial Services Customer Analytics Application Pack                     

3. This will trigger the creation of EAR/WAR file - <contextname>.<extn>. Here 
<contextname> is the context name given during installation.

4. On completion of the EAR/WAR files creation, the "BUILD SUCCESSFUL" and 
"Time Taken" message is displayed and you are returned to the prompt.

5. The EAR/WAR file - <contextname>.<extn> - is created under "$FIC_WEB_HOME" 
directory.

Note: This process overwrites any existing version of EAR/WAR file in the 
path. If the web application server is Apache Tomcat, the file created 
would be <contextname>.war.

6. Deploy the generated EAR/WAR file on to the web application server. For 
detailed information, refer Deploying EAR/WAR File.

Changing Batch ownership 
All the seeded batches are created with SYSADMN as the owner by default. This 
needs to be updated with username of the user who is responsible for maintenance of 
the batches. This can be done by executing the following procedure in the config 
schema:

begin

AAI_OBJECT_ADMIN.TRANSFER_BATCH_
OWNERSHIP('fromUser','toUser','infodom; 

end;

OR

begin

AAI_OBJECT_ADMIN.TRANSFER_BATCH_OWNERSHIP('fromuser','touser'); 

end;

where "FromUser" indicates the user who currently owns the batch and "toUser" 
indicates the user to which ownership needs to be transferred to "Infodom" is an 
optional parameter.

Updating OBIEE URL
To access the respective Business Intelligence Analytics Application, you need to 
update the OBIEE url in the table 'AAI_MENU_B', once the OBIEE environment is up 
and running. 

Following update statement needs to be executed in the config schema:

UPDATE AAI_MENU_B

SET V_MENU_URL = '<obieeURL>'

WHERE V_MENU_ID IN ('<List of enabled BI Analytical Links for a particular 
Media Pack >')

/

COMMIT
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/

For CA Media Pack as an example:

UPDATE AAI_MENU_B

SET V_MENU_URL = 'http://RCA:port/analytics'

WHERE V_MENU_ID IN ('OFS_RCABI_LINK')

/

COMMIT

/

Configurations for Java 8
Refer to the following instructions to extract and apply the patch.

1. Copy the downloaded patch file ( 21160684) to your OFSAA server in Binary mode. 

For more information on downloading the patch files, refer  Prerequisite 
Information section >> Category - Others >> Sub-Category - OFSAA.

2. Follow the instructions given in the Readme to apply the patch.

3. If the Oracle Database version is 12c, copy ojdbc7.jar from $ORACLE_
HOME/jdbc/lib to the following locations:

•      $FIC_HOME/utility/OFSAAGenerateRepository/lib/

•      $FIC_HOME/realtime_processing/WebContent/WEB-INF/lib/

•      $FIC_HOME/ficdb/lib/

•      $FIC_HOME/ficapp/icc/lib/

•      $FIC_HOME/ficapp/common/FICServer/lib/

•      $FIC_HOME/FMStandalone/FormsManager/WEB-INF/lib/

•      $FIC_HOME/ficweb/webroot/WEB-INF/lib/

•      $FIC_HOME/ficdb/etl/classes/

4. If the Oracle Database version is 11g, copy ojdbc6.jar from $ORACLE_
HOME/jdbc/lib to the following locations:

•      $FIC_HOME/utility/OFSAAGenerateRepository/lib/

•      $FIC_HOME/realtime_processing/WebContent/WEB-INF/lib/

•      $FIC_HOME/ficdb/lib/

•      $FIC_HOME/ficapp/icc/lib/

•      $FIC_HOME/ficapp/common/FICServer/lib/

•      $FIC_HOME/FMStandalone/FormsManager/WEB-INF/lib/

•      $FIC_HOME/ficweb/webroot/WEB-INF/lib/

•      $FIC_HOME/ficdb/etl/classes/
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6Start and Stop of  Infrastructure Services

This chapter details about how to start and stop Infrastructure services. This chapter 
includes the following topics:

•      Starting Infrastructure Services

•      Stopping Infrastructure Services

Starting Infrastructure Services
Once the installation of Infrastructure has been completed successfully and the 
post-installation steps are completed, the servers must be started. Log on to each 
machine and run the .profile file. All servers mentioned must be started from the 
same shell encoding. The servers mentioned below are dependent on each other. It is 
mandatory to maintain the order in which the servers are started. Allow each of the 
servers to initialize completely before starting the next server.

1. On the machine in which Infrastructure Application components have been 
installed, navigate to $FIC_APP_HOME/common/FICServer/bin and execute the 
following command to start the Infrastructure Server.

./startofsaai.sh

Note: You can also start the Infrastructure Server by executing the 
command "nohup ./ startofsaai.sh &". Starting the process using 
"nohup" and "&" will return the command prompt without having to 
wait till the process completes. However, this command cannot be 
used when you are starting the server for the first time or starting after 
changing user password in the configuration database schema.You 
can also start the Infrastructure Server by executing the command 
"nohup ./ startofsaai.sh &". Starting the process using "nohup" and 
"&" will return the command prompt without having to wait till the 
process completes. However, this command cannot be used when you 
are starting the server for the first time or starting after changing user 
password in the configuration database schema.

2. Select the required webserver start up option from the following table:



Table 6–1  Webserver start up options

Start up Option Description

Starting WebSphere profile On the machine in which Web sphere is installed, navigate to 
[Webshpere_Install_Directory] 
/AppServer/<profiles>/<profile name>/bin and execute the 
command: ./startServer.sh server1

Starting WebLogic Domain On the machine in which WebLogic is installed, navigate to 
<WebLogic Installation directory>/user_
projects/domains/<domain name>/bin and execute the 
command: startWebLogic.sh -d64

Note: If WebLogic is already running, access the WebLogic 
Admin Console. Stop and start the application <context 
name>.ear

Starting Tomcat 
Application

On the machine in which Tomcat is installed, navigate to 
<Tomcat_Install_ Directory>/bin and execute the command: 
./catalina.sh run

Stopping Infrastructure Services

6-88 Oracle Financial Services Customer Analytics Application Pack                     

3. Start ICC server:

a. On the machine in which Infrastructure default Application components have 
been installed, navigate to $FIC_HOME/ficapp/icc/bin and execute the 
command:

 ./iccserver.sh

Note: Only Infrastructure Default Application Server would hold 
ICC component.

4. To start Back-end Services:

a. On the machine on which Infrastructure Database components have been 
installed, navigate to $FIC_DB_HOME/bin and execute the command to start 
"Agent server":

./agentstartup.sh 

Or

Start Back-end services using the command:

nohup./agentstartup.sh &

Note: This agent internally starts the Router, Message Server, OLAP 
data server, and AM services.

Stopping Infrastructure Services
To stop Infrastructure services, follow these steps:

1. On the machine in which Infrastructure Application components have been 
installed, navigate to $FIC_APP_HOME/common/FICServer/bin and execute the 
command:.

./stopofsaai.sh
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2. To stop ICC server, on the machine in which Infrastructure default Application 
components have been installed, navigate to $FIC_HOME/ficapp/icc/bin and 
execute the command:

./iccservershutdown.sh

Note: Only Infrastructure Default Application Server would hold 
ICC component.

3. To stop Back-end server, on the machine in which Infrastructure database 
components have been installed, navigate to $FIC_DB_HOME/bin and execute the 
command:

./agentshutdown.sh
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7Post Deployment Configuration

This chapter includes the following topics:

•      Deploying the Application

•      Logging as System Administrator

•      Creating Users

•      Mapping User to User Group

Deploying the Application
This section explains steps to deploy the application. Web Layer deployment is 
required, For more information refer Appendix.

Logging as System Administrator
Post installation, only a System Administrator can login into Infrastructure through 
user id "sysadmn". This ID is created at the time of installation with the password 
provided during installation. Enter login id as "sysadmn" and the password that was 
provided during installation. Click Login. For more information, refer OFSAAI Login.

Creating Users
User Maintenance facilitates you to create user definitions, view, manage, modify, and 
delete user information. You can access User Maintenance by expanding User 
Administrator section within the tree structure of LHS menu.

The User Maintenance screen displays user details such as User ID, Name, Profile 
Name, Start and End dates. You can also identify the user status if enabled to access 
the Infrastructure system.

To add a user in the User Maintenance screen, follow these steps:

1. Select the Add button from the User Maintenance toolbar. This button is disabled 
if you have selected any User ID in the grid. The New User screen is displayed.
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Figure 7–1 User Maintenance Window

2. Enter the user details as tabulated:

Table 7–1  Prerequisite Information

Fields Description

User ID Enter a unique user id. Ensure that there are no 
special characters and extra spaces in the id entered.

User Name Enter the user name. The user name specified here 
will be displayed on the Infrastructure splash 
screen. Ensure that the User Name does not contain 
any special characters or spaces except "-", "'". and 
".".

Contact Address Enter the contact address of the user. It can be the 
physical location from where the user is accessing 
the system. Ensure that Contact Address does not 
contain any special characters except ".", "#", "-", ",".

Date Of Birth Specify the date of birth. You can use the popup 
calendar to enter the date.

Designation Enter the user designation. Ensure that Designation 
does not contain any special characters except "_, ":" 
and "-".
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3. Click Save to upload the user details.

The new User details are populated in the User Authorization screen which has to 
be authorized by System Authorizers. Once authorized, the User details are 
displayed in User Maintenance screen and can then be mapped to the required 
user group in the User UserGroup Map screen.

Profile Name Select the profile name by clicking on the 
drop-down list. 

User Start Date Specify the user start date based on the day slot the 
user is enabled to access the system. Ensure that 
User Start Date is greater than today's date. You can 
use the popup calendar to enter the date. 

User End Date Specify the user end date based on month and year 
when the user Id expires. Ensure that user End Date 
is greater than User Start Date. You can use the 
popup calendar to enter the date. 

Password Enter the default password for the user for the 
initial login. User needs to change the default 
password during the first login. 

A user is denied access in case the user has 
forgotten the password or enters the wrong 
password for the specified number of attempts (as 
defined in the Configuration screen). To enable 
access, enter a new password here.

Notification Time •      (Optional) Specify the notification start and 
end time within which the user can be notified 
with alerts. 

E-mail ID Enter the e-mail address of the user. 

Mobile No (Optional) Enter the mobile number of the user

Pager No (Optional) Enter the pager number of the user. 

Enable User Select the checkbox to allow user to access the 
system. 

A deselected checkbox denies access to the user.

Table 7–1 (Cont.) Prerequisite Information

Fields Description
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Mapping User to User Group
User UserGroup Map facilitates you to map user(s) to specific user group which in 
turn is mapped to a specific Information Domain and role. Every UserGroup mapped 
to the infodom needs to be authorized. Else, it cannot be mapped to users.

User UserGroup Map screen displays details such as User ID, Name, and the 
corresponding Mapped Groups. You can view and modify the existing mappings 
within the User UserGroup Maintenance screen.

You can access User UserGroup Map by expanding User Administrator section within 
the tree structure of LHS menu.

The following user groups are used in Customer Analytics Pack:

•      CA Admin

•      CA Analyst 

•      CA Authorizer 
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8OFS CA Configuration

This chapter explains the following steps that are to be followed for configuring Retail 
Customer Analytics v8.0.0.0.0 Dashboards and Reports after OBIEE installation 
(Server):

A. Preliminary Installation of Software

1. Make sure Oracle Business Intelligence (Version 11.1.1.7.1) installation is 
completed and available.

2. If the OBIEE is installed in other than Windows environment, ensure that a 
standalone OBIEE Client is installed in a Windows environment.

B. Modify Repository Connection Pool Settings

For Windows Server

1. Copy the Repository file from the $FIC_HOME/CIRCA and place it in the Repository 
folder where OBIEE is installed.

<OBIEE Install Folder>/instances/instance1/bifoundation/ 
OracleBIServerComponent/coreapplication_obis1/repository

2. Select Start >Programs >Oracle Business Intelligence>Administration.

3. Select File >Open >Offline.

4. Locate the CIRCA.rpd and open.

5. Provide Repository password. The Repository password is "Admin123". 

Set the Connection Pool Properties:

6. In the "Physical" layer, under Database object, double-click the Connection Pool to 
update its properties.

7. In the General tab, edit/check the following entry: 

Call Interface: Default (OCI 10g/11g)

8. Update Data source name as give in the following example:

(DESCRIPTION=(ADDRESS_LIST=(ADDRESS=(PROTOCOL=TCP)(HOST=<Database IP 
Address>)(PORT=<Port no>)))(CONNECT_DATA=(SID=<Database name>)))

9. Enter Database Schema user name in the User Name field.

10. Enter Database Schema password in the Password field.

11. Click OK to close the window and click Save to save the RPD file.

12. Click No for the Global Consistency Message.

13. Close the RPD file (File/Exit).



Note:

Repeat the same configuration for all the connection pools in the RPD.
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For Other Servers

1. Copy the Repository file from the $FIC_HOME/CIRCA and place it anywhere in the 
local Windows system.

2. Open the BI Administration tool in the windows environment.

3. Select Start >Programs >Oracle Business Intelligence Enterprise Edition Plus 
Client>Administration.

4. Select File >Open > Offline.

5. Locate the file CIRCA.rpd and open.

6. Provide Repository password. The Repository password is "Admin123".

Set the Connection Pool Properties as described in the above steps 6...14.

C. Starting Node manager and Weblogic Servers

1. Check if the Node Manager is running or not. If not then follow the following 
steps.

For Windows Server

1. Go to the services.

2. Start the Service Oracle Weblogic NodeManager.

 

Alternatively you can start Node Manager and all the managed services from 
the All Programs -> Oracle Business Intelligence-> Start BI Services option 
in the Start menu.

For Other Servers

1. Navigate to < OBIEE Install Folder >/ wlserver_10.3/server/bin folder.
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2. Run the following command: nohup ./startNodeManager.sh &.

Check if the Weblogic AdminServer if running or not. If not, then follow these 
steps.

For Windows Server

•      Navigate to < OBIEE Install Folder >/user_projects/domains/bifoundation_
domain/bin

•      Run the following command: startWebLogic.cmd

Note: The Weblogic Admin Server would have been already started if 
you had started through the All Programs -> Oracle Business 
Intelligence-> Start BI Services option as stated above

For Other Servers

•      Navigate to < OBIEE Install Folder >/user_projects/domains/bifoundation_
domain/bin

•      Run the following command: ./startWebLogic.sh

•      Enter the weblogic credential defined during the installation.

•      Bringing up this service can take a few minutes depending on your 
environment, wait until the command line stops scrolling and indicates server 
in RUNNING mode.

•      Start Weblogic Managed Server (bi_server1)

•      Log in to Fusion Middleware Control http://<hostserver name or 
IP>:<Port No Default is 7001>/em using the weblogic credentials defined 
during installation.

•      Under the WebLogic Domain, expand the bifoundation_domain node in the 
navigation tree.

•      Select bi_cluster and click the WebLogic Cluster menu to the right of it. Select 
the Control option from the menu, and select Start Up to start the Managed 
Servers.
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•      Verify the status of the applications.

 

D. Deployment

Deploy RPD file

1. Log in to Fusion Middleware Control http://<hostserver name or IP>:<Port 
No Default is 7001>/em using the weblogic credentials defined during 
installation.

2. Go to Business Intelligence folder > coreapplication> Deployment and click 
Lock and Edit Configuration.
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3. In the Upload BI Server Repository click Browse and locate the folder where the 
new CIRCA.rpd which has to be deployed is present.

4. Now put the existing RPD Password. Then Apply >Activate Changes.

5. You can see the new Default RPD as the CIRCA_BI0001.

 

6. Restart the BI Server as mentioned in the Starting the Analytics services section.

7. Modify the NQSConfig.INI file to incorporate User Roles and Group Id changes in 
case any GUID related error occurs. The location is < OBIEE Install Folder>

/instances/instance1/config/OracleBIServerComponent/coreapplication_
obis1

Change the FMW_UPDATE_ROLE_AND_USER_REF_GUIDS to YES.

For example: FMW_UPDATE_ROLE_AND_USER_REF_GUIDS = YES;

8. After modifying the file, restart the BI services again to remove the above error.
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Deploy Web Catalog

1. Copy the CIRCA.catalog file from $FIC_HOME/CIRCA folder.

2. Go to Business Intelligence folder > coreapplication> Deployment and check for 
the Catalog name. Change to RCA then apply and activate changes. This will create 
a new empty catalog with the name given.

For example

$ORACLE_
INSTANCE/bifoundation/OracleBIPresentationServicesComponent/$COMPONENT_
NAME/catalog/RCA

3. Go to Catalog Manager. Open the newly created catalog File -> Open Catalog.

4. Open the catalog online -> Browse to the catalog path. Click OK.

5. Now navigate to the /shared folder in the catalog manager and unarchive by 
selecting the path where the CIRCA.catalog was present. Then press OK.
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6. Verify that the Retail Customer Analytics folder appears under /shared folder.

7. Once the Unarchive is done. Restart the BI Presentation Services(see Starting the 
Analytics services) to apply the change. 

8. Modify the instanceconfig.xml file in case of any GUID error related to the BI 
Presentation Server to instruct Presentation Services to refresh GUIDs on restart.

The location of instanceconfig.xml file is < OBIEE Install Folder> 
/instances/instance1/config/OracleBIPresentationServicesComponent/corea
pplication_obips1

Edit the file to add the line 
<UpdateAccountGUIDs>UpdateAndExit</UpdateAccountGUIDs> and restart the BI 
presentation services once again.

9. The steps mentioned above will force the BI Presentation Services to shut down 
after updating the Account GUIDS.

In that case, go to instanceconfig.xml file and revert back the changes made, 
that is,  remove the line 
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<UpdateAccountGUIDs>UpdateAndExit</UpdateAccountGUIDs> from the 
instanceconfig.xml file and restart the services again.

E. Starting the Analytics services 

The Oracle Business Intelligence system components can start in any of the following 
manner.

Through OPMN controller

For Windows Server

1. Open a command prompt, navigate to <OBIEE Install 
Folder>/instances/instance1/bin

2. Run the opmnctl startall command.

For Other Servers 

1. Navigate to < OBIEE Install Folder > /instances/instance1/bin

2. Run the command ./opmnctl startall

3. Check the status by running the command ./opmnctl status

Through Enterprise Manager

1. Login to the EM administration screen using the url http://<hostserver name or 
IP>:<Port No Default is 7001>/em

2. Expand Business Intelligence node on the left and select Core application.

3. Navigate to Capacity management > Availability.

4. Click the necessary buttons to start and stop the services.
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5. In case of any problems, check for the log files present in the respective diagnostic 
folders of analytics server, that is, <OBIEE Install 
Folder>/instances/instance1/diagnostics/logs.

F. Testing the Analytics reports 

1. Log in to http:// <host server name or IP>:<Port No default is 
7001>/analytics/saw.dll?Dashboard using your Administrator credentials 
created during platform install.

2. Check for the reports availability. 

3. In case of any problems, check for the log files present in the respective diagnostic 
folders of analytics server, that is, <OBIEE Install 
Folder>/instances/instance1/diagnostics/logs. 
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AAppendix

This chapter covers the following topics:

•      Configuring Web Server

•      Configuring Web Application Servers

Configuring Web Server
The Web Server (HTTP Server) supported in this release of OFSAA are Oracle HTTP 
Server, Apache HTTP Server, and IBM HTTP Server.

Refer the product specific installation guide to install and configure the Web Server. If 
an installation already exists, skip and proceed to the next step.

Note: Make a note of the IP Address/Hostname and Port of the web 
server. This information is required during the installation process.

Note: Refer OFSAA Secure Configuration Guide/Security Guide for 
additional information on securely configuring your Web Server.

Note: Ensure to enable sticky session/ affinity session configuration 
on the web server. Refer the respective product specific Configuration 
Guide for more details. Additionally, you also need to enable the 
sticky session/ affinity session configuration at Load Balancer level if 
you have configured a Load Balancer in front of the web server(s).

Configuring Web Application Servers
You can deploy multiple OFSAA applications on different profiles of a WebSphere 
application server. To create multiple WebSphere "Profiles", use the command line 
option as explained below. A profile is the set of files that define the runtime 
environment. At least one profile must exist to run WebSphere Application Server.

This section includes the following topics:

•      Configuring WebSphere for Application Deployment

•      Configuring WebLogic for Application Deployment

•      Configuring Apache Tomcat Server for Application Deployment



Note: Refer OFSAA Secure Configuration Guide/Security Guide for 
additional information on securely configuring your Web Application 
Server.

Configuring Web Application Servers
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 Configuring WebSphere for Application Deployment
Applicable only if the web container is WebSphere.

You can deploy multiple Infrastructure applications on different profiles of a 
stand-alone WebSphere application server. To create multiple WebSphere "Profiles" in 
a stand-alone server, use the command line option as explained below. A profile is the 
set of files that define the runtime environment. At least one profile must exist to run 
WebSphere Application Server.

This section covers the following topics:

•      Creation of New Profile in WebSphere

•      Manage Applications in WebSphere

•      Delete WebSphere Profiles

•      WebSphere HTTPS Configuration

•      WebSphere Memory Settings

Creation of New Profile in WebSphere
The Profile is created in WebSphere through command line using the 
manageprofiles.sh which resides in <WebSphere Install directory>/AppServer/bin.

The command to create a profile without admin security through command line is as 
follows:

"manageprofiles.sh -create -profileName <profile> -profilePath <profile_
path> -templatePath <template_path> -nodeName <node_name> -cellName <cell_
name> -hostName <host_name>"

Example:

$usr/home>./manageprofiles.sh -create -profileName mockaix 
-profilePath/websphere/webs64/Appserver/profiles/mockaix 
-templatePath/websphere/webs64/Appserver/profileTemplates/default 
-nodeName ipa020dorNode04 - cellName ipa020dorNode04Cell -hostName 
ipa020dor

The command to create a profile with admin security through command line is as 
follows:

"manageprofiles.sh -create -profileName <profile> -profilePath <profile_
path> -templatePath <template_path> -nodeName <node_name> -cellName <cell_
name> -hostName <host_name> -enableAdminSecurity true -adminUserName 
<Admin User Name> -adminPassword < Admin User Password> -samplespassword 
<sample User Password>" 

Example:

$usr/home>./manageprofiles.sh -create -profileName mockaix 
-profilePath/websphere/webs64/Appserver/profiles/mockaix 
-templatePath/websphere/webs64/Appserver/profileTemplates/default 
-nodeName ipa020dorNode04 -cellName ipa020dorNode04Cell -hostName 
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ipa020dor -enableAdminSecurity true -adminUserName ofsaai -adminPassword 
ofsaai -samplespassword ofsaai"

Note: While using the manageprofiles.sh command to create a New 
Profile in WebSphere, you can also use "-validatePorts" to validate if 
the specified ports are not reserved or in use. Additionally, you can 
specify new ports with "-startingPort <base port>" which specifies 
the starting port number to generate and assign all ports for the 
profile. For more information on using these ports, refer WebSphere 
manageprofiles command.

Manage Applications in WebSphere
To manage the installed applications in WebSphere, do the following:

1. Open the administrator console using the following URL:

http://<ipaddress>:<Administrative Console Port>/ibm/console

Example: http://10.111.222.333:9003/ibm/console (https if SSL is enabled)

Note: Administrative Console Port value is available in 
serverindex.xml file within <WebSphere Profile 
Directory>/config/cells/<Node Cell>/nodes/<Node Name> 
directory.

The Integrated Solutions Console Login window is displayed.

Figure 8–1 Integrated Solutions Console Login

2. Log on with the User ID provided with the admin rights.

http://publib.boulder.ibm.com/infocenter/wasinfo/v6r1/index.jsp?topic=%2Fcom.ibm.websphere.base.doc%2Finfo%2Faes%2Fae%2Frxml_manageprofiles.html
http://publib.boulder.ibm.com/infocenter/wasinfo/v6r1/index.jsp?topic=%2Fcom.ibm.websphere.base.doc%2Finfo%2Faes%2Fae%2Frxml_manageprofiles.html
http://publib.boulder.ibm.com/infocenter/wasinfo/v6r1/index.jsp?topic=%2Fcom.ibm.websphere.base.doc%2Finfo%2Faes%2Fae%2Frxml_manageprofiles.html
http://publib.boulder.ibm.com/infocenter/wasinfo/v6r1/index.jsp?topic=%2Fcom.ibm.websphere.base.doc%2Finfo%2Faes%2Fae%2Frxml_manageprofiles.html
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3. From the LHS menu, expand the Applications > Application Type> WebSphere 
Enterprise Applications.

The Enterprise Applications screen is displayed.

Figure 8–2 Enterprise Applications

 This Enterprise Applications screen helps you to:

•      Install new application

•      Uninstall existing applications

•      Start or Stop the installed applications

Delete WebSphere Profiles
To delete a WebSphere profile, do the following:

1. Select the checkbox adjacent to the required application and click Stop.

2. Stop the WebSphere profile to be deleted.

3. Navigate to WebSphere directory:

<WebSphere_Installation_Directory>/AppServer/bin/

4. Execute the command:

manageprofiles.sh -delete -profileName <profile_name>

5. Delete profile folder.

Example: <WebSphere_Installation_
Directory>/AppServer/profiles/<profile_name>

6. Execute the command:

manageprofiles.sh -validateAndUpdateRegistry
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WebSphere HTTPS Configuration
Following are the steps for configuring an HTTPS Transport on WebSphere:

1. Create a profile using the Profile Creation Wizard in WebSphere.

Note: Note down the https port specified during this process and 
use the same as servlet port or web server port during OFSAAI 
installation.

2. To enable https configuration on Infrastructure, assign value 1 to "HTTPS_
ENABLE" in OFSAAI_InstallConfig.xml for Silent mode OFSAAI installation.

WebSphere Memory Settings
To configure the WebSphere Memory Settings:

1. Navigate to Websphere applications server > Application servers > 
server1 > Process definition > Java Virtual Machine.

2. Change the memory setting for Java Heap:

Initial heap size = 512

Maximum heap size = 3072

Configuring WebLogic for  Application Deployment
You can deploy multiple Infrastructure applications on different domains of a 
stand-alone weblogic application server. To create multiple WebLogic "Domains" in a 
stand-alone server you can use the Domain Creation wizard. A domain is the set of 
files that define the runtime environment. At least one domain must exist to run 
WebLogic Application Server.

Note:

For deployment on Oracle WebLogic Server 12.1.2+ (64 bit) with Java

8, download and install patch 18729264.

This section covers the following topics:

•      Creating Domain in WebLogic Server

•      Delete Domain in WebLogic

•      WebLogic Memory Settings

Creating Domain in WebLogic Server
To create a new domain using Configuration Wizard in WebLogic, do the following:

1. Navigate to the directory <weblogic_Home Directory>/wlserver_
10.3/common/bin and execute the command:

.\config.sh

The Welcome window of the Configuration Wizard is displayed.
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Figure 8–3 Welcome

2. Select Create a new WebLogic domain option and click Next.

The Select Domain Source window is displayed.

Figure 8–4 Select Domain Source

3.  Select the Generate a domain configured automatically to support the following 
products option and click Next. 
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The Specify Domain Name and Location window is displayed.

Figure 8–5 Specify Domain Name and Location

4. Enter the Domain Name and Location. Click Browse to navigate and specify the 
location. Click Next.

The Configure Administrator Username and Password window is displayed.

Figure 8–6 Configure Administrator Username and Password
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5. Enter the User name and User password to be assigned to the Administrator. 
Ensure that the password is of minimum 8 characters in length.

6. Re-enter the password for confirmation and add a brief Description. Click Next.

The Configure Server Start Mode and JDK window is displayed.

Figure 8–7 Configure Server Start Mode and JDK

7. Select the following options: 

In the WebLogic Domain Startup Mode section, select the required mode 
(Development Mode or Production Mode).

In the JDK Selection section, select Other JDK. Click Browse and navigate to the 
JDK location. Click Next.

The Select Optional Configuration window is displayed.
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Figure 8–8 Select Optional Configuration

8. Select Administration Server. A WebLogic Server domain must have an 
Administration Server. You can also select Manages Servers, Clusters and 
Machines and RDBMS Security Store if required. Click Next.

The Configure the Administration Server window is displayed.
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Figure 8–9 Configure the Administration Server

9. Enter Administration Server details such as the Name, Listen address, Listen Port, 
SSL listen port, and SSL enabled (for secure login using https) check box. Click 
Next.

The Configuration Summary window is displayed.

Note: Make a note of the Listen Port or SSL Listen Port value (ex: 
7007), since the same has to be re-entered in the Servlet port field 
during Infrastructure installation.
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Figure 8–10 Configure Server Start Mode and JDK

10. Verify the configuration details of the WebLogic domain and click Create. 

The Creating Domain window is displayed with the status indication of the 
domain creation process.
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Figure 8–11 Configure Server Start Mode and JDK

11. Click Done when complete. The domain server is created enabling the 
deployment of multiple Infrastructure applications on a single WebLogic.

Delete Domain in WebLogic
1. Navigate to the following directory:

<WebLogic Installation directory>/user_projects/domains/<domain 
name>/bin

2. Execute stopWebLogic.sh to stop the Weblogic domain.

3. Delete the Weblogic domain.

WebLogic Memory Settings
To configure the WebLogic Memory Settings:

1. Change the memory setting for Java Heap to -Xms512m -Xmx3072m in 
setDomainEnv.sh file, which resides in the folder <DOMAIN_HOME>/bin and in 
CommEnv.sh file which resides in the folder common/bin.

2. Edit this file for customizing memory settings and garbage collector settings 
depending on the available hardware configuration.

Example 1:

if [ "${JAVA_VENDOR}" = "Sun" ] ; then

WLS_MEM_ARGS_64BIT="-Xms512m -Xmx1024m"

export WLS_MEM_ARGS_64BIT

WLS_MEM_ARGS_32BIT="-Xms512m -Xmx1024m"

export WLS_MEM_ARGS_32BIT

else



Configuring Web Application Servers

                       Appendix A-13

WLS_MEM_ARGS_64BIT="-Xms512m -Xmx1024m"

export WLS_MEM_ARGS_64BIT

WLS_MEM_ARGS_32BIT="-Xms512m -Xmx1024m"

export WLS_MEM_ARGS_32BIT

Example 2:

JAVA_VM=

MEM_ARGS="-Xms256m -Xmx1024m"

Configuring Apache Tomcat Server for Application Deployment
This section is applicable only when the Web Application Server type is Tomcat.

This section covers the following topics:

•      Tomcat User Administration

•      Configure Tomcat to use JAVA 64 bit Executables

•      Configure Servlet Port

•      Create Tomcat WAR Files

•      SSL Port Configuration

•      Apache Tomcat Memory Settings

•      Uninstalling WAR Files in Tomcat

•      Configuration for Axis API

Tomcat User Administration
The Tomcat administration and manager application does not provide a default login. 
You are required to edit "$CATALINA_HOME/conf/tomcat-users.xml" as instructed 
below.

This file contains an XML <user> for each individual user, which will display the 
username and password used by admin to log on to Tomcat, and the role names to 
which the admin user is associated with. For example, <user name="admin" 
password="admin" roles="standard,manager" />

1. Add the manager role to any one of the existing username/password combination 
as shown in the example above.

2. Use the same username/password to which the manager role has been assigned to 
access the Tomcat Application Manager.

3. If the Tomcat server is already running, it requires a re-start after the above 
configuration is done.

Configure Tomcat to use JAVA 64 bit Executables
1. Navigate to the "$CATALINA_HOME/bin" folder.

2. Edit the setclasspath.sh as explained below:

3. Under 'Set standard commands for invoking Java', change "$JAVA_HOME"/bin to 
"$JAVA_BIN".

Example:

Edit the following block of text:
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# Set standard commands for invoking Java.

_RUNJAVA="$JAVA_HOME"/bin/java

if [ "$os400" != "true" ]; then

_RUNJDB="$JAVA_HOME"/bin/jdb

Change it to:

# Set standard commands for invoking Java.

_RUNJAVA="$JAVA_BIN"/java

if [ "$os400" != "true" ]; then

_RUNJDB="$JAVA_BIN"/jdb

If the Tomcat server is already running, it requires a re-start after the above 
configuration is done.

Configure Servlet Port
The Servlet Port specified during the Infrastructure installation process must be 
configured if your Web Application Server is Tomcat. If you are using the default port 
(8080), then you are not required to configure the same, since it is already configured.

If you are using a different port number, you must first configure the port in the 
"server.xml" in the "conf" directory of Tomcat Installation directory. The following 
steps guide you through the configuration process:

1. Navigate to $CATALINA_HOME/conf. Open server.xml and locate the tag:

"Define a non-SSL HTTP/1.1 Connector on port 8080 " 

2. Against this tag, a parameter is specified 'Connector port = "8080" '. Edit this 
value to the new port number that was used during the Infrastructure installation 
process. 

3. Save your changes in "server.xml".

Create Tomcat WAR Files
The WAR files are required to assemble servlets, .jsp files, web pages, and other static 
content into a deployable unit.

The following steps will guide you through the WAR files creation process:

1. On the machine in which Infrastructure Web components have been installed, 
navigate to the path $FIC_WEB_HOME.

2. Execute the command: 

./ant.sh

This will trigger the creation of WAR file - <contextname>.war. The 
<contextname> is the name given during installation.

3. On completion of the WAR files creation, a confirmation message will be 
displayed and you will be returned to the prompt.

4. The WAR file - <contextname>.war- is created on the machine on which 
Infrastructure Web components are installed under $FIC_WEB_HOME directory.

Note the following:

•      This process will not overwrite any existing version of WAR file that exists in the 
path. Rename/delete any existing war file.
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•      Proceed with the Tomcat WAR Files Deployment.

•      Log on to the server in which Tomcat is installed.

SSL Port Configuration
 Ensure that the following connect tag under "Define a SSL HTTP/1/1 Connector on 
port 8443" in "<Tomcat_installation_folder>/conf/server.xml" file is 
uncommented for SSL Configuration. (By default, it is commented).

<Connector port="8443" protocol="HTTP/1.1" SSLEnabled="true"

maxThreads="150" scheme="https" secure="true"

clientAuth="false" sslProtocol="TLS"

Note: The port mentioned as connector port is the Web Application 
Server port or servlet port in Infrastructure.

For more information related to SSL Configuration on Tomcat, refer to 
http://tomcat.apache.org/.

Apache Tomcat Memory Settings
To configure the Apache Tomcat Memory Settings, follow these steps:

1. Locate the file catalina.sh which resides in the folder <CATALINA_HOME>/bin

2. Edit this file for customizing the memory settings and garbage collector settings 
depending on the available hardware configuration.

3. Add the memory setting for Java Heap to -Xms512m -Xmx1024m.

4. For example:

if [ -z "$LOGGING_MANAGER" ]; then

JAVA_OPTS="$JAVA_OPTS -Xms512m -Xmx1024m

-Djava.util.logging.manager=org.apache.juli.ClassLoaderLogManager"

else

JAVA_OPTS="$JAVA_OPTS -Xms512m -Xmx1024m $LOGGING_MANAGER"

fi

Uninstalling WAR Files in Tomcat
On the machine that hosts Tomcat, perform the following steps to uninstall any 
previously deployed application:

1. Comment out Context path section from server.xml file in $CATALINA_HOME/conf 
directory to avoid conflict during undeploy and re-deploy of the WAR file.

Place comment <!-- --> in between the context path section. For example:

<!--

<Context path ="/pr2test" 
docBase="/home/perfuser/tomcat-7.0.19/webapps/pr2test" debug="0" 
reloadable="true" crossContext="true">

<Resource auth="Container"

http://tomcat.apache.org/
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name="jdbc/PR2ATM"

type="javax.sql.DataSource"

driverClassName="oracle.jdbc.driver.OracleDriver"

username="pr2atm"

password="pr2atm"

url="jdbc:oracle:thin:@10.184.74.99:1521:PERFTEST"

maxActive="100"

maxIdle="30"

maxWait="10000"/>

</Context>

-->

Restart the Tomcat service by doing the following:

•      Login to the "Unix server" through a terminal emulator.

•      Navigate to $catalina_home/bin directory.

•      Stop the tomcat services using the command ./shutdown.sh

•      Start the tomcat services using the command ./startup.sh

2. Open the URL in a browser window: http://<IP address>:<Tomcat server port>. 
(https if SSL is enabled). The Tomcat home window is displayed.

3. Click the Manager App. The Connect to window is displayed.

4. Login with the user credentials having admin rights. The Tomcat Web Application 
Manager window is displayed with the list of all applications deployed in Tomcat.
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Figure A–1 Tomcat Web Application Manager

5. Click the Undeploy link against the deployed Infrastructure application. A 
confirmation message is displayed on the application /Infrastructure being 
uninstalled.

Configuration for Axis API
This step is optional and required only if the web application server used in Apache 
Tomcat. If you use any other web application server, skip and proceed to next step.

Copy the jaxrpc.jar from the <OFSAA Installation Directory>/axis-1_
4/webapps/axis/WEB-INF/lib and place it in under <Tomcat Installation 
Directory>/lib and restart the Tomcat Server.
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BAppendix

Configuring Resource Reference in Web Application Servers
This section covers the following topics:

•      Configuring Resource Reference in WebSphere Application Server

•      Configuring Resource Reference in Weblogic Application Server

•      Configuring Resource Reference in Tomcat Application Server

Configuring Resource Reference in WebSphere Application Server
This section is applicable only when the Web Application Server type is WebSphere.

This section covers the following topics:

•      Creating JDBC Provider

•      Creating Data Source

•      J2C Authentication Details

•      JDBC Connection Pooling

Creating JDBC Provider
1. Open the WebSphere admin console in the browser window: 

http://<ipaddress>:<administrative console port>/ibm/console. (https if 
SSL is enabled). The Login window is displayed. 

2. Login with the user id that has admin rights.

3. Expand the Resources option in the LHS menu and click JDBC > JDBC Providers. 
The JDBC Providers window is displayed.
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Figure 8–12 JDBC Providers

4. Select the Scope from the drop-down list. Scope specifies the level at which the 
resource definition is visible.

5. Click New to add new JDBC Provider under the Preferences section. The Create 
new JDBC provider window is displayed.
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Figure 8–13 Create a new JDBC Provider

6. Enter the following details:

Table B–1 Fields and their description

Field Description

Database Type Oracle

Provider Type Oracle JDBC Driver

Implementation Type  Connection pool data source

Name The required display name for the resource

Description The optional description for the resource

7. Click Next. 
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Figure 8–14 Enter database class path information

8. Specify the directory location for "ojdbc<version>.jar" file. Ensure that you do not 
use the trailing slash file separators. . 

The Oracle JDBC driver can be downloaded from the following Oracle Download 
site:

•      Oracle Database 11g Release 2 (11.2.0.4) JDBC Drivers

•      Oracle Database 12c Release 1 (12.1.0.1) JDBC Drivers

Once downloaded, you need to copy the file in the required folder on the server.

Note:

Refer Appendix I for identifying the correct ojdbc<version>.jar version to be 
copied.

9. Click Next. The Summary window is displayed.

http://www.oracle.com/technetwork/apps-tech/jdbc-112010-090769.html
http://www.oracle.com/technetwork/database/features/jdbc/jdbc-drivers-12c-download-1958347.html
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Figure 8–15 Summary

10. Verify the details and click Finish to create the JDBC Provider.

11. The options to Save and Review are displayed. Click Save.

Creating Data Source
The steps given following are applicable for both config and atomic data source 
creation.

1. Open this URL in the browser window: http://<ipaddress>:<administrative 
console port>/ibm/console. (https if SSL is enabled). The Login window is 
displayed. 

2. Login with the user id that has admin rights.

3. Expand the Resources option in the LHS menu and click  JDBC > Data sources 
option. The Data sources window is displayed.
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Figure 8–16 Data Sources

4. Select the Scope from the drop down list. Scope specifies the level at which the 
resource definition is visible.

5. Click New. The Create a Data Source window is displayed.
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Figure 8–17 Create a data source

6. Specify the Data Source name and JNDI name for the new "Data Source".

The JNDI and Data Source name are case sensitive and ensure that JNDI name is 
same as the "Information Domain" name. 

7. Click Next. The Select JDBC provider window is displayed.

Figure 8–18 Select JDBC provider

8. Select the option Select an Existing JDBC Provider and select the required JDBC 
provider from the drop-down list. Click Next.
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Figure 8–19 Enter database specific properties

9. Specify the database connection URL.

For example: jdbc:oracle:thin:@<DB_SEREVER_IP>:<DB_SERVER_PORT>:<SID>

10. Select Data Store Helper Class Name from the drop-down list and ensure that the 
checkbox Use this data source in container managed persistence (CMP) is 
selected. 

Note: For RAC configuration, provide the RAC url specified during 
installation.

Example: jdbc:oracle:thin:@(DESCRIPTION=(ADDRESS_
LIST=(ADDRESS=(PROTOCOL=TCP)(HOST=10.11.12.13)(port=1521))(ADDRESS=(PRO
TOCOL=TCP)(HOST=10.11.12.14)(PORT=1521))(LOAD_
BALANCE=no)(FAILOVER=yes))(CONNECT_DATA=(SERVICE_NAME=pqadb)))

11. Click Next.
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Figure 8–20 Setup security aliases

12. Map the J2C authentication alias, if already created. If not, you can create a new 
J2C authentication alias by accessing the link given (Global J2C authentication 
alias) or you can continue with the data source creation by clicking Next and then 
Finish.

Figure 8–21 Summary
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You can also create and map J2C authentication alias after creating the data source.

13. You must create another Data source by following the aforementioned procedure 
with jdbc/FICMASTER as JNDI name pointing to the "configuration schema" of 
Infrastructure.

J2C Authentication Details
The steps given following are applicable for creating both config and atomic J2C 
Authentication.

To create J2C Authentication details:

1. Select the newly created Data Source and click JAAS - J2C authentication data 
link under Related Items. 

Figure 8–22 JAAS-J2C authentication data

2. Click New under the Preferences section.



Configuring Resource Reference in Web Application Servers

                      Appendix B-29

Figure 8–23 JAAS- J2C authentication data- New

3. Enter the Alias, User ID, Password, and Description. Ensure the following:

•      User ID is the Oracle user ID created for the respective CONFIG and 
ATOMIC Schema for the "Information Domain".

•      Specify the CONFIG database user ID and password information for the 
jdbc/FICMASTER data source, and specify the ATOMIC database user ID and 
password information for the ATOMIC schema data source that you created 
earlier.

4. Click Apply and save the details.

JDBC Connection Pooling
To define the JDBC connection pooling ensure that you have created JDBC Provider 
and Data source to access the data from the database.

1. Expand the Resources option in the LHS menu and click JDBC > Data sources 
option. The Data sources window is displayed.

2. Click the newly created Data Source $DATA_SOURCE$ and navigate to the path Data 
sources>$DATA_SOURCE$>Connection pools.



Configuring Resource Reference in Web Application Servers

B-30 Oracle Financial Services Customer Analytics Application Pack             

Figure B–1 Connection pools

3. Set the values for Connection timeout to 0 seconds, Maximum connections to 100 
connections, and Minimum connections to 10 connections as shown in the 
aforementioned figure. You can also define Reap Time, Unused Timeout, and 
Aged Timeout as required.

Configuring Resource Reference in Weblogic Application Server
This section is applicable only when the Web Application Server type is WebLogic.This 
section includes the following topics:

•      Create Data Source

•      Create GridLink Data Source

•      Configure Multi Data Sources

•      Advanced Settings for Data Source

•      JDBC Connection Pooling

•      For a Non RAC Database instance, Generic Data Source can be created. See 
Creating Data Source.

•      For a RAC Database instance, Gridlink Data Source has to be created. See 
Create GridLink Data Source.

•      When Load Balancing/Fail over is required, Multi Data Source has to be 
created. See Configure Multi Data Sources.
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Create Data Source
The steps given following are applicable for both config and atomic data source 
creation.

1. Open the following URL in the browser window: 
http://<ipaddress>:<administrative console port>/console. (https if SSL is 
enabled). The Welcome window is displayed. 

2. Login with the Administrator Username and Password. 

Figure 8–24 Welcome

3. From the LHS menu (Domain Structure), click Services > Data Sources. The 
Summary of JDBC Data Sources window is displayed.
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Figure 8–25 Summary of JDBC Data Sources

4. Click New and select Generic Data Source option. The Create a New JDBC Data 
Source window is displayed.

You can also select GridLink Data Source or Multi Data Source while creating a 
Data Source. For more information, see Creating Data Sourceor Configure Multi 
Data Sources.

Figure 8–26 Create a New JDBC Data Source
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5. Enter JDBC data source Name, JNDI Name, and select the Database Type from 
the drop-down list. Click Next.

Ensure the following:

•      The JNDI Name field should be in the format "jdbc/informationdomain"

•      Same steps needs to be followed to create a mandatory data source pointing to the 
"configuration schema" of infrastructure with jdbc/FICMASTER as JNDI name. 

•      JNDI Name is the same as mentioned in web.xml file of OFSAAI Application.

•      Required "Database Type" and "Database Driver" should be selected.

Figure 8–27 JDBC Data Source Properties

6. Select the Database Driver from the drop-down list. You need to select the 
Database Driver depending on database setup, that is, with or without RAC. Click 
Next.
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Figure 8–28 Transaction Options

7. Select the Supports Global Transactions checkbox and the One-Phase Commit 
option.

8. Click Next. The Connection Properties window is displayed.
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Figure 8–29 Connection Properties

9. Enter the required details such as the Database Name, Host Name, Port, Oracle 
User Name, and Password. 

10. Click Next. The Test Database Connection window is displayed.
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Figure 8–30 Test Database Connection

11. Verify the details and click Test Configuration and test the configuration settings.

A confirmation message is displayed stating "Connection test succeeded."

12. Click Finish. The created "Data Source" is displayed in the list of Data Sources.

Note the following:

•      "User ID" is the Oracle user ID that is created for the respective "Information 
Domain".
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•      "User ID" to be specified for data source with "FICMASTER" as "JNDI" name 
should be the Oracle user ID created for the "configuration schema".

13. Select the new Data Source and click the Targets tab. 

Figure 8–31 Select Targets

14. Select the AdminServer option and click Finish.

Create GridLink Data Source
If you have selected the option, New > GridLink Data Source while creating the "Data 
Source", you can directly specify the JDBC URL as indicated.

Figure 8–32 Create a New JDBC GridLinkData Source
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1. Enter Data Source Name, and JNDI Name.

Ensure that the "JNDI Name" field is specified in the format "jdbc/infodomname" and 
the XA Driver checkbox is not selected. Click Next.

Figure 8–33 JDBC GridLinkData Source- Connection Properties

2. Specify Complete JDBC URL, Database User Name, and Password. Click Finish. 
The created "Data Source" is displayed in the list of Data Sources.

Configure Multi Data Sources
A JDBC multi data source is an abstraction around a group of data sources that 
provides load balancing and failover between data sources. As with data sources, 
multi data sources are also bound to the JNDI tree. Applications can look up a multi 
data source on the JNDI tree and then reserve a database connection from a data 
source. The multi data source determines from which data source to provide the 
connection.

When the database used is Oracle RAC (Real Application Clusters) which allows 
Oracle Database to run across a set of clustered servers, then group of data sources can 
be created for instances running on a set of clustered servers and a JDBC multi data 
source can be created so that applications can look up a multi data source on the JNDI 
tree to reserve database connection. If a clustered server fails, Oracle continues 
running on the remaining servers.

1. Open WebLogic Admin Console  in the browser window: 
http://<ipaddress>:<administrative console port>/console. (https if SSL is 
enabled). The Login window is displayed. 

2. Login with the "User ID" that has admin rights.

3. In the LHS menu (Domain Structure), select Services > JDBC > Multi Data 
Sources. The Summary of JDBC Multi Data Sources window is displayed. 
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Figure 8–34 Summary of JDBC Multi Data Sources

4. Click New. The New JDBC Multi Data Source window is displayed.

Note: Ensure that the Data Sources which needs to be added to new 
JDBC Multi Data Source has been created.

Figure 8–35 Configure the  Multi Data Source

5.  Enter the JDBC Source Name, JNDI name, and select the Algorithm Type from 
the drop-down list. Click Next.

Note the following:
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•      The JNDI Name has to be specified in the format jdbc/infodomname. 

•      JNDI Name of the Data Sources that will be added to new JDBC Multi data 
source should be different from the JNDI name specified during Multi Data 
Source. 

•      Same steps needs to be followed to create a mandatory data source pointing 
to the "configuration schema" of infrastructure with jdbc/FICMASTER as 
JNDI name for Data Source. 

•      JNDI Name provided in multi data source should be the same name that will 
be mentioned in the web.xml file of OFSAAI Application.

•      You can select the Algorithm Type as Load-Balancing.

Figure 8–36 Select Targets

6. Select the AdminServer check box and click Next.

Figure 8–37 Select Data Source Type

7.  Select the type of data source which will be added to new JDBC Multi Data 
Source. Click Next.
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Figure 8–38 Add Data Sources

8.  Map the required Data Source from the Available Data Sources. Click Finish.

 The New JDBC Multi Data Source is created with added data sources.

Advanced Settings for Data Source
1. Click the new Data Source from the Summary of JDBC Data Sources window. The 

Settings for <Data Source Name> window is displayed.

2. Select the Connection Pooling tab given under Configuration.

3. Go to the Advanced option at the bottom of the window, and check the Test 
Connection of Reserve checkbox (Enables Weblogic Server to test a connection 
before giving it to a client).

To verify if the data source is valid, select "Data Source name". For example, 
FICMASTER.
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Figure 8–39 Settings for <Data Source Name>

4. Select the server and click Test Data Source.

A message is displayed indicating that the test was successful.

5.  Once the "Data Source" is created successfully, the following messages are 
displayed:

•      All changes have been activated. No restart is necessary.

•      Settings updated successfully. 

If not, follow the steps given aforementioned to recreate the data source. 

JDBC Connection Pooling
To define the JDBC connection pooling, ensure that you have created JDBC Provider 
and Data source to access the data from the database.

1. Click the newly created Data Source $DATA_SOURCE$ and navigate to the path 
Home >Summary of Services: JDBC >Summary of JDBC Data Sources >JDBC Data 
Source-<INFODDOM_NAME>

2. Set the values for Initial Capacity to 10, Maximum Capacity to 100, Capacity 
Increment by 1, Statement Cache Type to LRU, and Statement Cache Size to 10.

3.  Click Save.

Configuring Resource Reference in Tomcat Application Server
This section is applicable only when the Web Application Server type is Tomcat.

Copy the JDBC driver file depending on your Oracle database version. As OFSAAI is 
certified on Oracle 11gR2, copy the Oracle JDBC driver file, "ojdbc6.jar" from <Oracle 
Home>/jdbc/lib and place it in <Tomcat Home>/lib.

This section covers the following topics:

•      Create Data Source
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•      JDBC Connection Pooling

Create Data Source
To create "data source" for Infrastructure application, navigate to <Tomcat Home>/conf 
and edit the following block of text by replacing the actual values in server.xml.

<Context path ="/<context name>" docBase="<Tomcat Installation 
Directory>/webapps/<context name>" debug="0" reloadable="true" 
crossContext="true">

<Resource auth="Container" 

name="jdbc/FICMASTER"

type="javax.sql.DataSource"

driverClassName="oracle.jdbc.driver.OracleDriver"

username="<user id for the configuration schema database>" 

password="<password for the aforementioned user id>" 

url="jdbc:oracle:thin:@<DB engine IP address>:<DB Port>:<SID>"

maxActive="100" 

maxIdle="30"

maxWait="10000"/>

<Resource auth="Container"

name="jdbc/< INFORMATION DOMAIN NAME >"

type="javax.sql.DataSource"

driverClassName="oracle.jdbc.driver.OracleDriver"

username="<user id for the database>"

password="<password for the aforementioned user id>"

url="jdbc:oracle:thin:@<DB engine IP address>:<DB Port>:<SID>"

maxActive="100"

maxIdle="30"

maxWait="10000"/>

</Context>

Note the following:

Note: The <Resource> tag must be repeated for each Information 
Domain created. After the aforementioned configuration, the "WAR" 
file has to be created and deployed in Tomcat.

JDBC Connection Pooling
To define the JDBC connection pooling, do the following:

1. Copy $ORACLE_HOME/jdbc/lib/ojdbc6.jar to the path $TOMCAT_DIRECTORY/lib/.

2. Edit the server.xml present under the path $TOMCAT_DIRECTORY/conf/ with the 
following changes, which is required for connection pooling.
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<Context path="/ $CONTEXTNAME$" docBase=" $APP_DEPLOYED_PATH$ " debug="0" 
reloadable="true" crossContext="true">

<Resource auth="Container"

name="jdbc/ $INFODOM_NAME$"

type="javax.sql.DataSource"

driverClassName="oracle.jdbc.driver.OracleDriver"

username=" $ATOMICSCHEMA_USERNAME$"

password="$ATOMICSCHEMA_PASSWORD$"

url="$JDBC_CONNECTION_URL"

maxActive="100"

maxIdle="30"

maxWait="10000"

removeAbandoned="true" removeAbandonedTimeout="60"

logAbandoned="true"/>

</Context>

Note the following:

•      $TOMCAT_DIRECTORY$ should be replaced by Tomcat application installed 
path.

•      $CONTEXTNAME$ should be replaced by OFSAAI context name.

•      $APP_DEPLOYED_PATH$ should be replaced by OFSAAI application deployed 
path.

•      $INFODOM_NAME$ should be replaced by Infodom Name.

•      $ATOMICSCHEMA_USERNAME$ should be replaced by Atomic schema database 
user name.

•      $ATOMICSCHEMA_PASSWORD$ should be replaced by Atomic schema database 
password.

•      $JDBC_CONNECTION_URL should be replaced by JDBC connection string 
jdbc:Oracle:thin:<IP>:<PORT>:<SID>. For example, jdbc:oracle:thin 
10.80.50.53:1521:soluint
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Configuring OFS_CA_PACK.xml file
The customeranalytics.xml file holds details on the various OFSAA products that are 
packaged in a particular Application Pack. 

The following table gives details about the various tags/parameters available in the 
file and the values that need to be updated. Prior to installing the OFSAA Application. 
Pack in SILENT mode, it is mandatory to update this file. 

Note: If you are installing in the GUI mode, then this file need not be 
updated.

Table C–1 OFS_CA_PACK.XML Parameters

Tag 
Name/Attribute 
Name

Description Mandatory  
(Y/ N)

Default Value/ 
Permissible Value

Comments

APP_PACK_ID Unique 
Application 
Pack Identifier

Y Unique Seeded Value DO NOT 
modify this 
value.

APP_PACK_
NAME

Unique 
Application 
Pack Name

Y Unique Seeded Value DO NOT 
modify this 
value.

APP_PACK_
DESCRIPTION

Unique 
Application 
Pack 
Description

Y Unique Seeded Value DO NOT 
modify this 
value.

VERSION Unique release 
version

Y Unique Seeded Value DO NOT 
modify this 
value.

APP Unique 
Application 
Entries

Y Unique Seeded Value DO NOT 
remove these 
tags.

APP_ID Unique 
Application 
Identifier

Y Unique Seeded Value DO NOT 
modify this 
value.
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APP_ID/ 
PREREQ

Prerequisite 
Application/ 
Product

Y Unique Seeded Value For most 
applications 
Infrastructure 
would be the 
prerequisite set. 
For certain other 
applications, an 
appropriate 
Application ID 
would be set. 
DO NOT 
modify this 
value.

APP_ID/ DEF_
SEL_FLAG

Default 
Selected Flag

Y Default - YES In all 
Application 
Packs, 
Infrastructure 
would have this 
value set to 
“YES”. DO NOT 
modify this 
value.

APP_ID/ 
ENABLE

Enable 
Application/ 
Product

YES if 
installing in 
SILENT mode.

Default –  
YES for Infrastructure 
NO for Others

Permissible -  YES or 
NO

Set this 
attribute-value 
to YES against 
every APP_ID 
which is 
licensed and 
should be 
enabled for use. 
 
Note: 
Application/ 
Product once 
enabled cannot 
be disabled. 
However, 
Application/ 
Product not 
enabled during 
installation can 
be enabled later 
through the 
Administration 
UI.

APP_NAME Unique 
Application/ 
Product Name

Y Unique Seeded Value DO NOT 
modify this 
value.

APP_
DESCRIPTION

Unique 
Application/ 
Product Name

Y Unique Seeded Value DO NOT 
modify this 
value.

VERSION Unique release 
version

Y Unique Seeded Value DO NOT 
modify this 
value.

Table C–1 OFS_CA_PACK.XML Parameters
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OFS_CA_SCHEMA_IN.xml file
Creating database schemas, object with schemas and assigning appropriate grants are 
the primary steps in the installation process of OFSAA Applications.  The OFS_CA_
SCHEMA_IN.xml file contains details on the various application schemas that should be 
created prior to the Application Pack installation. 

The following table gives details about the various tags/parameters available in the file and the values 
that need to be updated. Prior to executing the schema creator utility, it is mandatory to update this file.

Table D–1 OFS_CA_SCHEMA_IN.xml parameters

Tag Name/  
Attribute 
Name

Description Mandatory/ 
Optional

Default Value/  
Permissible Value

Comments

<APP_PACK_
ID>

Unique 
Application 
Pack Identifier

Mandatory Unique Seeded Value DO NOT 
modify this 
value.
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<JDBC_URL> Enter the JDBC 
URL.

Note: You can 
enter RAC and 
NON-RAC 
enabled 
database 
connectivity 
URL.

Mandatory Example, 

jdbc:oracle:thin:@<HOS
T/IP>:<PORT>:<SID>

or

jdbc:oracle:thin:@//[H
OST][:PORT]/SERVICE

or

jdbc:oracle:thin:@(DESC
RIPTION=(ADDRESS_
LIST=(ADDRESS=(PRO
TOCOL=TCP)(HOST=[
HOST])(port=[PORT]))(
ADDRESS=(PROTOCO
L=TCP)(HOST=[HOST]
)(PORT=[PORT]))(LOA
D_
BALANCE=yes)(FAILO
VER=yes))(CONNECT_
DATA=(SERVICE_
NAME=[SERVICE]))) 

For example, 
jdbc:oracle:thin:@//dbh
ost.server.com:1521/ser
vice1 

or

jdbc:oracle:thin:@//dbs
host.server.com:1521/sc
an-1

or

jdbc:oracle:thin:@(DESC
RIPTION=(ADDRESS_
LIST=(ADDRESS=(PRO
TOCOL=TCP)(HOST=d
bhost1.server.com)(port
=1521))(ADDRESS=(PR
OTOCOL=TCP)(HOST
=dbhost2.server.com)(P
ORT=1521))(LOAD_
BALANCE=yes)(FAILO
VER=yes))(CONNECT_
DATA=(SERVICE_
NAME=service1)))

Ensure to add 
an entry (with 
SID/ SERVICE 
NAME) in the 
tnsnames.ora 
file on the 
OFSAA server. 
The entry 
should match 
with the SID/ 
SERVICE 
NAME used in 
the JDBC URL.

<JDBC_
DRIVER>

By default this 
driver name is 
seeded. 

Note: Do not 
edit this 
attribute value.

Mandatory Example, 

oracle.jdbc.driver.Oracl
eDriver

Only JDBC Thin 
Driver is 
supported. 
DO NOT 
modify this 
value.

<HOST> Enter the 
Hostname/ IP 
Address of the 
system on 
which you are 
installing the 
OFSAA 
components.

Mandatory

Host Name/ IP 
Address

Table D–1 OFS_CA_SCHEMA_IN.xml parameters
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<SETUPINFO
>/ NAME

Enter the 
acronym for 
the type of 
implementatio
n. This 
information 
will be 
displayed in 
the OFSAA 
Home Page.

Note: On 
executing the 
schema creator 
utility, this 
value will be 
prefixed with 
each schema 
name. For 
example: dev_
ofsaaconf, uat_
ofsaaatm.

Mandatory Accepts strings with a 
minimum length of two 
and maximum of four.

Example, 

DEV, SIT, PROD

This name 
would appear 
in the OFSAA 
Landing Page 
as “Connected 
To: xxxx”

The schemas 
being created 
would get this 
prefix. For E.g. 
dev_ofsaaconf, 
uat_ofsaaconf 
etc.

<PASSWORD
>/ DEFAULT*

Enter the 
password if 
you want to set 
a default 
password for 
all schemas.

Note: You also 
need to set 
APPLYSAMEF
ORALL 
attribute as Y 
to apply the 
default 
password for 
all the 
schemas.

Optional The maximum length 
allowed is 30 characters. 
Special characters are 
not allowed.

Table D–1 OFS_CA_SCHEMA_IN.xml parameters



OFS_CA_SCHEMA_IN.xml file

D-50 Oracle Financial Services Customer Analytics Application Pack                  

<PASSWORD
>/ 
APPLYSAMEF
ORALL

Enter as Y if 
you want to 
apply the 
password 
specified in 
DEFAULT 
attribute for all 
the schemas. 

If you enter as 
N, you need to 
provide 
individual 
passwords for 
all schemas.

Note: In case 
you have 
entered Y in 
APPLYSAMEF
ORALL 
attribute and 
also have 
specified 
individual 
passwords for 
all the 
schemas, then 
the specified 
individual 
passwords will 
take 
precedence.

Mandatory Default – N 
Permissible – Y or N

Note: Setting 
this attribute 
value is 
mandatory, If 
DEFAULT 
attribute is set.

Table D–1 OFS_CA_SCHEMA_IN.xml parameters
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<SCHEMA>/ 
TYPE

The different 
types of 
schemas that 
are supported 
in this release 
are  ATOMIC, 
CONFIG, 
SANDBOX, 
and ADDON.

By default, the 
schemas types 
are seeded 
based on the 
Application 
Pack. 

Note: Do not 
edit this 
attribute value.

Mandatory ATOMIC/CONFIG/SA
NDBOX/ADDON

Note: 

SANDBOX AND 
ADDON schemas are 
not applicable for OFS 
AAAI Application Pack.

Only One 
CONFIG 
schema can 
exist in the file. 
This schema 
identifies as the 
CONFIGURATI
ON schema that 
holds the 
OFSAA setup 
details and 
other metadata 
information.

Multiple 
ATOMIC/ 
SANDBOX/ 
ADDON 
schemas can 
exist in the file.

ATOMIC 
schema refers to 
the Information 
Domain 
schema. 
SANDBOX 
schema refers to 
the SANDBOX 
schema. 
ADDON 
schema refers to 
other 
miscellaneous 
schema (not 
applicable for 
this Application 
Pack). 

Table D–1 OFS_CA_SCHEMA_IN.xml parameters
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<SCHEMA.>/ 
NAME

By default, the 
schemas names 
are seeded 
based on the 
Application 
Pack.

You can edit 
the schema 
names if 
required. 

Note:

The Schema 
Name will 
have a prefix of 
the 
SETUPINFO/ 
NAME 
attribute.

SCHEMA 
NAME must 
be same for all 
the ATOMIC 
Schemas of 
applications 
within an 
Application 
Pack.

Mandatory The permissible length 
is 15 characters and 
only alphanumeric 
characters allowed. No 
special characters 
allowed except 
underscore ‘_’.

SETUPINFO/ 
NAME attribute 
value would be 
prefixed to the 
schema name 
being created. 
For E.g. if name 
is set as 
‘ofsaaatm’ and 
setupinfo as 
‘uat’ then 
schema being 
created would 
be ‘uat_
ofsaaatm’. 

NAME should 
be same where 
APP_GRP=1 for 
all SCHEMA 
tags (Not 
applicable for 
this Application 
Pack).

<SCHEMA>/ 
PASSWORD*

Enter the 
password of 
the schema to 
be created. 

Note: 

If this attribute 
is left blank, 
then the 
password 
specified in the 
<PASSWORD>
/DEFAULT 
attribute is 
applied as the 
Schema 
Password.

Optional The maximum length 
allowed is 30 characters. 
Special characters are 
not allowed.

Note: You need 
to mandatorily 
enter the 
password if you 
have set the 
<PASSWORD>
/ 
APPLYSAMEF
ORALL 
attribute as N.

<SCHEMA>/ 
APP_ID

By default, the 
Application ID 
is seeded based 
on the 
Application 
Pack. 

Note: Do not 
edit this 
attribute value.

Mandatory Unique Seeded Value Identifies the 
Application/ 
Product for 
which the 
schema is being 
created.

DO NOT 
modify this 
value.

Table D–1 OFS_CA_SCHEMA_IN.xml parameters
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<SCHEMA>/ 
DEFAULTTAB
LESPACE

Enter the 
available 
default 
tablespace for 
DB User.

Note: 

If this attribute 
is left blank, 
then USERS is 
set as the 
default 
tablespace.

Optional Default – USERS 
Permissible – Any 
existing valid 
tablespace name. 

Modify this 
value to 
associate any 
valid tablespace 
with the 
schema.

<SCHEMA>/ 
TEMPTABLES
PACE

Enter the 
available 
temporary 
tablespace for 
the DB User. 

Note: 

If this attribute 
is left blank, 
then TEMP is 
set as the 
default 
tablespace.

Optional Default – TEMP 
Permissible – Any 
existing valid 
temporary tablespace 
name.

Modify this 
value to 
associate any 
valid tablespace 
with the 
schema.

<SCHEMA>/ 
QUOTA

Enter the quota 
to be set on 
DEFAULTTAB
LESPACE 
attribute for 
the schema/ 
user. By 
default, the 
quota size is 
set to 500M.
Minimum: 
500M or 
Unlimited on 
default 
Tablespace

Optional Example, 

600M/m

20G/g

UNLIMITED/unlimite
d

Modify this 
value to grant 
the specified 
quota on the 
mentioned 
tablespace to 
the user. 

<SCHEMA>/ 
INFODOM

Enter the name 
of the 
Information 
Domain to 
associate this 
schema. 
The schema 
creator utility 
automatically 
derives an 
Information 
Domain Name 
based on the 
Application 
Pack if no 
value is 
specified for 
this attribute.

Optional Permissible length is 16 
characters and only 
alphanumeric 
characters allowed. No 
special characters 
allowed.

Table D–1 OFS_CA_SCHEMA_IN.xml parameters
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EAppendix

This appendix covers the following topics:

•      Creating EAR/WAR File

•      Deploying EAR/WAR File

•      Additional Configurations

•      Installation Checklist

•      OFSAA Landing Page

Creating EAR/WAR File
This section includes the following topics:

•      Creating WebSphere EAR/WAR File

•      Creating WebLogic EAR/WAR File

•      Creating Tomcat EAR/WAR File

Creating WebSphere EAR/WAR File
The EAR files are required to assemble servlets, .jsp files, web pages, and other static 
content into a deployable unit. The EAR file is created to reflect the changes made to 
the web.xml file.

To create WebSphere EAR/WAR File, follow these steps:

1. Navigate to the "$FIC_WEB_HOME" directory on the machine in which Infrastructure 
Web components have been installed and execute the command:

./ant.sh

2. This triggers the creation of EAR file -<contextname>.ear. The <contextname> is 
the name given during installation.

3. On completion of the EAR files creation, the "BUILD SUCCESSFUL" and "Time 
taken" message is displayed and you will be returned to the prompt.

4. The EAR file - <contextname>.ear - is created on the machine on which 
Infrastructure Web components are installed under $FIC_WEB_HOME directory.

Note: This process overwrites any existing version of EAR file that 
exists in the path.
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Creating WebLogic EAR/WAR File 
The EAR files are required to assemble servlets, .jsp files, web pages and other static 
content into a deployable unit. This EAR file creation is required to reflect the changes 
made to the web.xml file.

To create WebLogic EAR/WAR File, follow these steps:

1. Navigate to the path "<WEBLOGIC_INSTALL_DIR>/Bea/user_
projects/domains/<DOMAIN_NAME>/bin/".

2. Start WebLogic Domain by executing the command:

./startWeblogic.sh -d64

3. Navigate to the "$FIC_WEB_HOME" directory in the machine in which Infrastructure 
Web components have been installed.

4. Execute the command:

./ant.sh 

This will trigger the creation of EAR file - <contextname>.ear. Here 
<contextname> is the context name given during installation.

5. On completion of the EAR files creation, the "BUILD SUCCESSFUL" and "Time 
Taken" message is displayed and you will be returned to the prompt.

6. The EAR file - <contextname>.ear - is created on the machine on which 
Infrastructure Web components are installed under "$FIC_WEB_HOME" directory.

Note: This process overwrites any existing version of EAR file in the 
path.

Creating Tomcat EAR/WAR File
The WAR files are required to assemble servlets, .jsp files, web pages, and other static 
content into a deployable unit.

To create Tomcat EAR/WAR File, follow these steps:

1. On the machine in which Infrastructure Web components have been installed, 
navigate to the path $FIC_WEB_HOME.

2. Execute the command: 

./ant.sh

This will trigger the creation of WAR file - <contextname>.war. The 
<contextname> is the name given during installation.

3. On completion of the WAR files creation, a confirmation message will be 
displayed and you will be returned to the prompt.

4. The WAR file - <contextname>.war- is created on the machine on which 
Infrastructure Web components are installed under $FIC_WEB_HOME directory.

Note the following:

•      This process will not overwrite any existing version of WAR file that exists in the 
path. Rename/delete any existing war file.

•      Proceed with the Tomcat WAR Files Deployment.
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•      Log on to the server in which Tomcat is installed.

Deploying EAR/WAR File
This section covers the following topics:

•      Deploying WebSphere EAR Files

•      Deploying EAR/WAR file for WebLogic

•      Deploying Tomcat WAR Files

Deploying  WebSphere EAR Files
To deploy Infrastructure application in WebSphere:

1. Start WebSphere Profile by navigating to the path "/<Websphere_Installation_
Directory>/IBM/WebSphere/AppServer/profiles/<Profile_Name>/bin/" and 
execute the command:

 ./startServer.sh server1

2. Open the following URL in the browser: http://<ipaddress>:<Administrative 
Console Port>/ibm/console. (https if SSL is enabled). The login screen is 
displayed. 

Figure 8–39 Login Window
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3. Enter the user credentials which has administrator rights and click Log In.

4. From the LHS menu, select Applications and click New Application. The New 
Application window is displayed.

Figure 8–40 New Application

5. Click New Enterprise Application. The Preparing for the application installation 
window is displayed. 

Figure 8–41 Preparing for the application installation

6. Select Remote File System and click Browse. Select the EAR file generated for 
OFSAAI to upload and install. Click Next. 
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Figure 8–42 Installation Options

7. Select the Fast Path option and click Next. The Install New Application window is 
displayed.
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Figure 8–43 Install New Application

8. Enter the required information and click Next. The Map Modules to Servers 
window is displayed.
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Figure 8–44 Map Modules to Servers

9.  Select the Web Application and click Next. The Map Resource References to 
Resources window is displayed.
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Figure 8–45 Map Resource References to Resources

10. Map each resource defined in the application to a resource JNDI name defined 
earlier.

11. Click Modify Resource Authentication Method and specify the authentication 
method created earlier.

You can specify "config" for FICMASTER resource or "atomic" for atomic resource 
as the authentication method.

12. Select the OFSAAI Web Application check box and click Next. The Map Virtual 
hosts for Web Modules window is displayed.
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Figure 8–46 Map Virtual host for Web Modules

13. Select the Web Application check box and click Next. The Summary page is 
displayed.



Deploying EAR/WAR File

E-64 Oracle Financial Services Customer Analytics Application Pack                  

Figure 8–47 Summary

14. Click Finish and deploy the Infrastructure Application on WebSphere.

15. On successful installation, a message is displayed. Click Save and save the master 
file configuration. The details are displayed in the Master File Configuration 
window.

To start the application:

1. Expand Applications > Application Type > WebSphere enterprise applications. 
The Enterprise Applications window is displayed.
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Figure 8–48 Enterprise Applications

2. Select the installed application and click Start.

Note: 

■ <profile name> is the profile name given while creating the 
WebSphere profile.

■ <cell name > is the cell name given during profile creation 

■ <contextname> is the context name given during installation.

Deploying EAR/WAR file for WebLogic
Following are the steps for deploying Infrastructure application that would be created 
during installation:

1. Navigate to the path "<WebLogic Installation directory>/user_
projects/domains/<domain name>/bin" in the machine in which WebLogic is 
installed.

2. Start WebLogic by executing the command:

./startWebLogic.sh -d64 file

3. Open the URL in the browser window: http://<ipaddress>:<admin server 
port>/console. (https if SSL is enabled). The Sign in window of the WebLogic 
Server Administration Console is displayed.

Note: Ensure that you have started Infrastructure Server by executing 
"./startofsaai.sh" as mentioned in Starting Infrastructure Services 
section.

4. Log on to the WebLogic Server by entering the user credentials having privileges 
to deploy the EAR file.
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5. From the Domain Structure LHS menu, click Deployments. The Summary of 
Deployments window is displayed.

Figure 8–49 Summary of Deployments

6. Click Install. The Install Application Assistant window is displayed.

7. Select the Exploded EAR directory after browsing to the directory where it is 
saved and click Next.

Explode EAR

To explode EAR, follow the below steps:

1. Create the "applications" folder under domain name. For example, "/Bea/user_
projects/domains/ <Domain _name>/applications".

2. Create <context_name>.ear folder under "applications" folder. 

3. Copy the <$FIC_WEB_HOME/<context_name>.ear file to <WEBLOGIC_INSTALL_
DIR>/Bea/user_projects/domains/<DOMAIN_NAME>/applications/.

4. Explode the <context_name>.ear file by executing the command:

jar -xvf <context_name>.ear

5. Delete the <context>.ear and < context >.war file (recently created).

6. Create a directory <context_name>.war under <WEBLOGIC_INSTALL_
DIR>/Bea/user_projects/domains/<DOMAIN_NAME>/applications.
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7. Copy <$FIC_WEB_HOME/<context_name>.war file to <WEBLOGIC_INSTALL_
DIR>/Bea/user_projects/domains/<DOMAIN_NAME>/applications/<context_
name>.ear/.

8. Explode the <context_name>.war file by executing the following command to get 
the directory structure:

jar -xvf <context_name>.war
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Install Application

To install Application: 

1. Open the Install Application Assistant. 

Figure 8–50 Install Application Assistant

2. Click Next. 

Figure 8–51 Install Application Assistant 

3. From the Choose targeting style section, select the Install this deployment as an 
application option and click Next. The Optional Settings window is displayed.
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Figure 8–52 Optional Settings

4. Enter a Name for the deployment if required.

5. Under the Security section, select the DD only option to specify that only roles 
and policies that are defined in the deployment descriptors should be used.

6. Select the I will make the deployment available from the following location 
option under the Source accessibility section. 

7. Click Next to continue. The Deployment Summary window is displayed.
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Figure 8–53 Deployment Summary

8. Select the Yes, take me to the deployment's configuration screen option and click 
Finish. The Settings for <Deployment Name> window is displayed.
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Figure 8–54 Settings for <Deployment Name>

9. Review the general configuration details of the deployment. You can also update 
the configuration of the deployment in this window. In the Overview tab, you can 
view the complete deployment configuration.

10. Click Save to update the changes, if any.



Deploying EAR/WAR File

E-72 Oracle Financial Services Customer Analytics Application Pack                  

11. From the LHS menu, click Deployments. The Summary of Deployments window 
is displayed.

Figure 8–55 Summary of Deployments

12. Select the newly deployed Infrastructure application and click Start > Servicing 
all requests. Ensure that the Infrastructure server is up and running.
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Figure 8–56 Summary of Deployments

The State of the deployed application will be displayed as Active if started 
successfully.

Deploying Tomcat WAR Files
Before deploying the WAR files, ensure that the previously deployed applications of 
Infrastructure are uninstalled. See Uninstalling Previously Deployed WAR Files in Tomcat 
for the procedure to uninstall the previously deployed Infrastructure war files.

On the machine that hosts Tomcat, follow the steps outlined to deploy Infrastructure 
application:

1. Open the URL in Browser window: http://<IP address>:<Tomcat server 
port>. (https if SSL is enabled). The Tomcat home window is displayed.
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Figure 8–57 Tomcat home 

2. Click Manager App. The Connect to dialog box is displayed.

3. Enter the User Id and Password that has admin rights and click OK. (For user 
creation in tomcat, see "Tomcat User Administration". The Tomcat Web 
Application Manager window is displayed with the list of all the applications 
deployed.
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Figure 8–58 Tomcat Web Application Manager

4. In the Deploy section, enter the Context Path provided during the installation as 
"/<context-name>".

5. Enter the path where the <context-name>.war file resides (by default "$FIC_WEB_
HOME/<context-name.war>") in the WAR or Directory URL field and click Deploy.

On successful application deployment, a confirmation message is displayed.

■ For information on starting the Tomcat server, see Starting Infrastructure 
Services.

Additional Configurations
Refer to the following sections for detailed module specific post installation 
configurations.

This section covers the following topics:

•      FTP/SFTP Configuration for Excel/Document Upload

•      Configuration for Dimension and Hierarchy Management

•      Configure Infrastructure Server Memory

•      Internet Explorer Settings

•      Retrieve Patch Information

•      OLAP Data Server Configuration

•      Changing IP/ Hostname, Ports, Deployed Paths of the OFSAA Instance

•      Configure OFSAAI Web Services

•      Configure OFSAAI Web Services
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•      Deploy OFSAAI Web Services

•      Configuration to Enable Parallel Execution of DML statements

•      Configure Message Details in Forms Designer

•      Clearing Application Cache

•      Configuring Password Changes

•      Configure Java Virtual Machine

•      Configure Internal Service (Document Upload/Download)

FTP/SFTP Configuration for Excel/Document Upload
In OFSAA, certain modules require transfer of files from the web application server to 
the OFSAA server over SSH.   Follow these steps to ensure the OFSAA server 
recognizes the web application server during file transfers.

1.   Login to the web application server.

Example: <App Layer path>scp nohup.out <user>@<Web Server 
path>:/export/home/<user>

2. Type sftp <user>@<OFSAA Server>

3. Specify Yes when prompted for permission. Are you sure you want to continue 
connecting (Yes/No)? 

4.  This will add an entry into the "known_hosts" file.

5. A confirmation message is displayed: Permanently added <OFSAA Server> RSA) 
to the list of known hosts..

Configuration for Dimension and Hierarchy Management
These configuration changes are applicable when Dimension Management features 
provided in OFSAAI are used. You can open AMHMConfig.properties file present in 
the $FIC_WEB_HOME/webroot/conf directory to set the properties for the following:

•      Configure Member Deletion

•      Configure Attribute Default Date Format

•      Configure Members Reverse Population

•      Configure Members Reverse Population

•      Configure Maximum Levels allowed in Hierarchies

•      Configure Node Limit for a Hierarchy Tree

Configuration for Dimension and Hierarchy Management has to be done only after the 
application/solution installation is done. The properties specific to Information 
Domain are:

•      $INFODOM$=<Name of the Information Domain>

•      $DIMENSION_ID$=<Dimension ID for which the property to be set>

Configure Member Deletion
This property should be set to allow the user to delete the Members for the Dimension.



Table E–1  Member Deletion Configuration

Value Code Example

# Member Deletion 
Configuration - VALUE- 
Y/N

MEMBER_
DEL-$INFODOM$-$DIME
NSION_ID$=$VALUE$

MEMBER_
DEL-ORAFUSION-1=Y
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Configure Attribute Default Date Format
This property should be set to display the Default Date Format for Date type Attribute 
in Attributes window.

Table E–2  Attribute Default Date Format

Value Code Example

# Attribute Default Date 
Format - DB_DATE_
FORMAT:DD-MON-YYYY

ATTR_DEF_DATE_
FORMAT-$INFODOM$=$
DB_DATE_FORMAT$

ATTR_DEF_DATE_
FORMAT-ORAFUSION=D
D/MON/YYYY

Configure Members Reverse Population
This property should be set for reverse population of Members for the Dimensions in 
required Information Domains.

Table E–3  Members Reverse population

Value Code Example

# Members Reverse 
population - VALUE- Y/N

MEMBER_REVERSE_
POP-$INFODOM$-$DIME
NSION_ID$=$VALUE$

MEMBER_REVERSE_
POP-ORAFUSION-1=Y

Configure Hierarchy Reverse Population
This property should be set for reverse population of Hierarchies for the Dimensions 
in required Information Domains.

Table E–4  Hierarchy Reverse population

Value Code Example

#Hierarchy Reverse 
population - VALUE- Y/N

HIERARCHY_REVERSE_
POP-$INFODOM$-$DIME
NSION_ID$=$VALUE$

HIERARCHY_REVERSE_
POP-ORAFUSION-1=Y

Configure Maximum Levels allowed in Hierarchies
This property is required to set the maximum levels allowed to build the Hierarchies 
tree structure.

Table E–5  Hierarchy Maximum level allowed

Value Code Example

#Hierarchy Maximum level 
allowed for the hierarchy in 
particular Information 
Domain - VALUE - Integer 
number

MAX_
DEPTH-$INFODOM$=$VA
LUE$

MAX_DEPTH-FUSION=15
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The Maximum Levels allowed in the hierarchies is less than or equal to 15. If the 
Hierarchy Reverse population is set as "Y" and more than 15 levels are created. Then 
an alert is displayed as "The number of levels exceeding the limit".

If the maximum level allowed is set as more than 15 and hierarchy reverse population 
is set as "Y" then an error is displayed as "Error occurred in Reverse populating the 
hierarchy".

Configure Node Limit for a Hierarchy Tree
This property is required to display the Hierarchy as a small or a large hierarchy. If the 
tree node limit exceeds the set limit, the Hierarchies are treated as large Hierarchy.

Table E–6  Hierarchy Tree node limit

Value Code Example

#Tree node limit for the 
hierarchy - Values is Integer 
number

TREE_NODE_
LIMIT=$VALUE$

TREE_NODE_LIMIT=30

Configure Infrastructure Server Memory
The memory settings for Infrastructure Application Server, Tomcat, WebSphere, and 
WebLogic can be edited for customizing memory settings and garbage collector 
settings depending on the available hardware configuration as explained below. These 
settings are base minimum and has to be incremented considering the deployment 
metrics into account. The increments are usually handled in multiples of 128mb for 
heap and 64mb for stack.

Infrastructure Application Server Memory Settings
You can configure the Infrastructure Application Memory settings as follows:

1. Locate .profile file.

2. Edit X_ARGS field in this file for customizing memory settings and garbage 
collector settings depends on the hardware configuration.

This has a default value X_ARGS="-Xms200m"

X_ARGS=" "$X_ARGS" $DELIM -Xmx2048m"

Note: This parameter is modified in 7.3.2 IR and you need to modify 
X_ARGS_APP variable in the .profile file to customize Java Memory 
Settings for Model Upload based on the Data Model size.

Internet Explorer Settings

Note: OFSAAI supports only default zoom setting in Internet 
Explorer, that is, 100%. 
Cookies should be enabled.

The following browser settings have to be specified at every client machine prior to 
accessing the Infrastructure application.
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1. Open Internet Explorer. Select Tools > Internet Options. The Internet Options 
window is displayed.

2. Click the Settings button. The Settings window is displayed.

3. Select the option Everytime I Visit the webpage and click OK.

Figure E–1 Internet Options

4. In the Internet Options window, select the Security tab and select the Internet 
option under Select a zone to view or change the security settings.

5. Click Default Level under Security level for this zone.
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Figure E–2 Internet Options

6. Click OK to save.

7. Click Internet Explorer >> Tools >> Compatibility View Settings.

8. Enter the OFSAA setup URL in the Add this website field.

9. Click Add.

10. Ensure the URL is listed under Websites you've added to Compatibility View.

11. In the Internet Options window, select the Privacy tab and select the Turn on 
Pop-up Blocker option under Pop-up Blocker settings.



Additional Configurations

                       Appendix E-81

Figure E–3 Internet Options- Popup Blocker Settings

12. Click Settings. The Pop-up Blocker Settings window is displayed.

13. Enter the URL of the OFSAA Application in the Address of Website to Allow 
field.

14. Click Add. The OFSAA URL is displayed in the Allowed Sites section.

15. Click Close.

16. Click OK in the Internet Options window.

Retrieve Patch Information
To identify the list of patches installed on your OFSAA setup, follow these steps:

1. Login to the OFSAA application as a user with Object AdminAdvanced Role.

2. Navigate to Object Administration tab.

3. Click System Utilities.

4. Click Patch Information.

5. The page displays the list of patches installed on the OFSAA setup across 
Applications/Platform.
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OLAP Data Server Configuration
This section is applicable if you are using the OLAP feature of OFSAAI.

The following parameters must be set to ensure that the system limitations are not 
exceeded at any stage. The values for these OS parameters should be specified based 
on the expected load at each implementation site.

Example:

Process Memory Limit

Max Thread Stack Size

Max Number of Threads per Process

•      Sort Buffer settings: This must be set at the Essbase application level appropriate 
to the anticipated load.

•      Shutdown and Restart: During shutdown of OFSAAI Server that has an instance 
of Data Services that is communicating with an OLAP Data Server, it is imperative 
to ensure that the cleanup of the old instance is completed on the OLAP Data 
Server before restarting the OFSAAI Server. Pause for a period of time based on 
the load the system was subjected to, before restarting the Data Services 
subsystem.

Changing IP/ Hostname, Ports, Deployed Paths of the OFSAA Instance
For information on this section, refer OFS Analytical Applications Infrastructure 
Administration User Guide in OTN.

OFSAAI Setup Information Fetching Tool
Executing the SetupInfo.jar file available in the FIC_HOME path will help you retrieve 
the related information about the OFSAAI Set up such as Operating System Name and 
version, Database Type and Version, OFSAAI architecture, Log file locations and so on.

To execute "SetupInfo.jar" in console:

1. Navigate to the path $FIC_HOME.

2. Enter the command:

java -jar SetupInfo.jar

After execution, the output file location is displayed in the console.

Encryption Changer
This utility helps you to regenerate the new AESCryptKey.ext file and encrypt all the 
encrypted values of the OFSAAI setup according to the new key.

To execute EncryptC.jar in console:

1. Navigate to the path $FIC_HOME.

2. Enter the command:

java -jar EncryptC.jar

A confirmation message is displayed after execution.

Once executed, you need to create and deploy the EAR / WAR file depending on the 
configured Web Application Server. For more information, see , "Configuring Web 
Application Servers".

http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
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Infrastructure LDAP Configuration
For information on LDAP configuration, see OFSAAI Administration Guide.

Configure OFSAAI Web Services
Web Services in OFSAAI is meant for exposing a web service to "asynchronously" or 
"synchronously" execute requested tasks offered by OFSAAI. The configuration steps 
given below are to be done only if you are using the Web Services feature of OFSAAI.

Configure DynamicWSConfig.xml File
For each third party web service that needs to be accessed using the OFSAAI Web 
services framework and the operations to be invoked, corresponding entries are to be 
made in the DynamicWSConfig.xml template file.

The variable <WebServer> denotes any one of the application server, i.e. WebSphere, 
WebLogic, or Tomcat.

The DynamicWSConfig.xml file will be available in the <OFSAAI Installation 
Directory>/EXEWebService/ <WebServer>/ROOT/conf directory. This file can be 
placed in any directory that is accessible by the application and this location must be 
specified in the web.xml file, as WSCONFIGFILE parameter.

The DynamicWSConfig.xml template file will be in <WebServer Deployment Path>/ 
EXEWebService.ear/EXEWebService.war/conf directory

This template is given below:

<XML>

<WEBSERVICES>

<WEBSERVICE CODE="$CODE"

ENDPOINT="$ENDPOINT" TARGETNAMESPACE="$TARGETNAMESPACE"

XMLNS_XSD="$XMLNS_XSD" ENCODINGSTYLE="$ENCODINGSTYLE"

SERVICENAME="$SERVICENAME" PORTTYPENAME="$PORTTYPENAME"

SESSION_MAINTAIN_PROPERTY="$SESSION_MAINTAIN_PROPERTY"

USERNAME="$USERNAME"

PASSWORD="$PASSWORD" STYLE="$WEBSERVICESTYLE"

STUBIMPLEMENTATION="$STUBIMPLEMENTATION">

<OPERATION CODE="$CODE"

NAME="$NAME"

SOAPACTION="$SOAPACTION"

STYLE="$STYLE"

PACKAGENAME="$PACKAGENAME">

<INPUT ORDER="$ORDER"

PARAMNAME="$PARAMNAME"

ARGTYPE="$ARGTYPE"

CLASSNAME="$CLASSNAME"/>

<OUTPUT PARAMNAME="$PARAMNAME"

http://docs.oracle.com/cd/E60058_01/books/8.0.0.0.0/OFSAAI_Administration_Guide_8.0.pdf
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RETURNTYPE="$RETURNTYPE"

CLASSNAME="$CLASSNAME"/>

</OPERATION>

</WEBSERVICE>

</WEBSERVICES>

</XML>

The DynamicWSConfig.xml has the placeholders as tabulated below. These have to be 
updated depending on the web service chosen and the mode of accessing it. For each 
Web service to be accessed, the entire webservice tag in the DynamicWSConfig.xml file 
must be repeated. The placeholders tabulated below should be set in accordance to the 
parameters published in the third party wsdl files (webservices) to be accessed. The 
stub class specified must implement the "com.iflex.Oracle 
Reveleus.execution.webservice.EXEWebIF" interface.

Attributes for WEBSERVICE tag

Table E–7  WEBSERVICE tag

Placeholder Description

$CODE Unique number within the xml file and cannot be 999 or 0.

$ENDPOINT soap: address location in the wsdl: service name tag of 
the wsdl file.

$TARGETNAMESPACE The attribute value for the targetNamespace of the wsdl: 
definitions tag.

$XMLNS_XSD The attribute value for the xmlns:s of the wsdl:definitions 
tag

$ENCODINGSTYLE The attribute value for the xmlns:soapenc of the 
wsdl:definitions tag.

$SERVICENAME Name of the service found under the wsdl:service name tag 
of the wsdl file.

$PORTTYPENAME wsdl port type name as mentioned in the wsdl file.

$SESSION_MAINTAIN_PROPERTY This could be given as "" also.

$USERNAME User name to access the web services. Enter "" if no user 
name is required.

$PASSWORD Password to access the web services. Enter "" if no password 
is required.

$WEBSERVICESTYLE This can take either "rpc" in case of DII mode of invoking 
web services or "stub" in case of static mode. This is a 
mandatory parameter.

$STUBIMPLEMENTATION Fully qualified class name (package name.classname).

Attributes for OPERATION tag

Ensure that the "operation tag attributes" are repeated for each of the operation tags.

Table E–8  OPERSTION tag

Placeholder Description

$CODE Should be unique within the Webservice tag.
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Attributes for INPUT tag

Table E–9   INPUT tag

Placeholder Description

$ORDER The sequential number of the INPUT tag. Should 
start from 0. This is in line with the input order of 
the arguments that the API accepts which is called 
by this operation.

$PARAMNAME Input parameter name to be called by the wsdl file.

$ARGTYPE Input Parameter Data Type. If the input argument 
type is complex object, specify $ARGTYPE as 
"xmlstring".

$CLASSNAME Represents class name of input object parameter.

Attributes for OUTPUT tag

Table E–10  OUTPUT tag

Placeholder Description

$PARAMNAME Output parameter name to be returned by the web 
service.

$RETURNTYPE Output parameter Data Type. If the web service response is 
a complex object, then specify $RETURNTYPE as "object".

$CLASSNAME Represents class name of output object parameter.

web.xml Entries
Navigate to <OFSAAI Installation 
Directory>/EXEWebService/<WebServer>/ROOT/WEB-INF/ and edit the web.xml file as 
explained below.

Entry for WSConfig File

The WSCONFIG file (DynamicWSConfig.xml) is available in the <WebServer Deployment 
Path>/ EXEWebService.ear/EXEWebService.war/conf directory. This file can be 
placed in any directory that is accessible by the application.

The path where the WSCONFIG file is placed must be specified in place of 
$WSCONFIGFILELOCATION$ in the below block of text in web.xml.

<context-param>

<description>WebServices Configuration File</description>

<param-name>WSCONFIGFILE</param-name>

$NAME The name of the Function that is to be called by the wsdl file.

$SOAPACTION The URL for the Operation to access. This is associated with 
the Operation tag of the wsdl file.

$STYLE This can take "rpc" if the web services invoking is in 
DII mode or "stub" if it is in static mode. This is a 
mandatory parameter.

$PACKAGENAME Represents the JAXB package of input object.

Table E–8 (Cont.) OPERSTION tag

Placeholder Description
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<param-value>$WSCONFIGFILELOCATION$</param-value>

<!--Specify the Location of DynamicWSConFig.xml-->

</context-param>

Proxy Settings

The following block of text in web.xml file, replace the <param-value> given in bold 
below with appropriate values.

If no values are required, leave the <param-value> blank.

<context-param>

<description>http Proxy Host</description>

<param-name>http.proxyHost</param-name>

<param-value>$PROXYHOST$</param-value>

<!-- Specify the IP address or hostname of the http proxy server-->

</context-param>

<context-param>

<description>http Proxy Port</description>

<param-name>http.proxyPort</param-name>

<param-value>$PROXYPORT$</param-value>

<!--Port Number for the Proxy Server-->

</context-param>

<context-param>

<description>http proxy UserName</description>

<param-name>http.proxyUserName</param-name>

<param-value>$PROXYUSERNAME$</param-value>

<!-- User ID To get authenticated by proxy server-->

</context-param>

<context-param>

<description>http proxy Password</description>

<param-name>http.proxyPassword</param-name>

<param-value>$PROXYPASSWORD$</param-value>

<!-- User Password To get authenticated by proxy server-->

</context-param>

<context-param>

<description>http non-ProxyHosts</description>

<param-name>http.nonProxyHosts</param-name>

<param-value>$NONPROXYHOST$</param-value>

<!--Hosts for which the proxy settings should get by-passed (Note: 
Separate them by "|" symbol) -->

</context-param>
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OFSAAI Home Entry

This entry should point to the Application layer / Web layer of the OFSAAI 
installation and should be accessible.

Replace $FIC_HOME$ in the following block of text in web.xml with <WebServer 
Deployment Path>/EXEWebService.ear/EXEWebService.war.

<context-param>

<description>OFSAAI Web Home</description>

<param-name>FIC_HOME</param-name>

<param-value>$FIC_HOME$</param-value>

<!--OFSAAI Installation Folder-->

</context-param>

<context-param>

<description>OFSAAI Web Home</description>

<param-name>FIC_PHYSICAL_HOME</param-name>

<param-value>$FIC_HOME$</param-value>

<!--OFSAAI Installation Folder-->

</context-param>

DynamicWSConfig.xml

For each third party web service that needs to be accessed using the OFSAAI Web 
services framework, and the operation to be invoked, make corresponding entries into 
this file. This file is to be placed in the location that is specified in the web.xml, as 
WSCONFIGFILE parameter.

Deploy OFSAAI Web Services
You can deploy OFSAAI Web Services separately if you had not configured OFSAAI 
Web Services as part of the installation.

1. Complete the manual configuration of OFSAAI Web Services.

2. Navigate to <OFSAAI Installation Directory>/EXEWebService/<WebServer> 
and execute the command:

./ant.sh

This will trigger the EAR/WAR file creation, which is required for the 
deployment. 

3. Deploy the generated EXEWebService.EAR/EXEWebService.WAR file into the 
WebServer.

If you have already configured OFSAAI Web Services as part of the installation, 
deploy the generated EXEWebService.EAR/ EXEWebService.WAR file into the OFSAAI 
Deployment area in WebServer profile.

Configuration to Enable Parallel Execution of DML statements
A configuration file, OracleDB.conf has been introduced to accommodate any 
configurable parameter related to operations on oracle database. If you do not want to 
set a parameter to a specific value, then the respective parameter entry can be 
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removed/commented off form the OracleDB.conf file which resides in the path $FIC_
DB_HOME/conf.

As of now, the OracleDB.conf file has only one parameter namely CNF_DEGREE_OF_
PARALLELISM. This parameter indicates the degree of parallelism to be used for a DML 
operation if parallel DML is explicitly enabled in the session with the ENABLE 
PARALLEL DML clause of the ALTER SESSION statement. The default mode of a 
session is DISABLE PARALLEL DML. If CNF_DEGREE_OF_PARALLELISM is not 
set, then the default degree, as decided by Oracle will be used.

Configure Message Details in Forms Designer
You can configure the Message Details in Forms Designer under Data Entry Forms and 
Queries module by updating the details of mail server in the 
"NotificationConfig.cfg" file which resides in the path $FIC_APP_
HOME/common/FICServer/conf.

Ensure that the "authorized User details" for whom you need to configure the Message 
details are included in Administration > Security Management > User Administrator > 
User Maintenance window.

Update the following parameters in the "NotificationConfig.cfg" file:

Table E–11  NotificationConfig.cfg File

Parameter Description

SMTP_SERVER_IP Specify the hostname or IP address of SMTP Server.

SMTP_DEBUG_MODE To run SMTP service in Debug mode, set value to 
'true', otherwise set value to 'false'.

SMTP_AUTHORIZATION Set to 'true' if SMTP server requires the client to be 
authenticated, otherwise set to 'false'.

SMTP_USERNAME Username required for logging into SMTP server, if 
authentication is not required use a dummy value.

SMTP_PASSWORD Password required for logging into SMTP server, if 
authentication is not required use a dummy value.

SMTP_MAILID If the Messages has to go from a Particular ID that 
ID need to be added. Exchange server forces you set 
a valid ID that is there in the exchange server. 
(Based on Security settings)

Ensure that the authorized User details are included in Administration > Security 
Management > User Administrator > User Maintenance window.

Clearing Application Cache
This is applicable to all Web Servers (that is,  WebSphere, WebLogic, and Tomcat). 

Prior to the deployment of Infrastructure or Application Service Packs / One-off 
patches, navigate to the following path depending on the WebServer configured and 
clear the cache:

•      Tomcat: <Tomcat installation 
folder>/work/Catalina/localhost/<Application name>/org/apache/jsp

•      WebLogic: <Weblogic installation location>/domains/<Domain 
name>/servers/<Server name>/tmp/_WL_user/<Application name>/qaelce/jsp_
servlet
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•      WebSphere: <Websphere installation 
directory>/AppServer/profiles/<Profile name>/temp/<Node 
name>/server1/<Application name>/<.war file name>

Configuring Password Changes
This section explains about how to modify the OFSAA Infrastructure Config Schema 
and Atomic Schema passwords.

OFSAA Infrastructure Config Schema password modification
To change the Config Schema password, perform the following steps:

1. Change the Config schema User Password in the database.

2. Delete the $FIC_HOME/conf/Reveleus.SEC file.

3. Shutdown the OFSAAI App service:

cd $FIC_APP_HOME/common/FICServer/bin

./stopofsaai.sh

4. Start the Infrastructure Server in foreground directly on the server or through 
X-Windows software using the command:

./startofsaai.sh

5. At the prompt, enter System Password. Enter the "new Config schema" password. 
The service will start and initialize itself if it is able to successfully connect to the 
DB.

6. Post successful startup of the service, if required, the Infrastructure server may be 
shut down and restarted in the background using nohup mode.

OFSAA Infrastructure Atomic Schema password modification
To change the Atomic Schema password, perform the following steps:

1. Change the Atomic schema User Password in the database.

2. Login to the application from the browser using SYSADMN account or any user 
id, which has System Administrator role mapped.

3. Navigate to System Configuration > Database Details window. Select the appropriate 
connection and edit the password.

4. Navigate to Data Management Tools > Data Source> Data Integrator > Sources 
Designer window. Update the appropriate Source details.

5. If you are using Apache Tomcat as Web server, update the <Context> -> 
Resource tag details in Server.xml file from the $CATALINA_HOME/conf folder. (In 
case of Tomcat only Atomic <Resource> will exist).

If you are using WebSphere as Web server:

a. Login to the WebSphere Administration Console, from the left side menu.

b. Navigate to Resources >JDBC >Data Sources. A list of data sources will be 
populated on the right side. 

c. Select the appropriate Data Source and edit the connection details. (In this 
case, both Config and Atomic data sources will need to be modified).

If you are using WebLogic as Web server:
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a. Login to the WebLogic Administration Console, from the left side menu

b. Under Domain Structure list box, expand the appropriate Domain and 
navigate to Services > JDBC >Data Sources. A list of data sources will be 
populated on the right side. 

c. Select the appropriate Data Source and edit the connection details. (In this 
case, both Config and Atomic data sources need to be modified).

6. Restart the OFSAAI services.

Configure Java Virtual Machine
While running several database intensive tasks in parallel, fetching the database 
connection from connection pool may face an error. To ensure no such error is 
encountered, add the line securerandom.source=file:/dev/./urandom in the 
java.security configuration file available in $JAVA_HOME/jre/lib/security/ path.

This needs to be configured only on the machine where the OFSAAI database 
components (ficdb layer) are installed.

Configure Internal Service (Document Upload/Download)
This step can be ignored if it has already been configured as part of any previous 
IR/ML installation. The Document Upload/Download feature has undergone a 
change and can now be configured to use Internal service for document upload / 
download instead of the earlier ExeWebService.To facilitate Internal service for 
document upload/ download, perform the following configurations:

1. Create the folders download, upload, TempDocument, and Temp in the local path  
of Web application server and provide Read/Write permission.

■ To find the exact location, execute the following query in CONFIG schema: 

select localpath from web_server_info

■ To create folders with Read/Write permission, execute the command:

mkdir -m 777 download upload TempDocument Temp

2. Create DocStorage folder in the FTPSHARE location of APP tier and provide 
Read/Write permission.

■ To find the exact location, execute the query in CONFIG schema:

select ftpdrive from app_server_info

■ To create folder with Read/Write permission, execute the command:

mkdir -m 777 DocStorage

By default, the parameter DOCUMENT_SERVICE_TYPE_EXTERNAL value is set to 
FALSE in the Configuration table in CONFIG schema and hence the application 
“ExeWebService” will not be used. It is recommended that the value to be set to 
FALSE and use the Internal service for document upload/downloads. If you intend to 
continue using the External ExeWebService, set the value to TRUE.

Navigate to $FIC_HOME/EXEWebService/<WEBSERVER_TYPE> directory of WEB tier and 
type ./ant.sh. This triggers the creation of EAR/WAR file  EXEWebService.ear/.war. 
The EAR/WAR file EXEWebService.ear/.war will be created  in $FIC_
HOME/EXEWebService/<WEBSERVER_TYPE> directory of WEB tier.  Redeploy the 
generated EAR/WAR file onto your configured web application server.
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Installation Checklist
Before starting on the OFSAAI Installation Kit, ensure that the following 
pre-installation activities checklist is completed successfully. It is recommended to take 
a print out of the checklist and follow the checklist step by step.

Table E–12  General, Pre-Install, Install, and Post Install) Checklist

Step No Task Done

General

1 Check the OFS Customer Analytics 
Release Notes and Read Me 
document for any additional steps to 
be performed on OFS Customer 
Analytics Pack or OFSAAI.

Note: For more details, contact 
Oracle support.

Yes/No

Customer Analytics Application  Pre Installation + During Installation

1 Prior to installation, ensure that 
sufficient free temp space (minimum 
1 GB free) is available in /tmp 
directory of unix server hosting 
OFSAAI.

Yes/No

CA Application Pack Post Installation

1 Perform post-installation steps. For 
more information, refer to Post 
Installation.

Yes/No

OFSAA Landing Page

Figure E–4 OFSAA Landing Page
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Infrastructure can be accessed through your web-browser as soon as the System 
Administrator (SA) installs and configures Oracle Financial Services Analytical 
Applications Infrastructure.

The SA will provide you  a link through which you can access Oracle Financial 
Services Analytical Applications Infrastructure. You can access the Infrastructure 
application login screen through your web-browser using the URL: <IP Address of 
the Web Server > :<servlet port>/<context name>/login.jsp.

You can also login to the Infrastructure application with the host name instead of the 
IP address. To do this, it is necessary to have the host name mapped to the IP address 
in the hosts file the client Windows machine. The hosts file will be in 
%systemroot%\system32\ drivers\etc\ directory.

OFSAAI Login
While accessing Oracle Financial Services Analytical Applications Infrastructure, the 
Splash screen is as displayed:

Figure E–5 OFSAAI Login Page

You can select the required language from the Language drop-down list. The language 
options displayed in the drop-down list are based on the license. Based on the 
Language selected, the appropriate language login screen is displayed.

Enter the User ID and Password provided by the System Administrator and click 
Login. You will be prompted to change your password on your first login. 
Alternatively, you can also choose to change your password any time.
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Figure E–6 OFSAAI Login Page

 

In the Change Password screen, enter a new password, confirm it and click OK to 
view the Splash screen. Refer to the following guidelines for Password Creation:

•      Passwords are displayed as asterisks (stars) while you enter. This is to ensure that 
the password is not revealed to other users.

•      Ensure that the entered password is at least six characters long.

•      The password must be alphanumeric with a combination of numbers and 
characters.

•      The password should not contain spaces.

•      Passwords are case sensitive and ensure that the Caps Lock is not turned ON.

•      By default, the currently used password is checked for validity if password 
history is not set.

•      New password should be different from previously used passwords based on the 
password history which can be configured.

•      If you encounter any of the following problems, contact the System 
Administrator:

■ Your user ID and password are not recognized.

■ Your user ID is locked after three consecutive unsuccessful attempts.

■ Your user ID has been disabled.

■ Guest user cannot change the password.

Activating/Enabling a Product within an Application
Each product is marketed by a separate team and which is headed by a Sales Manager 
who reports to the Sales Head. Each Sales Manager in turn has two Sales Officers who 
are responsible for sales and profitability of the product. 

The Sales Head has decided that the Sales Officer of each product will not have access 
to the information of other products. However, each Sales Manager will have access to 
Sales figures of the other products.
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Using the Oracle Infrastructure Security Hierarchy feature, Administrator can provide 
information security at hierarchy level by defining security options for each hierarchy 
node. Thus, the Bank can control access of information at a node level and not increase 
the overheads.

This is how it is done in Oracle Infrastructure:

•      Firstly, the users are created in Oracle Infrastructure and then, a business 
hierarchy (as defined above) is created.

•      Now, the bank can restrict access of certain information to certain people in the 
Hierarchy Security configuration. 

•      The administrator can control security by mapping the users to various nodes in 
hierarchy.

For example, the administrator maps Sales Officer 1 and Sales Officer 2 to only the 
Personal Loans Node in the Product hierarchy. This restricts Sales Officer 1 and 2 to 
only viewing and maintaining their particular node in the hierarchy. 

By default, all the users mapped to a domain can access all the hierarchy levels to 
which they are mapped. This function allows the administrator to restrict or exclude a 
user/s from accessing restricted nodes.
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F Appendix

Patching Your OFSAA Infrastructure Installation
Oracle strongly recommends installing the latest available patchset so as to be up to 
date with the various releases of the OFSAA Infrastructure product.

You can refer to the below links on http://support.oracle.com for more information 
on latest releases and upgrade compatibility:

Latest OFSAAI 7.3 Release and OFSAA 6.0 and 6.1 Release Information (Doc 
ID 1456593.1)

OFSAAI 7.3 Upgrade and Compatibility Reference (Doc ID 1590502.1)

http://support.oracle.com
https://support.oracle.com/epmos/faces/ui/km/SearchDocDisplay.jspx?returnToSrId=&_afrLoop=17630110005355&srnum=&type=DOCUMENT&id=1456593.1&displayIndex=2&_afrWindowMode=0&_adf.ctrl-state=7tfacg6pm_179
https://support.oracle.com/epmos/faces/DocumentDisplay?_afrLoop=17722932179153&id=1590502.1&_afrWindowMode=0&_adf.ctrl-state=7tfacg6pm_200


Patching Your OFSAA Infrastructure Installation

F-100 Oracle Financial Services Customer Analytics Application Pack                  



G

                Appendix G-101

GAppendix

Cloning OFSAA Instance
There is a consistent need for a faster and effective approach of replicating an existing 
OFSAA instance for further project developments, that is, setting up OFSAA instances 
that are exact copies of the current OFSAA instance. For more information on cloning, 
refer OFSAA Cloning Reference Guide.

http://docs.oracle.com/cd/E61555_01/books/OFSAA_Cloning_Reference_Guide_8.0.pdf
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HAppendix

This Appendix discusses the following sections:

•      Grants for Atomic Schema

•      Grants for Config Schema

•      Grants for Config Schema Entities for Atomic Users

Grants for Atomic Schema
The following are the Grants for Atomic Schema:

GRANT CREATE SESSION TO &database_username

/

GRANT CREATE VIEW TO &database_username

/

GRANT CREATE SEQUENCE TO &database_username

/

GRANT CREATE TABLE TO &database_username

/

GRANT CREATE PROCEDURE TO &database_username

/

grant create RULE to &database_username

/

GRANT CREATE TRIGGER TO &database_username

/

grant create type to &database_username

/

grant select on SYS.V_$PARAMETER to &database_username

/

grant select on sys.dba_free_space to &database_username

/

grant select on sys.dba_tables to &database_username
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/

grant select on sys.Dba_tab_columns to &database_username

/

GRANT CREATE SYNONYM TO &database_username

/

GRANT DEBUG CONNECT SESSION TO &database_username

/

GRANT DEBUG ANY PROCEDURE TO &database_username

/

GRANT CREATE MATERIALIZED VIEW TO &database_username

/

GRANT OLAP_USER TO &database_username

/

GRANT CONNECT TO &database_username

/

GRANT OLAP_USER TO &database_username

/

GRANT CREATE ANY MATERIALIZED VIEW TO &database_username

/

GRANT CREATE ANY TABLE TO &database_username

/

GRANT CREATE MATERIALIZED VIEW TO &database_username

/

GRANT CREATE PROCEDURE TO &database_username

/

GRANT CREATE SEQUENCE TO &database_username

/

GRANT CREATE SESSION TO &database_username

/

GRANT CREATE SYNONYM TO &database_username

/

GRANT CREATE TABLE TO &database_username

/

GRANT CREATE TRIGGER TO &database_username

/

GRANT CREATE TYPE TO &database_username

/
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GRANT CREATE VIEW TO &database_username

/

GRANT DEBUG CONNECT SESSION TO &database_username

/

GRANT RQADMIN to &database_username

/

GRANT RQROLE to &database_username

/

Grants for Config Schema
The following are the Grants for Config Schema:

grant select on CSSMS_USR_PROFILE to &database_username

/

grant select on CSSMS_ROLE_MAST to &database_username

/

grant select on CSSMS_GROUP_MAST to &database_username

/

grant select on CSSMS_FUNCTION_MAST to &database_username

/

grant select on CSSMS_USR_GROUP_MAP to &database_username

/

grant select on CSSMS_USR_GROUP_DSN_SEG_MAP to &database_username

/

grant select on CSSMS_ROLE_FUNCTION_MAP to &database_username

/

grant select on CSSMS_GROUP_ROLE_MAP to &database_username

/

grant select on CSSMS_SEGMENT_MAST to &database_username

/

grant select on BATCH_TASK to &database_username

/

grant select on CSSMS_USR_DSN_SEG_MAP to &database_username

/

grant select on CSSMS_USR_ROLE_MAP to &database_username

/

grant select on CSSMS_METADATA_SEGMENT_MAP to &database_username

/
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grant select on BATCH_RUN to &database_username

/

grant select on PR2_FILTERS to &database_username

/

grant select on PR2_TASK_FILTER to &database_username

/

grant select on PR2_TASK_FILTER_DETAIL to &database_username

/

grant select on ST_STRESS_MASTER to &database_username

/

grant select on ST_SCENARIO_MASTER to &database_username

/

grant select on ST_SHOCK_MASTER to &database_username

/

grant select on BATCH_MASTER to &database_username

/

grant select on ICC_MESSAGELOG to &database_username

/

grant select on PR2_MASTER to &database_username

/

grant select on PR2_RUN_REQUEST to &database_username

/

grant select on MF_MODEL_SCRIPT_MASTER to &database_username

/

grant select on MF_INPUT_VALUES to &database_username

/

grant select on MF_MODEL_OUTPUT_VALUES to &database_username

/

grant select on DB_MASTER to &database_username

/

grant select on DSNMASTER to &database_username

/

grant select on pr2_rule_map to &database_username

/

grant delete on pr2_rule_map_pr to &database_username

/

grant insert on pr2_rule_map_pr to &database_username
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/

grant update on pr2_rule_map_pr to &database_username

/

grant select on pr2_rule_map_pr to &database_username

/

grant delete on pr2_rule_map_pr_tmp to &database_username

/

grant insert on pr2_rule_map_pr_tmp to &database_username

/

grant update on pr2_rule_map_pr_tmp to &database_username

/

grant select on pr2_rule_map_pr_tmp to &database_username

/

grant select on pr2_rule_map_exclude to &database_username

/

grant delete on pr2_rule_map_exclude_pr to &database_username

/

grant insert on pr2_rule_map_exclude_pr to &database_username

/

grant update on pr2_rule_map_exclude_pr to &database_username

/

grant select on pr2_rule_map_exclude_pr to &database_username

/

grant delete on pr2_rule_map_exclude_pr_tmp to &database_username

/

grant insert on pr2_rule_map_exclude_pr_tmp to &database_username

/

grant update on pr2_rule_map_exclude_pr_tmp to &database_username

/

grant select on pr2_rule_map_exclude_pr_tmp to &database_username

/

grant select on pr2_run_object to &database_username

/

grant select on pr2_run_object_member to &database_username

/

grant select on pr2_run_map to &database_username

/
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grant select on pr2_run_execution_b to &database_username

/

grant select on pr2_run_execution_filter to &database_username

/

grant select on pr2_firerun_filter to &database_username

/

grant select on pr2_filters to &database_username

/

grant select on configuration to &database_username

/

grant select on batch_parameter to &database_username

/

grant select on component_master to &database_username

/

grant select on MDB_OBJECT_TYPE_ATT_LAYOUT to &database_username

/

grant select on REV_OBJECT_ATTRIBUTE_DTL to &database_username

/

grant select on FORMS_LOCALE_MASTER to &database_username

/

grant select on mdb_object_dependencies to &database_username

/

grant select on mdb_execution_details to &database_username

/

grant select on REV_STAT_DATA to &database_username

/

grant select on REV_OBJECT_REPOSITORY_B to &database_username

/

grant select on REV_OBJECT_REPOSITORY_TL to &database_username

/

grant select on REV_OBJECT_ATTRIBUTE_DTL_MLS to &database_username

/

grant select on REV_OBJECT_APPLICATION_MAP to &database_username

/

grant select on MDB_OBJ_EXPR_DETAILS to &database_username

/

grant select on MDB_EXECUTION_DETAILS to &database_username
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/

grant select on REV_OBJECT_TYPES_CD to &database_username

/

grant select on REV_OBJECT_TYPES_MLS to &database_username

/

grant select on REV_APPLICATIONS_CD to &database_username

/

grant select on REV_APPLICATIONS_MLS to &database_username

/

grant select on METADATA_BROWSER_LOCALE to &database_username

/

grant select on MDB_STAT_DATA to &database_username

/

grant select on MDB_OBJECT_TYPE_LAYOUT to &database_username

/

grant select on ofsa_md_id_ref to &database_username

/

grant select on MDB_ETL_MAPPING to &database_username

/

grant select on setupinfo to &database_username

/

grant select on LOCALEREPOSITORY to &database_username

/

grant select on MF_MODEL_MASTER to &database_username

/

grant select on MF_SANDBOX_MASTER to &database_username

/

grant select on MF_VARIABLE_MASTER to &database_username

/

grant select on MF_TECHNIQUE_MASTER to &database_username

/

grant select on MDB_RULE_SOURCE_HEADER to &database_username

/

grant select on MDB_RULE_TARGET_HEADER to &database_username

/

grant select on MDB_RULE_TARGET_MEMBER_HEADER to &database_username

/
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grant select on MDB_RULE_GRID_DATA to &database_username

/

grant select on MDB_MODEL_MAPPING to &database_username

/

grant delete on AAI_MAP_MAPPER to &database_username

/

grant insert on AAI_MAP_MAPPER to &database_username

/

grant update on AAI_MAP_MAPPER to &database_username

/

grant select on AAI_MAP_MAPPER to &database_username

/

grant select on RTI_UI_EXCLUDE_PDM_LIST  to &database_username

/

grant select on RTI_VIR_PHY_TBL_NAME  to &database_username

/

grant select on infodom_patches to &database_username

/

grant create SESSION to &database_username

/

grant create PROCEDURE to &database_username

/ 

grant create SEQUENCE to &database_username

/ 

grant create TABLE to &database_username

/ 

grant create TRIGGER to &database_username

/ 

grant create VIEW to &database_username

/ 

grant create MATERIALIZED VIEW to &database_username

/ 

grant olap_user to &database_username

/

grant select on SYS.V_$PARAMETER to &database_username

/

grant create SYNONYM to &database_username
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/

Grants for Config Schema Entities for Atomic Users
The following are the Grants for Config Schema entities for Atomic Users:

GRANT SELECT ON CSSMS_USR_PROFILE TO &database_username

/

GRANT SELECT ON CSSMS_ROLE_MAST TO &database_username

/

GRANT SELECT ON CSSMS_GROUP_MAST TO &database_username

/

GRANT SELECT ON CSSMS_FUNCTION_MAST TO &database_username

/

GRANT SELECT ON CSSMS_USR_GROUP_MAP TO &database_username

/

GRANT SELECT ON CSSMS_USR_GROUP_DSN_SEG_MAP TO &database_username

/

GRANT SELECT ON CSSMS_ROLE_FUNCTION_MAP TO &database_username

/

GRANT SELECT ON CSSMS_GROUP_ROLE_MAP TO &database_username

/

GRANT SELECT ON CSSMS_SEGMENT_MAST TO &database_username

/

GRANT SELECT ON BATCH_TASK TO &database_username

/

GRANT SELECT ON CSSMS_USR_DSN_SEG_MAP TO &database_username

/

GRANT SELECT ON CSSMS_USR_ROLE_MAP TO &database_username

/

GRANT SELECT ON CSSMS_METADATA_SEGMENT_MAP TO &database_username

/

GRANT SELECT ON BATCH_RUN TO &database_username

/

GRANT SELECT ON PR2_FILTERS TO &database_username

/

GRANT SELECT ON PR2_TASK_FILTER TO &database_username

/

GRANT SELECT ON PR2_TASK_FILTER_DETAIL TO &database_username
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/

GRANT SELECT ON ST_STRESS_MASTER TO &database_username

/

GRANT SELECT ON ST_SCENARIO_MASTER TO &database_username

/

GRANT SELECT ON ST_SHOCK_MASTER TO &database_username

/

GRANT SELECT ON BATCH_MASTER TO &database_username

/

GRANT SELECT ON ICC_MESSAGELOG TO &database_username

/

GRANT SELECT ON PR2_MASTER TO &database_username

/

GRANT SELECT ON PR2_RUN_REQUEST TO &database_username

/

GRANT SELECT ON PR2_RULE_MAP TO &database_username

/

GRANT ALL PRIVILEGES ON PR2_RULE_MAP_PR TO &database_username

/

GRANT ALL PRIVILEGES ON PR2_RULE_MAP_PR_TMP TO &database_username

/

GRANT SELECT ON PR2_RULE_MAP_EXCLUDE TO &database_username

/

GRANT ALL PRIVILEGES ON PR2_RULE_MAP_EXCLUDE_PR TO &database_username

/

GRANT ALL PRIVILEGES ON PR2_RULE_MAP_EXCLUDE_PR_TMP TO &database_username

/

GRANT SELECT ON PR2_RUN_OBJECT TO &database_username

/

GRANT SELECT ON PR2_RUN_OBJECT_MEMBER TO &database_username

/

GRANT SELECT ON PR2_RUN_MAP TO &database_username

/

GRANT SELECT ON PR2_RUN_EXECUTION_B TO &database_username

/

GRANT SELECT ON PR2_RUN_EXECUTION_FILTER TO &database_username

/
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GRANT SELECT ON PR2_FIRERUN_FILTER TO &database_username

/

GRANT SELECT ON PR2_FILTERS TO &database_username

/

GRANT SELECT ON CONFIGURATION TO &database_username

/

GRANT SELECT ON BATCH_PARAMETER TO &database_username

/

GRANT SELECT ON COMPONENT_MASTER TO &database_username

/

GRANT SELECT ON MDB_OBJECT_TYPE_ATT_LAYOUT TO &database_username

/

GRANT SELECT ON REV_OBJECT_ATTRIBUTE_DTL TO &database_username

/

GRANT SELECT ON FORMS_LOCALE_MASTER TO &database_username

/

GRANT SELECT ON MDB_OBJECT_DEPENDENCIES TO &database_username

/

GRANT SELECT ON MDB_EXECUTION_DETAILS TO &database_username

/

GRANT SELECT ON REV_STAT_DATA TO &database_username

/

GRANT SELECT ON REV_OBJECT_REPOSITORY_B TO &database_username

/

GRANT SELECT ON REV_OBJECT_REPOSITORY_TL TO &database_username

/

GRANT SELECT ON REV_OBJECT_ATTRIBUTE_DTL_MLS TO &database_username

/

GRANT SELECT ON REV_OBJECT_APPLICATION_MAP TO &database_username

/

GRANT SELECT ON MDB_OBJ_EXPR_DETAILS TO &database_username

/

GRANT SELECT ON MDB_EXECUTION_DETAILS TO &database_username

/

GRANT SELECT ON REV_OBJECT_TYPES_CD TO &database_username

/

GRANT SELECT ON REV_OBJECT_TYPES_MLS TO &database_username
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/

GRANT SELECT ON REV_APPLICATIONS_CD TO &database_username

/

GRANT SELECT ON REV_APPLICATIONS_MLS TO &database_username

/

GRANT SELECT ON METADATA_BROWSER_LOCALE TO &database_username

/

GRANT SELECT ON MDB_STAT_DATA TO &database_username

/

GRANT SELECT ON MDB_OBJECT_TYPE_LAYOUT TO &database_username

/

GRANT SELECT ON OFSA_MD_ID_REF TO &database_username

/

GRANT SELECT ON MDB_ETL_MAPPING TO &database_username

/

GRANT SELECT ON SETUPINFO TO &database_username

/

GRANT SELECT ON LOCALEREPOSITORY TO &database_username

/

GRANT SELECT ON INFODOM_PATCHES TO &database_username

/

grant select on CSSMS_GROUP_MAST to &database_username

/

grant select on MF_MODEL_SCRIPT_MASTER to &database_username

/

grant select on MF_MODEL_OUTPUT_VALUES to &database_username

/

grant select on DB_MASTER to &database_username

/

grant select on DSNMASTER to &database_username

/

grant select on MF_MODEL_MASTER to &database_username

/

grant select on MF_SANDBOX_MASTER to &database_username

/

grant select on MF_VARIABLE_MASTER to &database_username

/
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grant select on MF_TECHNIQUE_MASTER to &database_username

/

grant select on MDB_RULE_SOURCE_HEADER to &database_username

/

grant select on MDB_RULE_TARGET_HEADER to &database_username

/

grant select on MDB_RULE_TARGET_MEMBER_HEADER to &database_username

/

grant select on MDB_RULE_GRID_DATA to &database_username

/

grant select on MDB_MODEL_MAPPING to &database_username

/

grant delete on AAI_MAP_MAPPER to &database_username

/

grant insert on AAI_MAP_MAPPER to &database_username

/

grant update on AAI_MAP_MAPPER to &database_username

/

grant select on AAI_MAP_MAPPER to &database_username

/

grant select on RTI_UI_EXCLUDE_PDM_LIST  to &database_username

/

grant select on RTI_VIR_PHY_TBL_NAME  to &database_username

/

grant select on MF_INPUT_VALUES to &database_username

/

grant select on METADATA_MASTER to &database_username

/

grant select on METADATA_ELEMENT_MASTER to &database_username

/

grant select on METADATA_ATTRIBUTE_MASTER to &database_username

/

grant select on METADATA_LOCALE_MASTER to &database_username

/
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The ojdbc<version>.jar file should be copied based on Database & Java version. 
Refer to the following table for details. 

Table I–1 JDBC Jar files version details

Oracle Datbase 
Version JDK Version Supported

JDBC Jar files specific to the 
release

12.1 or 12cR1 JDK 8 and JDK 6 ojdbc7.jar for JDK 8

ojdbc6.jar for JDK 6

11.2 or 11gR2 JDK 6 & JDK 5 ojdbc6.jar for JDK 6

ojdbc5.jar for JDK 5
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JAppendix

This section of the document consists of resolution to the frequently asked questions 
and error codes noticed during OFSAAI installation.

•      Frequently Asked Questions

•      Error Dictionary

OFSAAI installer performs all the pre-requisite validation check during installation. 
Any errors encountered in the process is displayed with an appropriate Error Code. 
You can refer to the Error Dictionary to find the exact cause and resolution to rectify 
the error.

Frequently Asked Questions
You can refer to the Frequently Asked Questions which has been developed with the 
interest to help you resolve some of the OFSAAI Installation and configuration issues. 
This intends to share the knowledge of problem resolution to a few of the known 
issues. This is not an official support document and just attempts to share the 
knowledge of problem resolution to a few of the known issues.

•      OFSAAI FAQs

•      Application Pack 8.0.0.0.0 FAQs

•      Forms Framework FAQs

OFSAAI FAQs
What are the different components that get installed during OFSAAI?

The different components of OFSAAI are illustrated in Figure 1–2, "Components of 
OFSAAI".

Same is applicable for OFSAAAI installers available for specific Operating 
Systems.

What are the different modes of OFSAAI installation?

OFSAAI can be installed in two modes, Silent Mode, and GUI mode.

Can the OFSAA Infrastructure components be installed on multi-tier?

No. OFSAA Infrastructure components (ficapp, ficweb, ficdb) cannot be installed on 
multi-tier. By default, they will be installed on single-tier. However, OFSAA 
Infrastructure can be deployed within the n-Tier architecture where the Database, Web 
Server and Web Application Server is installed on separate tiers.
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Is JDK (Java Development Kit) required during installation of OFSAA? Can it be 
uninstalled after OFSAA installation?

JDK is not required during  installation of OFSAA and only a run time is needed 
for details. Refer Table 2–2, "Recommended Software Combinations", Java 
Runtime Enviromen section.

Is JRE required during installation of OFSAA? Can it be uninstalled after OFSAAI 
installation?

Only JRE (Java Runtime Environment) is required during installation of OFSAA 
and cannot be uninstalled as the JRE is used by the OFSAA system to work.

How do I know what is the  Operating system, webservers and other software 
versions that OFSAA supports?

Refer to OFSAA Technology Stack Matrices.

What are the different files required to install OFSAAI?

The following files are required:

•      setup.sh.

•      envCheck.sh

•      preinstallcheck.sh

•      VerInfo.txt

•      OFSAAInfrastructure.bin

•      validatedXMLinputs.jar

•      MyResources_en_US.properties

•      log4j.xml

•      OFSAAI_PostInstallConfig.xml

•      OFSAAI_InstallConfig.xml

•      privileges_config_user.sql

•      privileges_atomic_user.sql

•      XML_Utility.jar

What should I do if I get the following error message during installation, "Execute 
Permission denied"?

Please check whether all the files provided for OFSAAI installation has execute  
permissions. 

To give execute permissions,

•      Navigate to the path OFSAAI_80000 and execute the command

chmod 755

"Graphical installers are not.."

If error resembles "Graphical installers are not supported by the VM. The console 
mode will be used instead..." then check whether any of the X-windows software 
has been installed.

Example: Hummingbird Exceed is started and configured to Graphical mode 
installation.

http://docs.oracle.com/cd/E55339_01/homepage.htm


Note: Type 'xclock' from prompt and this should display clock in 
graphical mode.
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"No Java virtual machine could be…"

If the error message reads "No Java virtual machine could be found from your 
PATH environment variable. You must install a VM prior to running this 
program", then 

•      Check whether "java path" is set in PATH variable. See the  Table 3–1, 
" Prerequisite Information"section in this document.

•      Check whether sufficient temporary space is available.

•      Ensure that the movement of OFSAAI Installer text files to the target system 
is done in the Text mode so that setup.sh file does not contain control line 
feed characters (^M).

During the installation, what should one do if the error message shows "OracleDriver 
Files Not Found, Please Choose the Right Path To Continue"?

Check whether the provided path for Oracle Driver files is correct and whether the 
user has permissions to access the files.

During installation, what is to be done if the error always reads "User must have 
CREATE TABLE, CREATE VIEW, CREATE TRIGGER, CREATE INDEX, CREATE 
SEQUENCE, CREATE PROCEDURE" even though the oracle schema user created has 
the mentioned privileges?

OFSAAI installer validates the database details provided during installation, so 
ensure:

•      Whether the oracle schema user has the required set of privileges for 
successful installation.

•      Whether the oracle schema user has been created with quota privileges on 
tablespace to create database objects.

See the  Table 3–1, " Prerequisite Information"section in this document.

Installation of OFSAAI was completed successfully! What next?

Post the successful completion of OFSAAI installation, one has to perform the Post 
Installation steps. See Chapter 5, "Post Installation Configuration". 

What is to be done when OFSAAI Installation is unsuccessful?

OFSAAI installer generates log file OFSAAInfrastructure_Install.log in the 
Infrastructure Installation Directory. There is also another log file created in the 
path configured in Log4j.xml. The logs of any of these reported, Warnings/Non 
Fatal Errors/Fatal Errors/Exceptions should be brought to the notice of the 
OFSAAI Customer Support. It is recommended not to proceed, until the reported 
problems are adequately addressed.

How do I completely uninstall OFSAAI?

OFSAAI can be completely uninstalled by performing the steps provided in 
Uninstalling OFSAA Installation in the OFS AAAI Installation and Configurtion 
Guide Release 8.0.

Can OFSAAI config and atomic schemas be on different databases?
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OFSAAI requires both config and atomic schemas to be present on the same 
database instance.

How to grant privileges if a new information domain is created?

If you are creating a new information domain, provide a set of privileges (database 
permissions) to the new Atomic schema.

•      Log into the database as sys and connect as sysdba user.

•      Execute the file privileges_config_user.sql available under $FIC_HOME 
directory

•      Enter the database schema for which you want to grant privileges.

When should I run the MLS utility?

See the Multiple Language Support (MLS) Utility section in OFSAAI 
Administration Guide in the OTN section.

Does OFSAAI support Oracle Linux versions other than 5.5?

OFSAAI supports the Oracle Linux versions from 5.5 up to 5.10 and also from 6.0 
and above.

On the UNIX System terminal, error message shows "Insert New Media. Please insert 
Disk1 or type it's location"while executing ./setup.sh, what should be done?

1. Login as root user on the Unix machine where OFSAAI is getting installed.

2. Navigate to the path /etc/security/. 

3. Edit the file limits.conf to add/edit a row for the unix user installing 
OFSAA:

<Unix User> soft nofile 9216

4. After saving the changes, log in as unix user with which OFSAAI is getting 
installed and execute the command:

ulimit -n

The command should return the value 9216.

How do I verify if the system environment is ready for OFSAAI installation?

To verify the system environment meets the minimum requirements for the 
installation, a Pre-Install Check utility is available within the Install Kit archive 
file. This utility can also be obtained separately by contacting Oracle Support.

See Verifying the System Environment section for additional information. 

How do I know if  the installation is completed successfully? 

The OFSAA Infrastructure installation performs a post install health check 
automatically on successful installation of the product. To rerun the post install 
verification at a later time, perform the following steps:

1. Navigate to the path $FIC_HOME (Product Installation Directory).

2. Execute the command:

./piverify.sh

What should I do if the installation in GUI mode is not invoked?

There are set of configuration steps required to be performed during  the 
installation in GUI mode. Verify whether the steps mentioned under Configuration 
for GUI Mode Installation section are done correctly. 

http://docs.oracle.com/cd/E60058_01/homepage.htm
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What should I do if there are any exceptions or errors in installation and how to 
proceed?

1. Please backup the installation logs.

2. Share the backup logs with Oracle support.

On Solaris 11 system, if one gets the following error message during OFSAAI 
installation, what should be done:

"Error: OFSAAI-1108

ORA-00604: error occurred at recursive SQL level 1

ORA-01882: timezone region not found"

Or

"Time zone cannot be set as null or 'localtime' "

This happens if the time zone is not set, that is NULL or it is set as ’localtime’. Set 
the environment variable TZ to a valid time zone region in the .profile file. For 
example, 

TZ=Asia/Calcutta

export TZ

What  happens if the installation process is abruptly terminated or aborted? What 
should I do?

If the installation is abruptly terminated, then the installation process will be 
incomplete. To recover from this, follow the below steps:

1. Drop the DB objects in the config schema created by OFSAAI installation.

2. Open the .profile and remove the entries made by the OFSAAI installation 
which are made between the comment statements, #Beginning of entries by 
OFSAA Infrastructure installation and #End of entries by OFSAA 
Infrastructure installation.

3. Delete the OFSAA install directory created by the OFSAAI installer.

4. Perform the OFSAAI installation again. 

Would OFSAA support any other web server types, other than the ones stated in tech 
matrix and installation guide?

No, all the supported softwares and versions are stated in the  OFSAA Technology 
Stack Matrices. 

What should I do if the database connection from connection pool throws an error 
"java.sql.SQLRecoverableException: IO Error: Connection reset"?

This happens while running several database intensive tasks in parallel. To correct 
this error, add the line securerandom.source=file:/dev/./urandom in the 
java.security configuration file available in $JAVA_HOME/jre/lib/security/ 
path.

Note: This needs to be configured on all the machines or VMs where 
the OFSAAI components are installed.

http://docs.oracle.com/cd/E55339_01/homepage.htm
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If the issue is not resolved even with the above settings, check the MTU(Maximum 
Transmission Unit) settings on the linux box. For details on MTU settings and 
updating them, contact your system Administrator.

When I invoke setup.sh file from my install archive, it throws syntax errors/file not 
found error messages, what should I do?

This could mostly  happen:

•      When installer was not unzipped rightly or corrupted during unzip.

•      setup.sh file which resides within the install archive was  not transferred in 
ASCII or text mode, which could have corrupted the file.

To correct this, follow the steps:

1. Copy the installer (in BINARY mode) to the system on which the OFSAA 
Infrastructure components will be installed.

2. Unzip the installer using the command:

unzip <OFSAAI_Installer>.zip

3. The corrupted setup.sh file would have introduced certain ^M characters into 
the file.  You can remove ^M characters from setup.sh file by following the 
below steps:

Note: To enter ^M, hold the CTRL key then press V and M in 
succesion.

a. Login to the server where the installer is copied.

b. Navigate to the directory OFSAAI_80000.

c. Open the setup.sh file in the vi editor using the command: vi setup.sh.

d. Inside vi editor in Esc mode, type: %s/^M//g 

e. Save the setup.sh file by typing: wq!

Does OFSAA support Oracle DB 11g Standard edition?

The OCI client and the jdbc driver does not change depending on whether it is a 
standard or enterprise edition. So, OFSAAI will work with standard edition as 
well.

We do not recommend standard edition because it will not scale and  does not 
support partition pack, database security vault, or advanced analytics.

What should I do if I get the following error message while executing ./startofsaai.sh 
file on the UNIX System terminal "./startofsaai.sh: /java: Execute permission denied"?

•      Ensure JAVA_BIN environment variable path is set on the "unix user" 
terminal from where the startofsaai.sh file is invoked.

•      Ensure the .profile where the environment/ path settings are made has 
been executed successfully.

What happens when the OFSAAI Application Server does not proceed even after 
providing the system password?

Ensure that, the System Password provided when prompted should match with 
the "Oracle Configuration password" provided during installation. Also check 
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whether the connection to the "configuration schema" can be established through 
sqlplus.

Although the OFSAAI installation has completed successfully, when OFSAAI servers 
are started, and the application URL is accessed, it gives an error message "the page 
cannot be found or displayed" or "Could not retrieve list of languages from Server. 
Please contact the system administrator". What should one do?

Ensure OFSAAI servers have been started and are running successfully. On the 
server start up parameters options, see Starting Infrastructure Services section.

For more details on the issue, refer on to the Revappserver log in $FIC_APP_ 
HOME/common/FICServer/logs directory or the Web Server log files.

Is it necessary to provide the specified grants to the Oracle schema user before 
installation? If yes, can it be revoked after completion of installation?

The "Oracle schema" user requires the necessary grants specified before, during, 
and after the installation process. Grants provided should never be revoked as the 
application makes use of these grants all the time.

Can I have distributed OFSAAI Application Server for load balancing?

OFSAAI Application server can be scaled out/distributed across different JVM's 
(machines) based on the various services and Information Domains, in other 
words, Load balancing could be achieved with distribution of services.

Why do I need Ftpshare? Why is it needed on all the layers? Can I have ftpshare on 
another machine other than the machines where OFSAAI is installed?

Ftpshare is a Metadata Repository directory. All the metadata related files used in 
Infrastructure are stored in the ftpshare directory. The ftpshare contains folders for 
each Information Domain, with each Information Domain folders holding Erwin, 
log, and scripts folder. The transfer of data among the Web, Application, and 
Database servers in Infrastructure takes place through FTP/SFTP.

You need to configure FTP/SFTP and enable communication between the servers 
by providing App server's FTP/SFTP credentials to the Web server and DB server 
users.

Yes, we can have ftpshare on another machine other than the machines where 
OFSAAI is installed.

Is it mandatory to provide the ftp/sftp password? 

Yes, OFSAAI needs credentials of the user which has complete permissions on 
ftpshare directory, and should be able to independently login to the unix server.

What are the permissions required for ftpshare and when should I give them?

It is recommended to provide  permissions on ftpshare in case of  installations 
done across different machines or VMs (multitier installation ).

In case of single tier installation, 770 permissions can be provided if the unix users 
of OFSAAI and web server belong to the same unix group.

And on any new file that is created in the 'ftpshare' folder of any installation layer 
should be granted specific/explicit permission.

Port Change utility could be used to have the Port number modified, which are 
currently being used by the Infrastructure application. For more information, refer  
Changing IP/ Hostname, Ports, Deployed Paths of the OFSAA Instancesection.

Are there any in-built system administration users within OFSAAI Application?
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The three in-built system administration users are provided to configure and setup 
OFSAAI.

•      SYSADMN 

•      SYSAUTH

•      GUEST 

Does OFSAAI Application support both FTP and SFTP?

OFSAAI supports both FTP and SFTP configuration.

Is it necessary to enable the FTP/SFTP services to use the OFSAAI?

Yes, enabling of FTP/SFTP services and its ports is a pre-requisite step towards 
using the OFSAAI.

OFSAAI Configuration: Unable to save the server details?

•      Ensure the input User ID, Password, and Share Name are correct.

•      Ensure FTP/SFTP services are enabled.

•      Have a test FTP/SFTP connection made and confirm if they are successful.

During Information Domain creation, the message "Please create a database and then 
create the information domain" appears. What should be done?

Information Domain is mapped to only one Database; and thus before the creation 
of Information Domain, at least one database details would need to exist.

The message "ConnectToDatabase: FatalError, could not connect to the DB server" 
appears during startup of backend engine message server. What does one need to do?

•      Verify whether connection to the "configuration schema" can be established 
through sqlplus.

•      Verify "configuration schema" password is modified post installation.

•      Ensure oracle database alias name created for oracle instance and oracle 
service name are same.

•      On a multi tier Installation mode, ensure TNSNAME and SID are the same in 
both the Application and Database Layers.

The message "Fatal Error, failed to get user ID from LibSmsConnect" appears during 
the startup of backend engine message server. What has to be done?

Ensure Reveleus.sec file exist under the $FIC_HOME/conf directory where the 
Database components are installed.

Does OFSAAI Application support LDAP authentication?

OFSAAI supports LDAP configuration and authentication.

Does OFSAAI support multiple languages?

Yes, OFSAAI supports multiple languages.

Does OFSAAI provide any data back-up features?

OFSAAI does not have built-in back up facility. External Storage Infrastructure is 
recommended for back-up.

What kind of security features does the OFSAAI provides?

OFSAAI provides security at:

•      Segment Level - Users can access only the segment they are mapped to.
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•      Application Level - Users can perform an operation only if mapped to 
appropriate role and functions.

Does OFSAAI have the ability to enforce periodic password change?

OFSAAI provides configurable parameters to define number of days after which 
the user password would expire and then the user is forced to change the 
password after expiration period.

What is the password policy followed in OFSAAI?

OFSAAI enforces a minimum password length with a combination of Upper and 
Lower case characters and alpha-numeric strings.

Which version of Erwin Data Modeller does OFSAAI support?

OFSAAI now supports ERwin version 9.2 and 9.5 generated xmls in addition to 
ERwin 4.1, ERwin 7.1, ERwin 7.3 and ERwin 9.0 formats.

Does OFSAAI provide the mechanism to upload Business Data model?

OFSAAI provides two mechanisms for business data model upload:

•      Easy to use GUI based Model upload mechanism to upload the Business Data 
Model through Unified Metadata Manager --> Import Model.

•      OFSAAI also provides a model upload utility "upload.sh" for uploading the 
business data model through the command line parameter by executing this 
shell script file under the path <FIC_HOME>/ficapp/common/FICServer/bin.

Refer the section Run Model Upload Utilityof the OTN for details. 

The Business Data model undergoes changes; how does this incremental change get 
applied to the existing model?

Modified data model can be uploaded into the system and OFSAAI has the ability 
to compare the changes within the data model with respect to the one already 
present in the system and enables propagation of incremental changes in a 
consistent manner.

What are the different types of uploading a business data Model? 

OFSAAI supports uploading of business data model from client desktop and also 
by picking up the data model from the server location.

Can the OFSAAI "Configuration Schema" password be modified post installation?

The OFSAAI "configuration schema" password can be modified post installation. 
OFSAAI application stores the password in the database and few configuration 
files, thus any changes to the "configuration schema" password would necessitate 
updating in these. Contact OFSAAI support for more details.

Can the OFSAAI "Atomic  Schema" password be modified?

The OFSAAI "Atomic Schema" password can be modified. OFSAAI application 
stores the atomic schema password in the database and few configuration files , 
thus any change to the atomic schema password would necessitate updating the 
password.

To change the Atomic Schema password, follow the steps:

1. Login to OFSAA.

2. Navigate to System Configuration > Database Details window. Select the 
appropriate connection, provide the modified password and save.

http://docs.oracle.com/cd/E60058_01/homepage.htm
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3. Navigate to Unified Metadata Manager > Technical Metadata> Data Integrator 
> Define Sources window. Update the appropriate Source details.

a. If you are using Apache Tomcat as Web server:

* Update the <Context> -> Resource tag details in server.xml file from the 
$CATALINA_HOME/conf folder. (In case of Tomcat only Atomic <Resource> 
will exist).

b. If you are using WebSphere as Web server:

* Login to the WebSphere Administration Console from the left side menu.

* Navigate to Resources >JDBC >Data Sources. A list of data sources will be 
populated on the right side.

* Select the appropriate Data Source and edit the connection details. (In this 
case, both Config and Atomic data sources need to be modified).

c. If you are using WebLogic as Web server:

* Login to the WebLogic Administration Console from the left side menu.

* Under Domain Structure list box, expand the appropriate Domain and 
navigate to Services > JDBC >Data Sources. A list of data sources will be 
populated on the right side.

* Select the appropriate Data Source and edit the connection details. (In this 
case, both Config and Atomic data sources need to be modified).

4. Restart the OFSAAI services

Note: If the modified passwords are not updated, OFSAAI logs 
displays the message ORA-28000: the account is locked.

 Does the upload of Business Data model depend on Java Memory?

Business data model upload through OFSAAI depends on the Java memory 
settings on the client and server machines. Java memory setting varies with the 
data model size and the available RAM. Contact OFSAAI support for more details.

Why do the Business Metadata Management screens (Business Processors screen) in 
User Interface, takes longer time to load?

The Log file in DynamicServices.xml which resides in $FIC_HOME/conf is 
continuously being updated/refreshed to cache metadata. This can be observed 
when you are starting startofsaai.sh and if any of the log file (Ex: 
SMSService.log) in DynamicServices.xml is being continuously refreshed for 
longer time.

By default, the Metadata Log file cache size is set to 1000. If in case the log is being 
updated beyond this limit, retrospectively the preceding entries are overwritten. 
For example, the 1001th entry is overwritten by deleting the first entry. This results 
in the application screen taking a longer time to load.

Increase the cache size limit in Dynamicservices.xml located at <FIC_HOME>/conf, 
depending on the currently logged count for the specific metadata.

1. Generate the Log report by executing the below query in config schema.

select count(1), t.metadata_name, m.dsn_id

from metadata_master m, metadata_type_master t 
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where m.metadata_type = t.metadata_type

group by t.metadata_name, m.dsn_id

2. The above query returns a list of codes with their respective metadata count. 
You can refer to "metadata_type_master" table to identify the metadata name.

3. View the log report to identify the metadata which is being updated/refreshed 
beyond the specified cache size limit. Accordingly increase the cache size limit 
in Dynamicservices.xml depending on the currently logged count for the 
specific metadata.

For example, if the "MEASURE_CACHE_SIZE" is set to 1000 and total 
measure reported in log is 1022, increase the limit to 2000 (approximately).

4. Restart Reveleus/OFSAAI servers (Web and APP) and check the issue.

What should I do if I get OutOfMemoryError while deploying EAR file in WebSphere 
application server?

The Java memory needs to be increased in ejbdeploy.sh file which is present 
under <WebSphere Install directory>/AppServer/deploytool/itp. For 
example, 

$JAVA_CMD \

-Xbootclasspath/a:$ejbd_bootpath \ 

Xms256m -Xmx1024m \

What configurations should I ensure if my data model size is greater than 2GB?

In order to upload data model of size greater than 2GB in OFSAAI Unified 
Metadata Manager- Import Model, you need to configure the required model size 
in struts.xml file available in the path $FIC_WEB_
HOME/webroot/WEB-INF/classes.

Note: The size requirements have to be always specified in bytes.

For example, if you need to configure for model size of 2.5GB, then you can 
approximately set the max size to 3GB (3221225472 bytes) as indicated below, in 
order to avoid size constraints during model upload.

<constant name="struts.multipart.maxSize" value="3221225472"/>

After configuring struts.xml file, generate the application EAR/WAR file and 
redeploy the application onto your configured web application server. For more 
information on generating and deploying EAR / WAR file, see Configuring Web 
Application Servers.

What should I do if my Hierarchy filter is not reflecting correctly after I make changes 
to the underlying Hierarchy?

In some cases, the Hierarchy Filters do not save the edits correctly if the 
underlying Hierarchy has been changed. This can occur in hierarchy maintenance, 
where you have moved a member to another hierarchy branch, and that member 
was explicitly selected in the Filter and is now a child of a node which is already 
selected in the Filter.

Please refer to Support Note for the workaround.

How do I turn off unused information domains (infodoms) from cache?

https://mosemp.us.oracle.com/epmos/faces/DocumentDisplay?id=1586342.1
https://support.oracle.com/epmos/faces/DocumentDisplay?_afrLoop=448098703264718&id=1586342.1&_afrWindowMode=0&_adf.ctrl-state=154byl0wqm_4
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Follow the below steps to turn off unused infodoms from cache:

Navigate to $FIC_HOME/conf in the APP layer of your OFSAAI installation. 

1. In the DynamicServices.xml file, identify the section for <Service code="20">. 

2. Modify the value of parameter CACHE_ON_STARTUP to 0 (default is 1). 

3. Repeat the same in the WEB layer too. Generate the application EAR/WAR 
file and redeploy the application onto your configured web application server. 
For more information on generating and deploying EAR / WAR file, see 
Configuring Web Application Servers.

4. Restart the OFSAAI Services (APP and WEB). For more information, see Start 
and Stop of Infrastructure Services.

Note: This setting will cache the Infodom metadata only for the 
infodoms that get accessed upon user login. Infodoms which do not 
get accessed, will not be cached.

Sample code is pasted below: 

<SERVICE CODE="20" 

CLASS="com.iflex.fic.metadata.services.MetadataServiceProvider" 
NAME="BMD" 

SERVERID="DEFAULT" PATH=" " LOGGERNAME="UMMLOGGER" LOGGERLEVEL="10"> 

<PARAMETERS> 

<PARAMETER NAME="CACHE_ON_STARTUP" VALUE="0" /> 

<PARAMETER NAME="BACKUP_XML" VALUE="1" /> 

<PARAMETER NAME="MAX_BACKUP_XML" VALUE="2" /> 

<PARAMETER NAME="PC_NONBI_BI_SWITCH" VALUE="2048" /> 

<PARAMETER NAME="HIERARCHY_NODE_LIMIT" VALUE="2000" /> 

<PARAMETER NAME="ALIAS_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="DATASET_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="MEASURE_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="HIERARCHY_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="DIMENSION_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="HIERARCHYATTRIBUTE_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="CUBE_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="RDM_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="BUSINESSPROCESSOR_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="DERIVEDENTITY_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="LOG_GET_METADATA" VALUE="false" /> 

<PARAMETER NAME="METADATA_PARALLEL_CACHING" VALUE="0" /> 

</PARAMETERS> 

</SERVICE>
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Can I install an Application Pack on an existing Atomic schema/ Information 
Domain created manually?

No, you cannot install an Application Pack on existing Atomic schema/Information 
Domain created manually. Application Packs can be installed only on Atomic 
Schemas/Information Domain created using schema creator utility and/ or the 
Application Pack installer.

When trying to view the model outputs in Model Outputs screen, I get "Exception 
->Local Path/STAGE/Output file name (No such file or directory)".

Ensure you have created a folder "STAGE" under the path mentioned as "Local Path" 
in the web server details screen. This folder needs to be created under the local path on 
every node ,in case of web application server clustering.

During OFSAA services startup, I get Exception in thread "main" 
java.lang.UnsatisfiedLinkError: net (Not a directory)?

Ensure the JRE referred in .profile is not a symbolic link. Correct the path reference to 
point to a physical JRE installed.

What is the optimized memory settings required for "New" model upload?

The following table lists the optimized memory settings required for "New" model 
upload.

Table J–1 Optimized Memory Settings for New Model Upload

Model Upload Options
Size of Data Model 
XML File

X_ARGS_APP ENV 
Variable in OFSAAI 
APP Layer

Pick from Server 106 MB "-Xms1024m 
-Xmx1024m

36 MB "-Xms2048m 
-Xmx2048m

815 MB "-Xms4096m 
-Xmx4096m

1243 MB "-Xms6144m 
-Xmx6144m

Model Upload Utility 106 MB "-Xms1024m 
-Xmx1024m"-Xms2048
m -Xmx2048m

336 MB "-Xms4096m 
-Xmx4096m

815 MB "-Xms4096m 
-Xmx4096m

1243 MB "-Xms6144m 
-Xmx6144m

Save New Erwin File In 
Server

106 MB "-Xms1024m 
-Xmx1024m

336 MB "-Xms2048m 
-Xmx2048m

"-Xms4096m 
-Xmx4096m

"-Xms6144m 
-Xmx6144m
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What is the resolution if I get the error - ORA 01792 maximum number of columns in a 
table or view is 1000 during T2T execution?

You should apply the below patch set from Oracle. Applicable only for 12c.

https://support.oracle.com/epmos/faces/DocumentDisplay?id=1937782.1 

I did not enable OFS Inline Processing Engine Application license during the 
installation. However, I have enabled it post installation, using the Manage OFSAA 
Product License(s) in the Admin UI. Are there any other additional configurations 
that I need to do?

Yes. Follow the instructions explained in the OFS Inline Processing Engine Configuration 
Guide.

I get an error when I try to build an Oracle OLAP cube. What should I do? 

Execute the below grant on the appropriate ATOMIC schema  
grant olap_user to &database_username

How do I turn off unused Information Domains (Infodoms) from caching?

Follow these steps to turn off unused infodoms from caching:

1. Navigate to $FIC_HOME/conf in the APP layer of your OFSAAI installation.

2.  In the DynamicServices.xml file, identify the section for <Service code="20">. 

3. Modify the value of parameter CACHE_ON_STARTUP to 0 (default is 1). 

4. Repeat the same in the WEB layer too. Generate the application EAR/WAR file 
and redeploy the application onto your configured web application server. For 
more information on generating and deploying EAR / WAR file, refer to the Post 
Installation Configuration section.

5. Restart the OFSAAI Services (APP and WEB). For more information, refer to the 
Starting Infrastructure Services section.

Note: This setting will cache the Infodom metadata only for the 
infodoms that get accessed upon user login. Infodoms which do not 
get accessed, will not be cached. 

Sample code is pasted below: 

<SERVICE CODE="20" 

CLASS="com.iflex.fic.metadata.services.MetadataServiceProvider" NAME="BMD" 

SERVERID="DEFAULT" PATH=" " LOGGERNAME="UMMLOGGER" LOGGERLEVEL="10"> 

<PARAMETERS> 

<PARAMETER NAME="CACHE_ON_STARTUP" VALUE="0" /> 

<PARAMETER NAME="BACKUP_XML" VALUE="1" /> 

<PARAMETER NAME="MAX_BACKUP_XML" VALUE="2" /> 

<PARAMETER NAME="PC_NONBI_BI_SWITCH" VALUE="2048" /> 

<PARAMETER NAME="HIERARCHY_NODE_LIMIT" VALUE="2000" /> 

<PARAMETER NAME="ALIAS_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="DATASET_CACHE_SIZE" VALUE="2000" /> 

https://support.oracle.com/epmos/faces/DocumentDisplay?id=1937782.1
http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
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<PARAMETER NAME="MEASURE_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="HIERARCHY_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="DIMENSION_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="HIERARCHYATTRIBUTE_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="CUBE_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="RDM_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="BUSINESSPROCESSOR_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="DERIVEDENTITY_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="LOG_GET_METADATA" VALUE="false" /> 

<PARAMETER NAME="METADATA_PARALLEL_CACHING" VALUE="0" /> 

</PARAMETERS> 

</SERVICE>

"While creating an Excel Mapping, after specifying the excel worksheet, the target 
table, and mapping each column in the worksheet to a target table, I click SAVE and 
nothing happens. But when I click CANCEL, a message pops up informing me that all 
changes will be discarded", what is to be done.

Check if the excel mapping creation is done using I.E 8 with JRE 1.4 plug in enabled on 
machine. If so, upgrade the JRE plug in to 1.7+.

OFSAAI FAQs
What are the different components that get installed during OFSAAI?

The different components of OFSAAI are illustrated in Figure 1–2, "Components of 
OFSAAI".

What are the different modes of OFSAAI installation?

OFSAAI can be installed in two modes, Silent Mode, and GUI mode.

Can the OFSAA Infrastructure components be installed on multi-tier?

No. OFSAA Infrastructure components (ficapp, ficweb, ficdb) cannot be installed on 
multi-tier. By default, they will be installed on single-tier. However, OFSAA 
Infrastructure can be deployed within the n-Tier architecture where the Database, Web 
Server and Web Application Server is installed on separate tiers.

Is JDK (Java Development Kit) required during installation of OFSAA? Can it be 
uninstalled after OFSAA installation?

JDK is not required during  installation of OFSAA and only a run time is needed 
for details. Refer  Configurations Supported for Java 7 and Configurations 
Supported for Java 8, Java Runtime Enviromen section.

Is JRE required during installation of OFSAA? Can it be uninstalled after OFSAAI 
installation?

Only JRE (Java Runtime Environment) is required during installation of OFSAA 
and cannot be uninstalled as the JRE is used by the OFSAA system to work.

How do I know what is the  Operating system, webservers and other software 
versions that OFSAA supports?

Refer to OFSAA Technology Stack Matrices.

http://docs.oracle.com/cd/E55339_01/homepage.htm
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What are the different files required to install OFSAAI?

The following files are required:

•      setup.sh.

•      envCheck.sh

•      preinstallcheck.sh

•      VerInfo.txt

•      OFSAAInfrastructure.bin

•      validatedXMLinputs.jar

•      MyResources_en_US.properties

•      log4j.xml

•      OFSAAI_PostInstallConfig.xml

•      OFSAAI_InstallConfig.xml

•      privileges_config_user.sql

•      privileges_atomic_user.sql

•      XML_Utility.jar

What should I do if I get the following error message during installation, "Execute 
Permission denied"?

Please check whether all the files provided for OFSAAI installation has execute  
permissions. 

To give execute permissions,

•      Navigate to the path OFSAAI_80000 and execute the command

chmod 755

"Graphical installers are not.."

If error resembles "Graphical installers are not supported by the VM. The console 
mode will be used instead..." then check whether any of the X-windows software 
has been installed.

Example: Hummingbird Exceed is started and configured to Graphical mode 
installation.

Note: Type 'xclock' from prompt and this should display clock in 
graphical mode.

"No Java virtual machine could be…"

If the error message reads "No Java virtual machine could be found from your 
PATH environment variable. You must install a VM prior to running this 
program", then 

•      Check whether "java path" is set in PATH variable. See the  Table 3–1, 
" Prerequisite Information"section in this document.

•      Check whether sufficient temporary space is available.
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•      Ensure that the movement of OFSAAI Installer text files to the target system 
is done in the Text mode so that setup.sh file does not contain control line 
feed characters (^M).

During the installation, what should I do if the error message shows "OracleDriver 
Files Not Found, Please Choose the Right Path To Continue"?

Check whether the provided path for Oracle Driver files is correct and whether the 
user has permissions to access the files.

During installation, what is to be done if the error always reads "User must have 
CREATE TABLE, CREATE VIEW, CREATE TRIGGER, CREATE INDEX, CREATE 
SEQUENCE, CREATE PROCEDURE" even though the oracle schema user created has 
the mentioned privileges?

OFSAAI installer validates the database details provided during installation, so 
ensure:

•      Whether the oracle schema user has the required set of privileges for 
successful installation.

•      Whether the oracle schema user has been created with quota privileges on 
tablespace to create database objects.

See the  Table 3–1, " Prerequisite Information"section in this document.

Installation of OFSAAI was completed successfully! What next?

Post the successful completion of OFSAAI installation, one has to perform the Post 
Installation steps. See Chapter 5, "Post Installation Configuration". 

What is to be done when OFSAAI Installation is unsuccessful?

OFSAAI installer generates log file OFSAAInfrastructure_Install.log in the 
Infrastructure Installation Directory. There is also another log file created in the 
path configured in Log4j.xml. The logs of any of these reported, Warnings/Non 
Fatal Errors/Fatal Errors/Exceptions should be brought to the notice of the 
OFSAAI Customer Support. It is recommended not to proceed, until the reported 
problems are adequately addressed.

How do I completely uninstall OFSAAI?

OFSAAI can be completely uninstalled by performing the steps provided in 
Uninstalling OFSAA Infrastructure in the OFS AAAI Installation and Configurtion 
Guide Release 8.0.

Can OFSAAI config and atomic schemas be on different databases?

OFSAAI requires both config and atomic schemas to be present on the same 
database instance.

How to grant privileges if a new information domain is created?

If you are creating a new information domain, provide a set of privileges (database 
permissions) to the new Atomic schema.

•      Log into the database as sys and connect as sysdba user.

•      Execute the file privileges_config_user.sql available under $FIC_HOME 
directory

•      Enter the database schema for which you want to grant privileges.

When should I run the MLS utility?
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See the Multiple Language Support (MLS) Utility section in OFSAAI 
Administration Guide in the OTN section.

Does OFSAAI support Oracle Linux versions other than 5.5?

OFSAAI supports the Oracle Linux versions from 5.5 up to 5.10 and also from 6.0 
and above.

On the UNIX System terminal, error message shows "Insert New Media. Please insert 
Disk1 or type it's location"while executing ./setup.sh, what should be done?

1. Login as root user on the Unix machine where OFSAAI is getting installed.

2. Navigate to the path /etc/security/. 

3. Edit the file limits.conf to add/edit a row for the unix user installing 
OFSAA:

<Unix User> soft nofile 9216

4. After saving the changes, log in as unix user with which OFSAAI is getting 
installed and execute the command:

ulimit -n

The command should return the value 9216.

How do I verify if the system environment is ready for OFSAAI installation?

To verify the system environment meets the minimum requirements for the 
installation, a Pre-Install Check utility is available within the Install Kit archive 
file. This utility can also be obtained separately by contacting Oracle Support.

See Verifying the System Environment section for additional information. 

How do I know if  the installation is completed successfully? 

The OFSAA Infrastructure installation performs a post install health check 
automatically on successful installation of the product. To rerun the post install 
verification at a later time, perform the following steps:

1. Navigate to the path $FIC_HOME (Product Installation Directory).

2. Execute the command:

./piverify.sh

What should I do if the installation in GUI mode is not invoked?

There are set of configuration steps required to be performed during  the 
installation in GUI mode. Verify whether the steps mentioned under Configuration 
for GUI Mode Installation section are done correctly. 

What should I do if there are any exceptions or errors in installation and how to 
proceed?

1. Please backup the installation logs.

2. Share the backup logs with Oracle support.

On Solaris 11 system, if one gets the following error message during OFSAAI 
installation, what should be done:

"Error: OFSAAI-1108

ORA-00604: error occurred at recursive SQL level 1

ORA-01882: timezone region not found"

http://docs.oracle.com/cd/E60058_01/homepage.htm
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Or

"Time zone cannot be set as null or 'localtime' "

This happens if the time zone is not set, that is NULL or it is set as ’localtime’. Set 
the environment variable TZ to a valid time zone region in the .profile file. For 
example, 

TZ=Asia/Calcutta

export TZ

What  happens if the installation process is abruptly terminated or aborted? What 
should I do?

If the installation is abruptly terminated, then the installation process will be 
incomplete. To recover from this, follow the below steps:

1. Drop the DB objects in the config schema created by OFSAAI installation.

2. Open the .profile and remove the entries made by the OFSAAI installation 
which are made between the comment statements, #Beginning of entries by 
OFSAA Infrastructure installation and #End of entries by OFSAA 
Infrastructure installation.

3. Delete the OFSAA install directory created by the OFSAAI installer.

4. Perform the OFSAAI installation again. 

Would OFSAA support any other web server types, other than the ones stated in tech 
matrix and installation guide?

No, all the supported softwares and versions are stated in the  OFSAA Technology 
Stack Matrices. 

What should one do if the database connection from connection pool throws an error 
"java.sql.SQLRecoverableException: IO Error: Connection reset"?

This happens while running several database intensive tasks in parallel. To correct 
this error, add the line securerandom.source=file:/dev/./urandom in the 
java.security configuration file available in $JAVA_HOME/jre/lib/security/ 
path.

Note: This needs to be configured on all the machines or VMs where 
the OFSAAI components are installed.

If the issue is not resolved even with the above settings, check the MTU(Maximum 
Transmission Unit) settings on the linux box. For details on MTU settings and 
updating them, contact your system Administrator.

When I invoke setup.sh file from my install archive, it throws syntax errors/file not 
found error messages, what should I do?

This could mostly  happen:

•      When installer was not unzipped rightly or corrupted during unzip.

•      setup.sh file which resides within the install archive was  not transferred in 
ASCII or text mode, which could have corrupted the file.

To correct this, follow the steps:

1. Copy the installer (in BINARY mode) to the system on which the OFSAA 
Infrastructure components will be installed.

http://docs.oracle.com/cd/E55339_01/homepage.htm
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2. Unzip the installer using the command:

unzip <OFSAAI_Installer>.zip

3. The corrupted setup.sh file would have introduced certain ^M characters into 
the file.  You can remove ^M characters from setup.sh file by following the 
below steps:

Note: To enter ^M, hold the CTRL key then press V and M in 
succesion.

a. Login to the server where the installer is copied.

b. Navigate to the directory OFSAAI_80000.

c. Open the setup.sh file in the vi editor using the command: vi setup.sh.

d. Inside vi editor in Esc mode, type: %s/^M//g 

e. Save the setup.sh file by typing: wq!

Does OFSAA support Oracle DB 11g Standard edition?

The OCI client and the jdbc driver does not change depending on whether it is a 
standard or enterprise edition. So, OFSAAI will work with standard edition as 
well.

We do not recommend standard edition because it will not scale and  does not 
support partition pack, database security vault, or advanced analytics.

What should I do if I get the following error message while executing 
./reveleusstartup.sh file on the UNIX System terminal "./reveleusstartup.sh: /java: 
Execute permission denied"?

•      Ensure JAVA_BIN environment variable path is set on the "unix user" 
terminal from where the reveleusstartup.sh file is invoked.

•      Ensure the .profile where the environment/ path settings are made has 
been executed successfully.

What happens when the OFSAAI Application Server does not proceed even after 
providing the system password?

Ensure that, the System Password provided when prompted should match with 
the "Oracle Configuration password" provided during installation. Also check 
whether the connection to the "configuration schema" can be established through 
sqlplus.

Although the OFSAAI installation has completed successfully, when OFSAAI servers 
are started, and the application URL is accessed, it gives an error message "the page 
cannot be found or displayed" or "Could not retrieve list of languages from Server. 
Please contact the system administrator". What should I do?

Ensure OFSAAI servers have been started and are running successfully. On the 
server start up parameters options, see Starting Infrastructure Services section.

For more details on the issue, refer on to the Revappserver log in $FIC_APP_ 
HOME/common/FICServer/logs directory or the Web Server log files.

Is it necessary to provide the specified grants to the Oracle schema user before 
installation? If yes, can it be revoked after completion of installation?
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The "Oracle schema" user requires the necessary grants specified before, during, 
and after the installation process. Grants provided should never be revoked as the 
application makes use of these grants all the time.

Can I have distributed OFSAAI Application Server for load balancing?

OFSAAI Application server can be scaled out/distributed across different JVM's 
(machines) based on the various services and Information Domains, in other 
words, Load balancing could be achieved with distribution of services.

Why do I need Ftpshare? Why is it needed on all the layers? Can I have ftpshare on 
another machine other than the machines where OFSAAI is installed?

Ftpshare is a Metadata Repository directory. All the metadata related files used in 
Infrastructure are stored in the ftpshare directory. The ftpshare contains folders for 
each Information Domain, with each Information Domain folders holding Erwin, 
log, and scripts folder. The transfer of data among the Web, Application, and 
Database servers in Infrastructure takes place through FTP/SFTP.

You need to configure FTP/SFTP and enable communication between the servers 
by providing App server's FTP/SFTP credentials to the Web server and DB server 
users.

Yes, we can have ftpshare on another machine other than the machines where 
OFSAAI is installed.

Is it mandatory to provide the ftp/sftp password? 

Yes, OFSAAI needs credentials of the user which has complete permissions on 
ftpshare directory, and should be able to independently login to the unix server.

What are the permissions required for ftpshare and when should I give them?

It is recommended to provide  permissions on ftpshare in case of  installations 
done across different machines or VMs (multitier installation ).

In case of single tier installation, 770 permissions can be provided if the unix users 
of OFSAAI and web server belong to the same unix group.

And on any new file that is created in the 'ftpshare' folder of any installation layer 
should be granted specific/explicit permission.

Port Change utility could be used to have the Port number modified, which are 
currently being used by the Infrastructure application. For more information, refer  
Changing IP/ Hostname, Ports, Deployed Paths of the OFSAA Instancesection.

Are there any in-built system administration users within OFSAAI Application?

The three in-built system administration users are provided to configure and setup 
OFSAAI.

•      SYSADMN 

•      SYSAUTH

•      GUEST 

Does OFSAAI Application support both FTP and SFTP?

OFSAAI supports both FTP and SFTP configuration.

Is it necessary to enable the FTP/SFTP services to use the OFSAAI?

Yes, enabling of FTP/SFTP services and its ports is a pre-requisite step towards 
using the OFSAAI.

OFSAAI Configuration: Unable to save the server details?
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•      Ensure the input User ID, Password, and Share Name are correct.

•      Ensure FTP/SFTP services are enabled.

•      Have a test FTP/SFTP connection made and confirm if they are successful.

During Information Domain creation, the message "Please create a database and then 
create the information domain" appears. What should be done?

Information Domain is mapped to only one Database; and thus before the creation 
of Information Domain, at least one database details would need to exist.

The message "ConnectToDatabase: FatalError, could not connect to the DB server" 
appears during startup of backend engine message server. What do I need to do?

•      Verify whether connection to the "configuration schema" can be established 
through sqlplus.

•      Verify "configuration schema" password is modified post installation.

•      Ensure oracle database alias name created for oracle instance and oracle 
service name are same.

•      On a multi tier Installation mode, ensure TNSNAME and SID are the same in 
both the Application and Database Layers.

The message "Fatal Error, failed to get user ID from LibSmsConnect" appears during 
the startup of backend engine message server. What has to be done?

Ensure Reveleus.sec file exist under the $FIC_HOME/conf directory where the 
Database components are installed.

Does OFSAAI Application support LDAP authentication?

OFSAAI supports LDAP configuration and authentication.

Does OFSAAI support multiple languages?

Yes, OFSAAI supports multiple languages.

Does OFSAAI provide any data back-up features?

OFSAAI does not have built-in back up facility. External Storage Infrastructure is 
recommended for back-up.

What kind of security features does the OFSAAI provides?

OFSAAI provides security at:

•      Segment Level - Users can access only the segment they are mapped to.

•      Application Level - Users can perform an operation only if mapped to 
appropriate role and functions.

Does OFSAAI have the ability to enforce periodic password change?

OFSAAI provides configurable parameters to define number of days after which 
the user password would expire and then the user is forced to change the 
password after expiration period.

What is the password policy followed in OFSAAI?

OFSAAI enforces a minimum password length with a combination of Upper and 
Lower case characters and alpha-numeric strings.

Which version of Erwin Data Modeller does OFSAAI support?

OFSAAI now supports ERwin version 9.2 and 9.5 generated xmls in addition to 
ERwin 4.1, ERwin 7.1, ERwin 7.3 and ERwin 9.0 formats.
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Does OFSAAI provide the mechanism to upload Business Data model?

OFSAAI provides two mechanisms for business data model upload:

•      Easy to use GUI based Model upload mechanism to upload the Business Data 
Model through Unified Metadata Manager --> Import Model.

•      OFSAAI also provides a model upload utility "upload.sh" for uploading the 
business data model through the command line parameter by executing this 
shell script file under the path <FIC_HOME>/ficapp/common/FICServer/bin.

Refer the section Run Model Upload Utilityof the OTN for details. 

The Business Data model undergoes changes; how does this incremental change get 
applied to the existing model?

Modified data model can be uploaded into the system and OFSAAI has the ability 
to compare the changes within the data model with respect to the one already 
present in the system and enables propagation of incremental changes in a 
consistent manner.

What are the different types of uploading a business data Model? 

OFSAAI supports uploading of business data model from client desktop and also 
by picking up the data model from the server location.

Can the OFSAAI "Configuration Schema" password be modified post installation?

The OFSAAI "configuration schema" password can be modified post installation. 
OFSAAI application stores the password in the database and few configuration 
files, thus any changes to the "configuration schema" password would necessitate 
updating in these. Contact OFSAAI support for more details.

Can the OFSAAI "Atomic  Schema" password be modified?

The OFSAAI "Atomic Schema" password can be modified. OFSAAI application 
stores the atomic schema password in the database and few configuration files , 
thus any change to the atomic schema password would necessitate updating the 
password.

To change the Atomic Schema password, follow the steps:

1. Login to OFSAA.

2. Navigate to System Configuration > Database Details window. Select the 
appropriate connection, provide the modified password and save.

3. Navigate to Unified Metadata Manager > Technical Metadata> Data Integrator 
> Define Sources window. Update the appropriate Source details.

a. If you are using Apache Tomcat as Web server:

* Update the <Context> -> Resource tag details in server.xml file from the 
$CATALINA_HOME/conf folder. (In case of Tomcat only Atomic <Resource> 
will exist).

b. If you are using WebSphere as Web server:

* Login to the WebSphere Administration Console from the left side menu.

* Navigate to Resources >JDBC >Data Sources. A list of data sources will be 
populated on the right side.

* Select the appropriate Data Source and edit the connection details. (In this 
case, both Config and Atomic data sources need to be modified).

c. If you are using WebLogic as Web server:

http://docs.oracle.com/cd/E60058_01/homepage.htm
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* Login to the WebLogic Administration Console from the left side menu.

* Under Domain Structure list box, expand the appropriate Domain and 
navigate to Services > JDBC >Data Sources. A list of data sources will be 
populated on the right side.

* Select the appropriate Data Source and edit the connection details. (In this 
case, both Config and Atomic data sources need to be modified).

4. Restart the OFSAAI services

Note: If the modified passwords are not updated, OFSAAI logs 
displays the message ORA-28000: the account is locked.

 Does the upload of Business Data model depend on Java Memory?

Business data model upload through OFSAAI depends on the Java memory 
settings on the client and server machines. Java memory setting varies with the 
data model size and the available RAM. Contact OFSAAI support for more details.

Why do the Business Metadata Management screens (Business Processors screen) in 
User Interface, takes longer time to load?

The Log file in DynamicServices.xml which resides in $FIC_HOME/conf is 
continuously being updated/refreshed to cache metadata. This can be observed 
when you are starting reveleusstartup.sh and if any of the log file (Ex: 
SMSService.log) in DynamicServices.xml is being continuously refreshed for 
longer time.

By default, the Metadata Log file cache size is set to 1000. If in case the log is being 
updated beyond this limit, retrospectively the preceding entries are overwritten. 
For example, the 1001th entry is overwritten by deleting the first entry. This results 
in the application screen taking a longer time to load.

Increase the cache size limit in Dynamicservices.xml located at <FIC_HOME>/conf, 
depending on the currently logged count for the specific metadata.

1. Generate the Log report by executing the below query in config schema.

select count(1), t.metadata_name, m.dsn_id

from metadata_master m, metadata_type_master t 

where m.metadata_type = t.metadata_type

group by t.metadata_name, m.dsn_id

2. The above query returns a list of codes with their respective metadata count. 
You can refer to "metadata_type_master" table to identify the metadata name.

3. View the log report to identify the metadata which is being updated/refreshed 
beyond the specified cache size limit. Accordingly increase the cache size limit 
in Dynamicservices.xml depending on the currently logged count for the 
specific metadata.

For example, if the "MEASURE_CACHE_SIZE" is set to 1000 and total 
measure reported in log is 1022, increase the limit to 2000 (approximately).

4. Restart Reveleus/OFSAAI servers (Web and APP) and check the issue.

What should I do if I get OutOfMemoryError while deploying EAR file in WebSphere 
application server?
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The Java memory needs to be increased in ejbdeploy.sh file which is present 
under <WebSphere Install directory>/AppServer/deploytool/itp. For 
example, 

$JAVA_CMD \

-Xbootclasspath/a:$ejbd_bootpath \ 

Xms256m -Xmx1024m \

What configurations should I ensure if my data model size is greater than 2GB?

In order to upload data model of size greater than 2GB in OFSAAI Unified 
Metadata Manager- Import Model, you need to configure the required model size 
in struts.xml file available in the path $FIC_WEB_
HOME/webroot/WEB-INF/classes.

Note: The size requirements have to be always specified in bytes.

For example, if you need to configure for model size of 2.5GB, then you can 
approximately set the max size to 3GB (3221225472 bytes) as indicated below, in 
order to avoid size constraints during model upload.

<constant name="struts.multipart.maxSize" value="3221225472"/>

After configuring struts.xml file, generate the application EAR/WAR file and 
redeploy the application onto your configured web application server. For more 
information on generating and deploying EAR / WAR file, see Configuring Web 
Application Servers.

What should I do if my Hierarchy filter is not reflecting correctly after I make changes 
to the underlying Hierarchy?

In some cases, the Hierarchy Filters do not save the edits correctly if the 
underlying Hierarchy has been changed. This can occur in hierarchy maintenance, 
where you have moved a member to another hierarchy branch, and that member 
was explicitly selected in the Filter and is now a child of a node which is already 
selected in the Filter.

Please refer to Support Note for the workaround.

How do I turn off unused information domains (infodoms) from cache?

Follow the below steps to turn off unused infodoms from cache:

Navigate to $FIC_HOME/conf in the APP layer of your OFSAAI installation. 

1. In the DynamicServices.xml file, identify the section for <Service code="20">. 

2. Modify the value of parameter CACHE_ON_STARTUP to 0 (default is 1). 

3. Repeat the same in the WEB layer too. Generate the application EAR/WAR 
file and redeploy the application onto your configured web application server. 
For more information on generating and deploying EAR / WAR file, see 
Configuring Web Application Servers.

4. Restart the OFSAAI Services (APP and WEB). For more information, see 
Chapter 6, "Start and Stop of Infrastructure Services".

https://mosemp.us.oracle.com/epmos/faces/DocumentDisplay?id=1586342.1
https://support.oracle.com/epmos/faces/DocumentDisplay?_afrLoop=448098703264718&id=1586342.1&_afrWindowMode=0&_adf.ctrl-state=154byl0wqm_4
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Sample code is pasted below: 

<SERVICE CODE="20" 

CLASS="com.iflex.fic.metadata.services.MetadataServiceProvider" 
NAME="BMD" 

SERVERID="DEFAULT" PATH=" " LOGGERNAME="UMMLOGGER" LOGGERLEVEL="10"> 

<PARAMETERS> 

<PARAMETER NAME="CACHE_ON_STARTUP" VALUE="0" /> 

<PARAMETER NAME="BACKUP_XML" VALUE="1" /> 

<PARAMETER NAME="MAX_BACKUP_XML" VALUE="2" /> 

<PARAMETER NAME="PC_NONBI_BI_SWITCH" VALUE="2048" /> 

<PARAMETER NAME="HIERARCHY_NODE_LIMIT" VALUE="2000" /> 

<PARAMETER NAME="ALIAS_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="DATASET_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="MEASURE_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="HIERARCHY_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="DIMENSION_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="HIERARCHYATTRIBUTE_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="CUBE_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="RDM_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="BUSINESSPROCESSOR_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="DERIVEDENTITY_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="LOG_GET_METADATA" VALUE="false" /> 

<PARAMETER NAME="METADATA_PARALLEL_CACHING" VALUE="0" /> 

</PARAMETERS> 

</SERVICE>

Can I install an Application Pack on an existing Atomic schema/ Information 
Domain created manually?

No, you cannot install an Application Pack on existing Atomic schema/Information 
Domain created manually. Application Packs can be installed only on Atomic 
Schemas/Information Domain created using schema creator utility and/ or the 
Application Pack installer.

When trying to view the model outputs in Model Outputs screen, I get "Exception 
->Local Path/STAGE/Output file name (No such file or directory)".

Ensure you have created a folder "STAGE" under the path mentioned as "Local Path" 
in the web server details screen. This folder needs to be created under the local path on 
every node ,in case of web application server clustering.
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During OFSAA services startup, I get Exception in thread "main" 
java.lang.UnsatisfiedLinkError: net (Not a directory)?

Ensure the JRE referred in .profile is not a symbolic link. Correct the path reference to 
point to a physical JRE installed.

What is the optimized memory settings required for "New" model upload?

The following table lists the optimized memory settings required for "New" model 
upload.

Table J–2 Optimized Memory Settings for New Model Upload

Model Upload Options
Size of Data Model 
XML File

X_ARGS_APP ENV 
Variable in OFSAAI 
APP Layer

Pick from Server 106 MB "-Xms1024m 
-Xmx1024m

36 MB "-Xms2048m 
-Xmx2048m

815 MB "-Xms4096m 
-Xmx4096m

1243 MB "-Xms6144m 
-Xmx6144m

Model Upload Utility 106 MB "-Xms1024m 
-Xmx1024m"-Xms2048
m -Xmx2048m

336 MB "-Xms4096m 
-Xmx4096m

815 MB "-Xms4096m 
-Xmx4096m

1243 MB "-Xms6144m 
-Xmx6144m

Save New Erwin File In 
Server

106 MB "-Xms1024m 
-Xmx1024m

336 MB "-Xms2048m 
-Xmx2048m

"-Xms4096m 
-Xmx4096m

"-Xms6144m 
-Xmx6144m

What is the resolution if I get the error - ORA 01792 maximum number of columns in a 
table or view is 1000 during T2T execution?

You should apply the below patch set from Oracle. Applicable only for 12c.

https://support.oracle.com/epmos/faces/DocumentDisplay?id=1937782.1 

I did not enable OFS Inline Processing Engine Application license during the 
installation. However, I have enabled it post installation, using the Manage OFSAA 
Product License(s) in the Admin UI. Are there any other additional configurations 
that I need to do?

Yes. Follow the instructions explained in the OFS Inline Processing Engine Configuration 
Guide.

https://support.oracle.com/epmos/faces/DocumentDisplay?id=1937782.1
http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
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I get an error when I try to build an Oracle OLAP cube. What should I do? 

Execute the below grant on the appropriate ATOMIC schema  
grant olap_user to &database_username

How do I turn off unused Information Domains (Infodoms) from caching?

Follow these steps to turn off unused infodoms from caching:

1. Navigate to $FIC_HOME/conf in the APP layer of your OFSAAI installation.

2.  In the DynamicServices.xml file, identify the section for <Service code="20">. 

3. Modify the value of parameter CACHE_ON_STARTUP to 0 (default is 1). 

4. Repeat the same in the WEB layer too. Generate the application EAR/WAR file 
and redeploy the application onto your configured web application server. For 
more information on generating and deploying EAR / WAR file, refer to the Post 
Installation Configuration section.

5. Restart the OFSAAI Services (APP and WEB). For more information, refer to the 
Starting Infrastructure Services section.

Note: This setting will cache the Infodom metadata only for the 
infodoms that get accessed upon user login. Infodoms which do not 
get accessed, will not be cached. 

Sample code is pasted below: 

<SERVICE CODE="20" 

CLASS="com.iflex.fic.metadata.services.MetadataServiceProvider" NAME="BMD" 

SERVERID="DEFAULT" PATH=" " LOGGERNAME="UMMLOGGER" LOGGERLEVEL="10"> 

<PARAMETERS> 

<PARAMETER NAME="CACHE_ON_STARTUP" VALUE="0" /> 

<PARAMETER NAME="BACKUP_XML" VALUE="1" /> 

<PARAMETER NAME="MAX_BACKUP_XML" VALUE="2" /> 

<PARAMETER NAME="PC_NONBI_BI_SWITCH" VALUE="2048" /> 

<PARAMETER NAME="HIERARCHY_NODE_LIMIT" VALUE="2000" /> 

<PARAMETER NAME="ALIAS_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="DATASET_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="MEASURE_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="HIERARCHY_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="DIMENSION_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="HIERARCHYATTRIBUTE_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="CUBE_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="RDM_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="BUSINESSPROCESSOR_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="DERIVEDENTITY_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="LOG_GET_METADATA" VALUE="false" /> 
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<PARAMETER NAME="METADATA_PARALLEL_CACHING" VALUE="0" /> 

</PARAMETERS> 

</SERVICE>

"While creating an Excel Mapping, after specifying the excel worksheet, the target 
table, and mapping each column in the worksheet to a target table, I click SAVE and 
nothing happens. But when I click CANCEL, a message pops up informing me that all 
changes will be discarded", what is to be done.

Check if the excel mapping creation is done using I.E 8 with JRE 1.4 plug in enabled on 
machine. If so, upgrade the JRE plug in to 1.7+.

Can Multiple OFSAA Infrastructure instances share the same config schema?

No, only one OFSAA environment can be installed using one config schema.

Can Atomic schema be shared?

Yes, it can be shared between two OFSAA instances.

While setting a firewall, which ports should be opened for communication between 
the Web Server (Apache HTTP Server/ Oracle HTTP Server/ IBM HTTP Server) and 
the Web Application Server (WebSphere/ WebLogic/ Tomcat) for OFSAAI to operate 
properly?

The OFSAA Servlet port which is same as Web server port should be open. Also the 
web application port should be open.

Can I modify the NLS_LENGTH_SEMANTICS to BYTE from CHAR for the 
Database where older versions of OFSAA is Installed?

Yes, NLS_LENGTH_SEMANTICS can be modified to BYTE from CHAR if you are not 
intending to use multi language support.

Can I install already installed application in a different infodom?

How can I configure the OFSAA application for High Availability?

OFSAA can have active-passive high availability. For more details, refer Configuration 
for High Availability- Best Practices Guide.

During OFSAA installation should I provide web application server's IP /Hostname 
and port or web server's IP/Hostname and port, if the Apache HTTP Server/ Oracle 
HTTP Server/ IBM HTTP Server are configured?

In case the web server is configured, you should enter the Web Server IP 
Address/Hostname and Port details during OFSAA installation. Here the Servlet port 
should be same as the Web Server port.

If Web Server is not configured, the Web Application Server's IP Address/ Hostname 
and Port is required during the installation process. Here the Servlet port should be 
same as the Web application Server port.

Is "ReveleusAdminConsoleAgent" applicable for OFSAAI 8.0.0.0.0 and higher 
versions?

No, ReveleusAdminConsoleAgent is not applicable starting OFSAAI 7.3.3.0.0. There is a 
change in the way agentservers are managed through AGENTSTARTUP.SH & 
AGENTSHUTDOWN.SH.

What should I do when the message server process does not open and I get the 
following error message, "CI18NProvider::CI18NProvider, Error, unable to connect 
to the config database"?

http://docs.oracle.com/cd/E61555_01/books/Configuration%20for%20High%20Availability%20%28HA%29%20Best%20Practices%20Guide.pdf
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This error is displayed due to the following reasons:

•      The Config Schema password is already expired.

•      If the config schema password is going to expire soon and the message like 
"ORA-28002: the password will expire within 6 days" displays while connecting to 
config schema through sqlplus.

•      The Config schema password is Modified.

To resolve the error, re-set the config schema password to the old password. Else, if the 
config schema password is modified to something else then follow the below steps:

1. Delete the $FIC_HOME/conf/Reveleus.SEC file.

2. Shutdown the OFSAAI App service: cd $FIC_APP_HOME/common/FICServer/bin 
./stopofsaai.sh

3. Shutdown the OFSAAI App service: cd $FIC_APP_HOME/common/FICServer/bin 
./stopofsaai.sh

4. Start the Infrastructure Server in foreground directly on the server or through 
XWindows software using the command: ./startofsaai.sh

5. Enter System Password.

6. Enter the new Config schema password. The service starts and initializes if it is 
able to successfully connect to the DB and generates the Reveleus.SEC file.

7. Post successful startup of the service, if required, the Infrastructure server may be 
shut down and restarted in the background using nohup mode.

What is the mechanism of Log File sizing and backup?

OFSAAI Log files created under $FIC_APP_HOME/common/FICServer/logs & <OFSAAI_
DEPLOYED_AREA>/<CONTEXT.war>/logs is configurable in RevLog4jConfig.xml.

The default size of the log files (MaxFileSize) is set to max 5000kb & number of max 
backup log files (MaxBackupIndex) retained is set to 5, both of which are configurable. 
Increasing these parameters to a higher value should depend on the server HW 
configurations and may reduce the performance.

To configure the Logs file size on OFSAA Application server, follow these steps:

1. Navigate to $FIC_HOME/conf where OFSAA is installed.

2. Edit the following parameters in the file RevLog4jConfig.xml

•      <param name="file" : Enter the path where the Logs are to be generated.

•      <param name="MaxFileSize" : Provide the required file size.

•      <param name="MaxBackupIndex" : Provide the required number of backup 
files to be created.

Example:

<appender name="REVSERVERAPPENDER" 
class="org.apache.log4j.RollingFileAppender">

<param name="file" value="$FIC_
HOME/ficapp/common/FICServer/logs/RevAppserver.log"/>

<param name="Append" value="true" />

<param name="MaxFileSize" value="5000kb" />

<param name="MaxBackupIndex" value="5" />
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<layout class="org.apache.log4j.PatternLayout">

<param name="ConversionPattern" value="[REVELEUSLOG] %m%n"/>

</layout>

</appender>

To configure the Deployed area logs file, follow these steps:

1. Navigate to <EAR/WAR Deploy area>/conf folder.

2. Repeat step 2 from the above section.

Can we modify the Log file path?

Yes, Log file path is configurable, it can be configured in RevLog4jConfig.xml.default 
log file path (file) is set by the installer . This can be configured to another path.

Can I point the environment with HTTP enabled to HTTPS after installation and 
vice versa?

Follow these steps:

1. Create SSL related certificates and import to respective servers.

2. Enable SSL on a desired Port ( example 9443 ) on your existing and already 
deployed web application servers.

3. Replace the protocol as https and new ssl port (FIC_SERVLET_PORT) configured 
and in all the URLs specified on below files:

•      $FIC_HOME/ficapp/common/FICServer/conf/FICWeb.cfg and $FIC_
HOME/ficweb/webroot/conf/FICWeb.cfg

•      $FIC_HOME/ficapp/icc/conf/WSMREService.properties

•      $FIC_HOME/ficweb/webroot/conf/ModelExecution.properties

•      $FIC_HOME/ficdb/conf/MDBPublishExecution.properties

•      $FIC_HOME/ficdb/conf/ObjAppMap.properties

•      $FIC_HOME/utility/Migration/conf/WSMigration.properties

•      $FIC_HOME/utility/WSExecution/conf/WSExecution.properties

•      $FIC_
HOME/EXEWebService/WebSphere/ROOT/WEB-INF/wsdl/EXEWebServiceImpl.ws
dl

•      $FIC_
HOME/EXEWebService/Tomcat/ROOT/WEB-INF/wsdl/EXEWebServiceImpl.wsdl

•      $FIC_
HOME/EXEWebService/weblogic/ROOT/WEB-INF/wsdl/EXEWebServiceImpl.wsd
l

4. Replace XML attribute/Node values as specified on below files:

•      $FIC_HOME/ficweb/webroot/WEB-INF/web.xml

FIC_WEBSERVER_PORT=9443

•      FIC_WEBPROTOCOL=https

$FIC_HOME/conf/LookUpServices.xml and $FIC_
HOME/ficweb/webroot/conf/LookUpServices.xml

PORT="9443"   PROTOCOL="https:"
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5. Login to config schema and execute below SQL command to replace protocol and 
SSL port.

SQL> update configuration cn set cn.paramvalue='9443' where 
cn.paramname='SERVLET_ENGINE_PORT';

SQL> update configuration cn set 
cn.paramvalue=replace(cn.paramvalue,'http:','https:') where 
cn.paramname='FormsManagerCacheReload';

SQL> update web_server_info ws set 
ws.servletport='9443',ws.servletprotocol='https';

6. Create EAR/WAR file and Re-Deploy.

What should I do if the sliced data model upload takes a long time to complete?

If the metadata cache size is set to a lower value than the actual count of each 
metadata type ( hierarchy, dataset, dimension etc), then it gets into performance 
degrade issues. We have to increase the cache size for each metadata type according to 
the count in the environment.

Following are the parameters in DynamicServices.xml to be configured depends on 
the metadata count in your environment.

<PARAMETER NAME="HIERARCHY_NODE_LIMIT" VALUE="2000"/>

<PARAMETER NAME="ALIAS_CACHE_SIZE" VALUE="1000"/>

<PARAMETER NAME="DATASET_CACHE_SIZE" VALUE="2000"/>

<PARAMETER NAME="MEASURE_CACHE_SIZE" VALUE="3000"/>

<PARAMETER NAME="HIERARCHY_CACHE_SIZE" VALUE="2000"/>

<PARAMETER NAME="DIMENSION_CACHE_SIZE" VALUE="2000"/>

<PARAMETER NAME="CUBE_CACHE_SIZE" VALUE="1000"/>

<PARAMETER NAME="BUSINESSPROCESSOR_CACHE_SIZE" VALUE="2000"/>

<PARAMETER NAME="DERIVEDENTITY_CACHE_SIZE" VALUE="1000"/>

Metadata count can be derived based on the following queries:

select count(1) from metadata_master where metadata_version=0 --- for all 
metadata

select count(1) from metadata_master where metadata_version=0 and 
metadata_type=1 --- for measure

select count(1) from metadata_master where metadata_version=0 and 
metadata_type=2 --- for Dimension

select count(1) from metadata_master where metadata_version=0 and 
metadata_type=3 --- for HCY

select count(1) from metadata_master where metadata_version=0 and 
metadata_type=4 --- for DATASET

select count(1) from metadata_master where metadata_version=0 and 
metadata_type=59 --- for BP's

select count(1) from metadata_master where metadata_version=0 and 
metadata_type=54 --- for Alias

select count(1) from metadata_master where metadata_version=0 and 
metadata_type=5 --- for CUBES
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select count(1) from metadata_master where metadata_version=0 and 
metadata_type=856 --- for Derived Entity

For LDAP authentication , which server connects with the LDAP server, the 
Application server (where ofsaai is installed), or Web Application server (where 
EAR is deployed)?

For LDAP authentication, the Application server (ficapp) connects with the LDAP 
server.

The LDAP server in the setup listens on secure protocol ldaps ( port 636). I have the 
root certificate of the LDAP server for SSL, and would like to know where to 
offload this certificate?

You need to import the certificate into the JDK/JVM used by Reveleus server in ficapp 
layer.

How to relocate FTPSHARE folder?

You can run the PortC.jar utility. For more details, refer Changing IP/ Hostname, 
Ports, Deployed Paths of the OFSAA Instance section in the OFSAAI Admin Guide 
available on OTN.

How do we identify the list of ports that are used by/configured in an OFSAA 
environment?

1. Navigate to $FIC_HOME folder on Target.

2. Run the PortC.jar utitlity using the command:

java -jarPortC.jar DMP

A file with the name DefaultPorts.properties will be created under $FIC_HOME 
directory which will contain the ports. For more information, refer Changing IP/ 
Hostname, Ports, Deployed Paths of the OFSAA Instance section in the OFSAAI 
Admin Guide available on OTN.

What should I do if I get the following error message, "Error while fetching open 
cursor value Status : FAIL"?

This error occurs while executing envCheck.sh because the user does not have 
access to V$parameter. This error does not occur due to sysdba or non sysdba 
privileges provided they have access/grants to V$parameter.

What should I do when an entity containing many attributes (>100 columns) is 
selected as Source entity and the Data Mapping (T2T definition) save operation 
takes longer than expected with the hourglass in the UI continuously rotating?

In such cases, the user might falsely assume that T2T definition save has failed. 
The reason for this occurrence is that the FilerServlet has taken considerable 
amount of time to validate the xml data that was passed. If we skip validation in 
excludeURLList.cfg, there will be no latency in Data Mapping save operation. To 
rectify this, follow these steps:

1. Locate the webserver deployed area webroot/conf/excludeURLList.cfg file.

2. Modify the following entries:

•      [SQLIA]./dataIntegrator/ to [ALL]./dataIntegrator/

•      [SQLIA]./ETLExtractionServlet to [ALL]./ETLExtractionServlet

3. Save the changes and restart the webserver.

4. Resave the definition.

http://docs.oracle.com/cd/E60058_01/homepage.htm
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Application Pack 8.0.0.0.0 FAQs
What is an Application pack?

An Application Pack is suite of products. For more information, refer About Oracle 
Financial Services Analytical Applications (OFSAA).

Can I get a standalone installer for OFSAAI 8.0?

No. AAI is part of every application pack and installs automatically.

How does OFSAA 8.0 Application pack relate to OFSAA 7.x series?

8.0 is a new major release consolidating all products from OFSAA product suite.

Can existing OFSAA 7.x customers upgrade to OFSAA 8.0 Application Pack? 

There is no upgrade path available. However, we will have migration kit / path for 
every product to 8.0 application pack. Further details will be available with Oracle 
Support.

Does OFSAA 8.0 Application pack UPGRADE's automatically existing 
environments?

No.  Refer Point 5.  OFSAA 8.0 application pack has to be installed in an new 
environment and subsequently migration path / migration kit needs to be run to 
migrate from 7.x to 8.0.  Please note we will have migration path only from the 
previously released version of OFSAA products.

Where can I download OFSAA 8.0 Application Pack?

You can download the OFSAAI 8.0 Application Pack from Oracle Software Delivery 
Cloud (OSDC).

What are the minimum system and software requirements for OFSAA 8.0 Application 
Pack?

Refer installation guide section Hardware and Software Requirements section.

Is my environment compatible with OFSAA 8.0 Application Pack? 

Environment Check utility performs the task.  It is part of install and can also be run 
separately.

Has OFSAA 8.0 Application Pack is supports all Operating systems?

LINUX, AIX, SOLARIS 10, 11. Refer to Technology Matrix for the technology matrix 
that OFSAA suite products are/ will be qualified on.

How can I install OFSAA 8.0 Application Pack?

Refer to Oracle Financial Services Advanced Analytical Infrastructure Installation And 
Configuration Guide published in OTN for the application pack installers.

Does this installation require any Third party Software's? 

Oracle Financial Services Advanced Analytical Infrastructure Installation And 
Configuration Guide published in OTN lists the third party software that needs to be 
installed.

What languages are supported during OFSAA 8.0 Application Pack installation?

US English is the language supported.

What mode of installations OFSAA Application Pack supports? [i.e., Silent , GUI]

OFSAA Application Packs supports both, GUI and Silent Mode.

Does OFSAA 8.0 Application Pack support Multi tier Installations?

http://docs.oracle.com/cd/E55339_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
https://edelivery.oracle.com/osdc/faces/Home.jspx?_afrLoop=1035460249148828&_afrWindowMode=0&_adf.ctrl-state=cibegvl3s_4


Frequently Asked Questions

                       Appendix J-153

OFSAA 8.0 does single tier installation. For more information refer to OFSAAI FAQs 
section.

Does this Application Pack validate all Pre-requisites required for this installation 
i.e., Memory, Disk Space etc.?

Yes.  The pre-requisite checks are done by the respective application pack installer.  

What happens if it aborts during installation of any application with in Application 
pack?

Customer needs to restore the system and retrigger the installation

Does this Application pack 'Rolls Back' if any of application installation fails due to 
errors?

Rollback of installation is not supported.

Does the Application pack installs all applications bundled?

All application pack system files are installed but there is an option to enable the 
licensed products.

Can I re-install any of the Application Packs?

You can retrigger in case of failure.

Does Application pack allow enabling / disabling any of the applications installed?

Yes.  You cannot disable once the product is enabled in an environment.

I have installed one application in a Application pack and can I install any of new 
applications within the Application pack later point of time?

No, installation is not required.  Enabling the application is an option to use it later.

How many OFSAA Infrastructures can be installed in a single server?

There is no issue in installing separate OFSAAI installations, each with their own 
PFT/FTP installations and separate associated database instances and separate Web 
Server installations on the same server as long as adequate memory is allocated for 
each instance and as long as each OFSAAI installation is installed using a separate 
UNIX user and profile. Care should be taken if running multiple OFSAAI installations 
on a single server. Adequate memory will be required for each installation as several 
OFSAAI processes (model upload, DEFQ services, etc) take significant amounts of 
memory. So it depends on your server memory.

Is it possible to Install OFSAA 8.0 Application pack on any one of the existing 
'Infodom' where another  OFSAA 8.0 application is installed?

Yes.  But Behavioral Detection Pack and Compliance Regulatory Reporting pack are 
the exceptions.  They need to be installed in a different INFODOM.

Can I select an Infodom in Application pack during installation?

Yes. You can select or change the required infodom. 

Can I install all Application Packs in a 'Single Infodom'?

Yes.  But Behavioural Detection Pack and Compliance Regulatory Reporting Pack are 
the exceptions. They need to be installed in a different INFODOM.

Is it possible to install applications on different Infodom within the Application 
pack? (That is if you want to install LRM & MR in two infodoms)

Applications within application pack have to be installed in the same information 
domain in the same environment.
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How many Infodoms can be created over a single OFSAA Infrastructure of 8.0.1.0.0? 
Frequently Asked Questions

You can install only one infodom during installation. But after installation, you can 
create multiple infodoms.

Is the 'Data Model' bundled specific to an Application pack or to an individual 
application?

A merged data model for all applications within the application pack is bundled and 
uploaded.

Is it possible to install OFS Enterprise Modeling later?

OFS Enterprise Modeling is a separate product and can be enabled as an option later 
from any application pack that bundles Enterprise Modeling.

Does the Application pack create sandbox automatically for the required 
applications?

Yes, Sandbox creation is part of application install process.

Are upgrade Kits available for individual applications or the complete Application 
Pack?

Maintenance Level (ML) Release / Minor Release upgrades are available across all 
applications.

Can I upgrade AAI only?

Yes, you can upgrade AAI alone.

Can I upgrade one application within the Application Pack? i.e., LRM will be 
upgraded in Treasury Application pack, but MR won't be upgraded.

No. Not possible Upgrade is applied across packs.

Is it possible to uninstall any Application from the Application pack?

No, it is not possible to uninstall any Application from the Application Pack.

Can I uninstall entire Application Pack?

No, you cannot uninstall the Application Pack.

Is it possible to uninstall only application and retain AAI in the installed 
environment?

No, you cannot uninstall only the application and retain AAI in the installed 
environment.

Does Application Pack contain all Language Packs supported?

Language Packs need to be installed on 8.0 application packs.

Can I install an Application Pack over another Application Pack (that is same 
infodom or different infodom)?

Yes, you can install an Application Pack over another Application Pack in the same 
information domain or different information domain. But Behavioural Detection 
Application Pack and Compliance Regulatory Reporting Application Pack, Asset 
Liability Management Application Pack and Profitability Application Pack are the 
exceptions. They need to be installed in a different INFODOM.

Can I use an existing manually created schema as information domain for application 
pack installation?
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No. Schemas required by OFSAA applications have to be created using Schema 
Creator Utility.

Does OFSAA 8.0 support on WebLogic 10.3.6 with Oracle 12c?

Yes, OFSAA 8.0 will support on WebLogic 10.3.6 with Oracle 12c. WebLogic 10.3.6 
supports oracle 12c with some additional configurations. Refer the link 
http://docs.oracle.com/cd/E28280_01/web.1111/e13737/ds_
12cdriver.htm#JDBCA655 for additional configurations.

While running the schema creator utility, I get an error "HostName in input xml is not 
matching with the local hostname"?

 One possible reason could be the machine is configured for zonal partitioning. Ensure 
all the known IP Addresses of the machine are present in the /etc/hosts file.

What are the Java versions supported in OFS CA Application Pack version 8.0.0.0.0?

OFS CA Application Pack supports Java 1.8.x.

Is this release of the OFS CA Application Pack version 8.0.0.0.0 supported on Java 8? 

Yes. To install this release of the OFS CA Application Pack version  8.0.0.0.0 on Java 8. 
For more information, refer to specific notes mentioned in the sections  Prerequisite 
InformationConfigurations supported for Java 8, Configuring the Schema Creator 
Utility,  GUI Mode Installation, GUI Mode Installation.

Forms Framework FAQs
What should I do when I have large volume of data to be exported?

It is recommended to use BIP reports or OBIEE reports if you have to export large 
volume of data

How do I export the columns added to the grid by Field Chooser option?

Perform Grid Export operation to export the columns added to the grid by Field  
Chooser option

Error Dictionary
This contents of this section has been created with the interest to help you resolve the 
installation issues if any. There is a compilation of all the possible errors that might 
arise during the installation process with the possible cause and the resolution to 
quickly fix the issue and proceed further with the installation.

Accessing Error Dictionary
Instead of scrolling through the document to find the error code, you can use the pdf 
search functionality. In the "Find" dialog available in any of the Adobe Acrobat version 
that you are using to view the pdf document, follow the below instructions to quickly 
find the error resolution.

1. With the Installation pdf open, press Ctrl+F or select Edit > Find.

2. The Find dialog is displayed as indicated.

3. Enter the error code that is displayed on screen during Infrastructure installation.

4. Press Enter. The search results are displayed and highlighted as indicated below.

http://docs.oracle.com/cd/E28280_01/web.1111/e13737/ds_12cdriver.htm#JDBCA655 for additional configurations
http://docs.oracle.com/cd/E28280_01/web.1111/e13737/ds_12cdriver.htm#JDBCA655 for additional configurations
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Figure 8–61 Error Dictionary

View the details of the issues, its cause, and resolution specific to the error code. 
Repeat the step to find an answer to any other errors that you notice during 
installation. If you are not able to resolve the issue even after following the steps 
provided in resolution, you can contact support.oracle.com along with log files and 
appropriate screen shots.

Error Code Dictionary

Cause Unix shell is not "korn" shell.

Resolution Change the shell type to "korn". Use chsh unix command to change 
SHELL type.

Shell type can also be changed by specifying shell path for the Unix 
user in /etc/passwd file.

Note: chsh command is not available in Solaris OS.

Cause No proper arguments are available.

Resolution Provide proper arguments. Invoke Setup.sh using either SILENT 
or GUI mode.

Example: ./Setup.sh SILENT or ./Setup.sh GUI

Cause File .profile is not present in $HOME.

Resolution Create .profile in $HOME, i.e. in the home directory of user.

Cause File OFSAAInfrastructure.bin is not present in current folder.

Resolution Copy OFSAAInfrastructure.bin into installation kit directory.

Cause File CustReg.DAT is not present in current folder.

Resolution Copy CustReg.DAT into installation kit directory.

8Error code - OFSAAI-1001

8Error code - OFSAAI-1002

8Error code - OFSAAI-1004

8Error code - OFSAAI-1005

8Error code - OFSAAI-1006

support.oracle.com
support.oracle.com
support.oracle.com


Cause File OFSAAI_InstallConfig.xml is not present in current folder.

Resolution Copy OFSAAI_InstallConfig.xml into installation kit directory.

Cause File validateXMLInputs.jar is not present in current folder.

Resolution Copy validateXMLInputs.jar into installation kit directory.

Cause File log4j.xml is not present in current folder.

Resolution Copy log4j.xml into installation kit directory.

Cause Unknown error occurred.

Resolution Make sure to provide proper argument (SILENT or GUI) to the 
Setup.sh file.

Cause XML validation failed.

Resolution Check InfrastructurePreValidations.Log for more details.

Cause Property file with locale name does not exist.

Resolution Copy MyResources_en_US.properties to the setup kit directory and 
keep en_US in LOCALE tag of OFSAAI_InstallConfig.xml.

Cause File OFSAAI_InstallConfig.xml/OFSAAI_PostInstallConfig.xml 
not found.

Resolution Copy OFSAAI_InstallConfig.xml/OFSAAI_PostInstallConfig.xml 
to the setup kit directory.

Cause XML node value is blank.

Resolution Make sure all node values except SMTPSERVER, PROXYHOST, 
PROXYPORT, PROXYUSERNAME, PROXYPASSWORD, 
NONPROXYHOST, or RAC_URL are not blank.
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8Error code - OFSAAI-1007

8Error code - OFSAAI-1008

8Error code - OFSAAI-1009

8Error code - OFSAAI-1010

8Error code - OFSAAI-1011

8Error code - OFSAAI-1012

8Error code - OFSAAI-1013

8Error code - OFSAAI-1014



Cause XML is not well formed.

Resolution Execute the command dos2unix OFSAAI_InstallConfig.xml to 
convert plain text file from DOS/MAC format to UNIX format.

OR

Make sure that OFSAAI_InstallConfig.xml is valid. Try to open the 
file through Internet Explorer for a quick way to check validity. If it 
is not getting opened, create new OFSAAI_InstallConfig.xml using 
the XML_Utility.jar.

Cause User installation directory contain blank spaces.

Resolution Provide an installation path that does not contain spaces. Check the 
tag USER_INSTALL_DIR in OFSAAI_InstallConfig.xml file. This path 
should not contain any spaces.

Cause User installation directory is invalid.

Resolution Provide a valid installation path. Check if you are able to create the 
directory mentioned in USER_INSTALL_DIR tag value of OFSAAI_
InstallConfig.xml file.
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8Error code - OFSAAI-1015

8Error code - OFSAAI-1016

8Error code - OFSAAI-1017
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